
 

 

User Guide 
 

Oracle® Health Sciences Central Designer 
Release 2.0 

 

Part Number: E37919-01 

 

 



 

 

  
Copyright © 2013, Oracle and/or its affiliates. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license 
agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial 
property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability 
with other independently created software or as specified by law, is prohibited. 

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please 
report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license 
agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose. 

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States 
Government, the following notice is applicable:  

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition 
Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the 
Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license 
agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software -- Restricted 
Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065. 

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be 
the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such 
applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs. 

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for 
the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you 
choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, 
including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for 
any loss or damage of any sort that you may incur from dealing with any third party.  

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners. 

This documentation may include references to materials, offerings, or products that were previously offered by Phase Forward Inc. Certain 
materials, offerings, services, or products may no longer be offered or provided. Oracle and its affiliates cannot be held responsible for any 
such references should they appear in the text provided. 

 

 



 

Oracle® Health Sciences Central Designer 2.0 iii 

Contents 
About this guide vii 

Overview of this guide ...................................................................................................................................................... viii 
Prerequisites........................................................................................................................................................... viii 
Users ....................................................................................................................................................................... viii 

Related information .............................................................................................................................................................. x 
Documentation ........................................................................................................................................................ x 

If you need assistance......................................................................................................................................................... xii 

Part I  Introduction to the study design environment 1 

Chapter 1  Product tour 3 

About the Central Designer application ........................................................................................................................... 4 
Applications .............................................................................................................................................................. 4 
Deployment target applications ............................................................................................................................ 4 
Users, rights, and roles............................................................................................................................................ 4 

First steps ............................................................................................................................................................................... 6 
Logging on and off .................................................................................................................................................. 6 
Changing your password ........................................................................................................................................ 7 
Home Page ............................................................................................................................................................... 7 
Getting Help ............................................................................................................................................................. 8 
Setting your machine for different locales .......................................................................................................... 9 

Project Explorer .................................................................................................................................................................. 11 
Adjusting the view of the Explorer bars in the Project Explorer ................................................................. 11 
Finding a study object in the Project Explorer ................................................................................................ 12 
Sorting study objects ............................................................................................................................................. 12 
Filtering container objects.................................................................................................................................... 13 
Viewing study object titles or RefNames in the Project Explorer ................................................................ 13 

Editors .................................................................................................................................................................................. 14 
Browsers ............................................................................................................................................................................... 15 

About browsers...................................................................................................................................................... 15 
Opening and closing a browser .......................................................................................................................... 15 
Rearranging a browser in the application window .......................................................................................... 16 
Showing and hiding a browser ............................................................................................................................ 17 
Editing study object properties in the Properties Browser ............................................................................ 18 

Navigating to a specific Explorer bar, editor, or browser ........................................................................................... 19 
Customizing the workspace .............................................................................................................................................. 20 

Arranging fields, tabs, and browsers .................................................................................................................. 20 
Resetting window layout and message boxes ................................................................................................... 20 
Showing and hiding the status bar ...................................................................................................................... 20 
Changing the number of projects that appear in the Recent Projects list ................................................... 21 
Choosing what appears on startup ..................................................................................................................... 21 
Filtering your view of system-specific study objects ....................................................................................... 21 
Viewing more than one tab in the workspace .................................................................................................. 21 
Filtering data in a grid ........................................................................................................................................... 22 
Grouping data in a grid ........................................................................................................................................ 22 
Showing and hiding a field ................................................................................................................................... 23 
Sorting data in a grid ............................................................................................................................................. 23 



Contents  
 

iv Oracle® Health Sciences Central Designer 2.0 

Chapter 2  Planning 25 

Planning teams and collaboration .................................................................................................................................... 26 
Example of collaboration ..................................................................................................................................... 27 

Planning libraries ................................................................................................................................................................. 29 
Guidelines for library development.................................................................................................................... 29 
Illustrations of library workflow ......................................................................................................................... 32 

Planning how to manage study objects ........................................................................................................................... 38 
Planning rules and edit checks .......................................................................................................................................... 40 
Planning the study workflow ............................................................................................................................................ 41 
Planning mappings and data extracts .............................................................................................................................. 42 

Part II  Working in the study design environment 43 

Chapter 3  Collaborating 45 

Implementing collaboration .............................................................................................................................................. 46 
Creating and modifying tasks .............................................................................................................................. 46 
Creating a collaboration note .............................................................................................................................. 52 
About locking study objects ................................................................................................................................ 54 

Working in a collaborative environment ........................................................................................................................ 57 
Interacting with assigned tasks ............................................................................................................................ 57 

Chapter 4  Reusing study objects 59 

About projects, studies, and libraries .............................................................................................................................. 60 
Library administration ........................................................................................................................................................ 62 

Creating a library .................................................................................................................................................... 62 
Opening and closing a study or library project ................................................................................................ 62 
Setting up library teams ........................................................................................................................................ 63 
Library security....................................................................................................................................................... 67 
Publishing, republishing, and unpublishing ...................................................................................................... 69 
Categorizing study objects ................................................................................................................................... 71 

Finding and using study objects in a library ................................................................................................................... 74 
Searching for study objects .................................................................................................................................. 74 
Reusing study objects............................................................................................................................................ 81 

Copying, cutting, and pasting ........................................................................................................................................... 88 
Copying and pasting a study object .................................................................................................................... 89 
Dragging and dropping study objects ................................................................................................................ 90 
Cutting and pasting a study object ..................................................................................................................... 91 
Copying and moving data-entry rules ................................................................................................................ 91 
About copying study objects grouped by data mappings............................................................................... 92 

Working with templates and types ................................................................................................................................... 93 
About templates ..................................................................................................................................................... 93 
About types ............................................................................................................................................................ 95 
Differences between templates and types ......................................................................................................... 96 
Information you can define for templates and types ...................................................................................... 96 
Marking a study object as a template ................................................................................................................. 98 
Modifying a template ............................................................................................................................................ 98 
Removing a template categorization from a study object .............................................................................. 99 
Creating a study object from a template ............................................................................................................ 99 
Marking an item as a type .................................................................................................................................. 100 
Modifying a type .................................................................................................................................................. 100 
Removing a type categorization from an item ............................................................................................... 100 
Creating an item from a type ............................................................................................................................. 101 



 User Guide  

Oracle® Health Sciences Central Designer 2.0 v 

Chapter 5  Managing study objects 103 

Creating, replacing, updating, and deleting .................................................................................................................. 104 
About creating study objects ............................................................................................................................. 104 
Renaming a study object .................................................................................................................................... 105 
Renaming a study object in a workflow diagram ........................................................................................... 105 
About deleting ...................................................................................................................................................... 106 
Deleting a study object in a workflow grid ..................................................................................................... 106 
Deleting a workflow rule from a workflow diagram ..................................................................................... 107 
Deleting a global condition ................................................................................................................................ 107 
Deleting one or more rules ................................................................................................................................ 107 
About instances and links .................................................................................................................................. 107 

Adding study objects ........................................................................................................................................................ 112 
About the Add To browser ............................................................................................................................... 112 
Adding study objects to a study from the Add To browser ........................................................................ 112 
Previewing study objects in the Add To browser .......................................................................................... 113 

Saving study objects ......................................................................................................................................................... 114 
About saving study objects ................................................................................................................................ 114 
Saving one or more study objects ..................................................................................................................... 115 
Saving a rule .......................................................................................................................................................... 115 

References .......................................................................................................................................................................... 116 
Attaching a reference to a study ....................................................................................................................... 116 
Removing a reference from a study ................................................................................................................. 117 
Maximum attachment size ................................................................................................................................. 117 

About versions and revisions.......................................................................................................................................... 118 
Versions ................................................................................................................................................................. 118 
Versioning and revising a study object ............................................................................................................ 118 
Reverting to a previous version or revision of a study object ..................................................................... 119 
Revising study objects ......................................................................................................................................... 119 
Viewing audit history for a study object .......................................................................................................... 123 
Viewing the differences between two versions or revisions of a study object ......................................... 123 

Exporting and importing text for translation .............................................................................................................. 124 
About exporting and importing text ................................................................................................................ 124 
Exporting text strings from a study or library ................................................................................................ 124 
Importing translated text strings ....................................................................................................................... 125 
Translating exported text strings ...................................................................................................................... 125 
Checking for empty strings ................................................................................................................................ 127 

Importing and exporting a study .................................................................................................................................... 128 
About importing .................................................................................................................................................. 128 
About exporting ................................................................................................................................................... 135 

Reserved words for RefNames ...................................................................................................................................... 136 

 Appendix A  Option and property descriptions 141 

Collaboration ..................................................................................................................................................................... 142 
Collaboration Notes Browser—Option descriptions ................................................................................... 142 
Collaboration Note Editor dialog box—Option descriptions .................................................................... 142 
Task areas—Field descriptions ......................................................................................................................... 143 
Tasks Browser—Option descriptions ............................................................................................................. 144 
Task Editor dialog box—Option descriptions .............................................................................................. 145 

Home page ......................................................................................................................................................................... 147 
Home Page—Section descriptions ................................................................................................................... 147 
Status toolbar—Option descriptions ............................................................................................................... 147 

Study objects ...................................................................................................................................................................... 148 
Export Translations dialog box—Option descriptions ................................................................................ 148 
Export Wizard options ....................................................................................................................................... 149 
History Viewer dialog box—Option descriptions ......................................................................................... 149 



Contents  
 

vi Oracle® Health Sciences Central Designer 2.0 

Import Wizard options - CSML or ODM file ............................................................................................... 150 
Import Wizard options - InForm resources ................................................................................................... 151 
References tab—Option descriptions ............................................................................................................. 151 

Glossary 153 

Index 163 

  



 

Oracle® Health Sciences Central Designer 2.0 vii 

In this preface 
Overview of this guide ........................................................................................................................ viii 

Related information ................................................................................................................................ x 

If you need assistance ........................................................................................................................... xii 

 
 

 
About this guide 



  About this guide  
 

viii Oracle® Health Sciences Central Designer 2.0 

Overview of this guide 
The User Guide introduces the study design environment in the Central Designer application and 
describes how to work as a study design team in that environment, including how to: 

• Work collaboratively. 

• Maximize study design efficiency by reusing study objects. 

• Manage collections of study objects. 
 

Prerequisites 
You should have experience in one or more of the following clinical areas: 

• Data management 

• Data analysis 

• Study design 

• Library management 

• Project management 

Additionally, rule developers must have the following levels of programming expertise, depending on 
the types of rules they will be creating. 

 

Type of rule Required programming expertise 
Simple edit checks using rule 
templates. 

None. 

Comparisons, calculations. • Understanding of C# or similar (for example, Java, C, or 
C++) expression syntax. 

• Ability to incorporate functions in expressions. 

User-defined functions. • Ability to program in a .NET language (for example, C#) 
and create .NET assemblies. 

 
 

Users 
This guide is for users of the Central Designer application, including: 

 

User Description 
Clinical data manager A user who is involved in the study design process. 

Library administrator A user with library administration privileges for one or more 
clinical areas. 

Central Designer administrator An IT representative who supports and maintains the application 
from a technology and infrastructure perspective. 
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User Description 
Study design team Users who implement a study. This team includes several roles 

such as form designer, rule designer, and study workflow 
designer. 

Medical project manager A user who works with the CRF designer to create an annotated 
study protocol, usually based on existing CRFs for the therapeutic 
area. This user is concerned with the overall set of study 
questions and logic, not the individual details of form design. 

Statistician A user who interacts with study designers with respect to data 
collection needs for analysis. 

Translator A user who is responsible for translating text in clinical studies, 
forms, items, and rule queries to a specified language. 
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Related information 

Documentation 
All documentation is available from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com) and the Download Center (https://extranet.phaseforward.com). 

All documents may not be updated for every Central Designer release. Therefore, the version 
numbers for the documents in a release may differ. For a complete list of the documents in this 
Central Designer release, their release version numbers, and part numbers, see the Release Notes. 

 

Item Description 
Release Notes The Release Notes document provides detailed information about the requirements, 

enhancements, and fixed issues in the current release. 

Known Issues The Known Issues document provides detailed information about the known issues 
in this release, along with workarounds, if available. 

Note:  The most current list of known issues is available on the Extranet. To sign 
in to the Extranet, go to https://extranet.phaseforward.com. 

Installation Guide The Installation Guide provides system requirements and instructions for installing 
and upgrading the Oracle® Health Sciences Central Designer software and the 
Oracle® Health Sciences Central Designer Administrator software. 

This document is also available from the Documentation CD. 

Administrator 
Guide 

The Administrator Guide describes how to use the Oracle® Health Sciences Central 
Designer Administrator software to set up users, permissions, system 
configuration parameters, and catalog defaults. 

This document is also available from the Oracle® Health Sciences Central 
Designer Administrator application user interface (HTML format) and the 
Documentation CD (PDF format). 

User Guide The User Guide introduces the study design environment in the Oracle® Health 
Sciences Central Designer application and describes how to work as a study 
design team in that environment, including how to: 

• Work collaboratively. 

• Maximize study design efficiency by reusing study objects. 

• Manage collections of study objects. 

This document is also available from the Oracle® Health Sciences Central 
Designer application user interface (HTML format) and the Documentation CD 
(PDF format).  

InForm Design 
Guide 

The InForm Design Guide describes how to design a study for deployment to the 
InForm application. 

This document is also available from the Oracle® Health Sciences Central 
Designer application user interface (HTML format) and the Documentation CD 
(PDF format). 
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Item Description 
Rules Reference 
Guide 

The Rules Reference Guide is a reference to the tools that are available for creating 
rule expressions, including: 

• Study object properties. 

• Functions. 

• Constants. 

• Data mappings. 

• Methods, operators, and literals. 

This document is also available from the Oracle® Health Sciences Central 
Designer application user interface (HTML format) and the Documentation CD 
(PDF format). 

Secure 
Configuration 
Guide 

The Secure Configuration Guide provides an overview of the security features 
provided with the Oracle® Health Sciences Central Designer application, including 
details about the general principles of application security, and how to install, 
configure, and use the Central Designer application securely. 

  
 



  About this guide  
 

xii Oracle® Health Sciences Central Designer 2.0 

If you need assistance 
Oracle customers have access to support through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info, or if you are hearing impaired, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs. 
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About the Central Designer application 
The Central Designer application provides a collaborative environment for developing clinical studies 
and addresses the need to significantly increase productivity in the study design process by: 

• Providing one central environment for study design. 

• Improving efficiency. 

• Facilitating reuse. 

• Supporting internal and external standards. 
 

Applications 
The Central Designer application provides a collaborative design environment that supports multiple 
users and roles from any location.  

There are two client applications: 

• Central Designer—Used for collaborative study development. 

• Central Designer Administrator—Used to set up users, permissions, system configuration 
parameters, and catalog defaults. 

An administrator must set up administration information before you can perform some tasks. 
 

Deployment target applications 
You can design a study in the Central Designer application and deploy the study to the InForm 
application. 
 

Users, rights, and roles 
An administrator sets up users and roles in the Central Designer Administrator application. When an 
administrator creates a role, the administrator chooses: 

• The scope of the role. A role can have a library, study, or application scope.  

• The rights to associate with the role. 

The scope of a role, rights assigned to the role, and teams determine whether users can perform 
certain activities and view different application areas. 

• Library scope—Roles created with the library scope become library teams in the Central 
Designer application. 

To perform activities in a library, you must be assigned to: 

• A role with a library scope in the Central Designer Administrator application. 

• The corresponding library team in the Central Designer application. 
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• Study scope—Roles created with the study scope become study teams in the Central Designer 
application. 

To perform activities in a study, you must be assigned to: 

• A role with a study scope in the Central Designer Administrator application. 

• The corresponding study team in the Central Designer application. 

• Application scope—Activities associated with the application scope are always available to all 
users, whether or not the users are assigned to teams. Roles created with the application scope 
do not become teams in the Central Designer application. 
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First steps 

Logging on and off 
If your logon session is inactive for the amount of time set by the administrator, you are prompted to 
re-enter your password the next time you perform an activity. 

To log on: 

1 Navigate to the following address: 

http://<server name>/CentralDesignerInstall 

where <server name> is the name of the application server computer. 

2 Click the Start Central Designer Client link. 

A dialog box appears, indicating that the application is starting.  

The logon window appears. 

3 Type your User Name and Password. 

Note: You might be prompted to change your password if your password has expired. 

4 Click Log On. 

You are logged on to the application, and the application opens. By default, the Home Page 
appears, but you can choose what you see after logon. 

For more information, see Choosing what appears on startup (on page 21). 

To log off and log on as a different user: 

1 Select File > Log on As Different User. 

If your project has unsaved changes, you are prompted to save.  

The logon window appears. 

2 Type your User name and Password, and click Log On. 

To log off: 

• Select File > Exit. 

If you have unsaved changes, you are prompted to save them. 
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Changing your password 
You can change your password at any time. You are prompted to change your password when you 
start the application if: 

• The administrator has indicated that that you must change your password.  

• Your password has expired. 

To change your password after logging on: 

1 Select File > Change Password. 

The Change Password dialog box appears. 

2 Type your old and new passwords. You must type your new password twice for confirmation. 

3 Click OK. 

To change your password because it is required: 

1 Navigate to the following address: 

http://<server name>/CentralDesignerInstall 

where <server name> is the name of the application server computer.  

2 Click the Start Central Designer Client link. 

A dialog box appears, indicating that the application is starting.  

The logon window appears.  

3 Type your User name and Password, and click Log On. 

The Change Password dialog box appears. 

4 Type your old and new passwords. You must type your new password twice for confirmation. 

5 Click OK. 
 

Home Page 
The Home Page displays tasks that are assigned to you and recently viewed projects. You can open a 
task, do the requested work, close the task, and go on to the next task. The Home Page closes after 
you open a library project or study project. By default, the Home Page appears after you log on. For 
more information, see Choosing what appears on startup (on page 21). 

For more information, see: 

Home Page - Section descriptions (on page 147). 

Task areas - Field descriptions (on page 143). 
 

Opening the Home Page 
Your startup options determine whether the Home Page appears by default after you log on. 

You can view the Home Page at any time. 

• On the toolbar, click the Home Page button ( ). 
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Opening a project from the Home Page 
From the Home Page, you can: 

• Open a study or library project by double-clicking the project or a task that is assigned to you. 

• Open the application without opening a study or library project.  
 

What to open Procedure 
Recently accessed library project or study 
project. 

• In the Recent Projects List section, double-click a 
project. 

Library project or study project, by selecting 
a task. 

• In either the My Tasks or My Recent Tasks Since 
section, double-click a task in the list. 

Central Designer application. without 
selecting a task or project. 

• On the toolbar, click the Workspace button ( ). 

 

Note: You can also open study and library projects by selecting File > Open. 

 

Getting Help 

Using online Help 
• Press F1, and then click the area of the application for which you want more information. A 

Help window appears with the relevant page displayed.  

• To open a help document such as the User Guide, select Help and select the document. 

If you need the version of the application, you can view it in the About Central Designer dialog box. 
The dialog box also contains copyright information.  

The following help is also available: 

• Hover Help—Point to a button, tab, or icon, and a tool-tip appears. 

• Oracle Help Desk—Help is available from the Oracle Help Desk if you encounter system-
related issues. For more information, see If you need assistance (on page xii). 

 

Troubleshooting issues with Help 
If any of the tabs do not appear when you open the Help from the Help menu, add the name of the 
application server to the list of trusted sites.  

1 In Internet Explorer, select Tools > Internet Options. 

2 Select the Security tab. 

3 Select Trusted Sites, and click Sites. 

4 In Add this Web site to the zone, type the address that the client application uses to connect to the 
application server. 

5 Click OK until you return to Internet Explorer.  
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Setting your machine for different locales 

Viewing Japanese characters 
Perform these steps if you are unable to view Japanese characters. 

1 Select Start > Control Panel > Regional and Language Options.  

2 Select the Languages tab. 

3 Select Install files for East Asian languages. 

4 Click OK. 

5 Restart your computer. 
 

Setting up a keyboard to use different locales 
When the Windows operating system starts in a specific locale, it updates the keyboard settings for 
that locale. If you will develop a study in a language other than the locale in which you are located, 
use this procedure to switch your keyboard settings and shortcuts between locales. 

In each locale, set up the Windows operating system to support multiple text input languages—the 
local language and the language in which the study is developed: 

1 Select Control Panel > Regional and Language Options > Languages tab > Details. 

2 In the Settings tab of the Text Services and Input Languages dialog box, make sure that both the 
local language and the study development language are included in the list of supported text 
input languages. 

3 Activate the Language Bar. 

4 Use the Language Bar to switch between the local language and the study development language. 
Always log on to the Central Designer application in the study development language. 

 

Additional locale settings 
You set the default locale for a study in the Central Designer application. 

The Microsoft Windows operating system also provides the following language-related options. 
 

Option location Purpose 
Control Panel > 
Regional and Language Options > 
Regional Options tab > 
Standards and formats section 

Controls the formatting conventions for numeric data, 
including dates, times, numbers, and currencies.  

Note: If you do not set the default locale for a study in the 
Central Designer application, this setting is used as the default 
locale for a study. If you modify the regional setting, you must 
close and reopen the Central Designer application to use the 
new locale.  
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Option location Purpose 
Control Panel >  
Regional and Language Options >  
Languages tab >  
Language used in menus and 
dialogs 

Controls the language of text in menus and dialog boxes. The 
option appears only if you have one or more Multiple User 
Interface (MUI) packs installed.  

The Central Designer user interface supports only English. 

Control Panel >  
Regional and Language Options > 
Languages tab >  
Details button >  
Default input language 

Controls the language that you use to type information on the 
computer.  

For example, if the default locale for a study is set to French 
(France), all study metadata is saved as French metadata. 
Even if the input language is English (United States) and you 
type information in the English language, the information is 
saved as information entered for the French locale. 
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Project Explorer 
The Project Explorer is the primary navigation tool in the Central Designer application. Located by 
default on the left side of the Central Designer application window, the Project Explorer consists of 
a set of hierarchical lists of the study objects in the design environment. 

Lists of study objects appear in Explorer bars. When selected, each Explorer bar displays a list of 
study objects in a tree format. For example, when you select the Elements and Events Explorer bar, 
a tree listing of the study elements and study events in the open study or library appears in the 
Project Explorer. You can expand the tree listing to view the child study objects of each study object 
in the tree. 

• When you select the icon for a group of study objects (for example, Forms) in the Project 
Explorer, the editor for that type of study object appears in the application workspace and lists 
the study objects of that type that have been defined for the open study or library. 

• When you select a specific study object, the editor for that study object appears in the application 
workspace. 

The Central Designer application has numerous options for finding, sorting, filtering, and displaying 
study objects in the Project Explorer. 
 

Adjusting the view of the Explorer bars in the Project Explorer 
You can choose between two Explorer bar groupings: 

• Bottom Grouping—Explorer bars are grouped at the bottom of the Project Explorer. You can 
slide a splitter bar to control how many bars are visible in the Project Explorer. When an 
Explorer bar is not visible, an icon representing the Explorer bar appears at the bottom of the 
Project Explorer. 

• Zipper Grouping—All Explorer bars appear in the Project Explorer. The Explorer bars before 
the selected Explorer bar appear at the top of the Project Explorer. The Explorer bars after the 
selected Explorer bar appear at the bottom of the Project Explorer. 

To select an Explorer bar grouping: 

1 At the top of the Project Explorer, select Options > Explorer View. 

2 Select a grouping option. 

To view a subset of Explorer bars in the Project Explorer: 

• In the Project Explorer, do one of the following: 

• Click and drag the splitter bar up or down. 

• In the bottom right corner of the Project Explorer, click the arrow, and select Show More 
Buttons or Show Fewer Buttons. 
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Finding a study object in the Project Explorer 
1 At the top of the Project Explorer, click Find. 

The Find dialog box appears. 

2 In the Find what field, type the text to search for. 

3 In the Fields to search options, select the fields in which to search for the specified text. 

4 To match the case used in the search, select Match case. 

5 To search for the whole word, select Match whole word. 

6 Click Find Next. 

Starting with the selected study object, a search is performed. The first study object whose 
RefName or title matches the text that you type is selected. 

Study objects filtered from view are ignored. 
 

Sorting study objects 
The Project Explorer for library projects and study projects has containers that hold study objects. 
For example, the Forms container holds all forms in the study or library. You can sort the study 
objects that appear in each container. 

By default, study objects appear in the following order in the Project Explorer: 

• Study objects added to a Study Design, Study Element, or Study Event appear in workflow 
order. 

• Study objects added to a form appear in the order in which they are added. 

• Study objects without children appear in alphabetical order.  

1 In the Project Explorer, select Options > Container Sorting. 

A menu appears. 

2 Select one of the following options: 

• Ascending—Sort the study objects in each study object container in alphabetical order. 

• Descending—Sort the study objects in each study object container in reverse alphabetical 
order. 

Note: If the order of the study objects is important, for example, the order of items on a form, 
these study objects cannot be sorted. 
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Filtering container objects 
1 In the Project Explorer, select the Explorer bar for the study objects to view. 

2 At the top of the Project Explorer, select Filters. 

Note: The Filters drop-down list is not enabled for the containers in the Study Information 
Explorer bar or the Visit Schedule Explorer bar. 

3 Select one of the following: 

• All Objects. 

• Modified Objects—Study objects modified since the project was last saved. 

• Local Locks—Study objects you locked. 

• Remote Locks—Study objects locked by other users. 

The workspace contains only the study objects specified by the filter. In addition, the header in 
the Project Explorer indicates that the workspace is filtered. 

 

Viewing study object titles or RefNames in the Project Explorer 
You can view either the RefNames or the titles of all study objects in the Project Explorer. When 
developing naming conventions, consider that all study objects (except study projects, library 
projects, libraries, and studies) have RefNames and titles, which can be different. 

• RefNames are referenced in rules and are deployed to the target application. Therefore, they 
must: 

• Follow C# variable standards. 

• Start with a letter or an underscore.  

• Contain only letters, numbers, and underscores.  

• Be unique within a study or library. For example, you cannot have a form and an item with 
RefNames of DOV in the same study or library. 

• Titles are the more readable display names for study objects. They can contain spaces and special 
characters, but are not referenced in rules and are not deployed to the target application.  

To view titles or RefNames: 

• At the top of the Project Explorer, select Options > Display Names, and select a display option. 

The option you select remains selected when you open a new session. 
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Editors 
An editor allows you to work with study or library objects. The Central Designer application includes 
editors for each type of study object and for individual study objects. When you select a type of study 
object or a specific study object in the Project Explorer, the editor for that study object type or study 
object appears in the workspace. 

• The editors for types of study objects (container editors) are organized as grids in which each 
study object of the type in the study or library appears in one row of the grid. Commands that 
allow you to perform actions on a selected study object appear at the top of the grid. You can 
arrange the columns of the grid in the order you prefer, and you can include or exclude columns 
as needed. 

For more information, see Customizing the workspace (on page 20). 

• The information in editors for individual study objects is organized into tabs that give access to 
subsets of the functionality available for each type of study object. For example, when you create 
a form, item, or codelist, the Design tab in the Form, Item, or Codelist editor allows you to 
define the characteristics of the new study object. 

 



 User Guide  

Oracle® Health Sciences Central Designer 2.0 15 

Browsers 

About browsers 
Browsers enable you to perform specific study and library design, management, validation, and 
deployment activities. The following browsers are available in the Central Designer application: 

• Project Explorer—View and navigate to study objects in the current study or library. 

• Properties Browser—View and modify properties for a study object. 

• Libraries Browser—View library objects, and drag them into a workspace. 

• Users Browser—View users, and drag them into a workspace. 

• Collaboration Notes Browser—View, create, and edit collaboration notes. 

• Tasks Browser—View, create, edit, and manage tasks that you have created or that are assigned 
to you.  

• Baselines Browser—View, edit, and delete validation baselines. 

• Jobs Browser—View, edit, and delete jobs, including validation, deployment, and import jobs. 

• Add To browser—View and add study objects that are available to be added to a workspace. 
 

Opening and closing a browser 
You can close the browsers that you do not need to work in. Your changes are saved for the next 
time you log on. 

Note: If a browser name has a checkbox beside it in the View menu, it is open. If no checkbox 
appears, it is closed. 

To open a browser: 

• Select View, and then select a browser from the list. 

To close a browser: 

• Click the X button, located in the upper-right corner of the browser. 

or 

Select View, and deselect a browser from the list. 

You can reset the layout of the application window (on page 20) to the default view. 
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Rearranging a browser in the application window 
1 Click the title of the browser (located to the left of the Auto-Hide button ( ) and the X button), 

and drag it away from its location. Do not release the mouse button.  

The mouse cursor changes to a plus sign with arrows ( ). 

Arrow buttons appear at the top, bottom, left, and right of the application window (for example: 

). 

2 Drag the browser (without releasing the mouse button) to the desired location in the application 
window.  

Arrow buttons appear in the application area. For example:  

 
3 Point your mouse to an arrow button. The application area where the browser will appear is 

highlighted. After you find the desired location for the browser, release the mouse button. 
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Showing and hiding a browser 
If a space holds multiple browsers and you can see only one at a time, hiding or showing one affects 
all of them. 

 

Browser controls 

 

1—When a browser is hidden, it does not appear automatically. You must point your cursor to the 
named tab for the browser to show it. 

2—The Auto-Hide button is sideways, indicating that the browser is hidden.  
 

To hide a browser: 

• Click the Auto-Hide button ( ), located in the upper-right corner of the browser. 

To view a hidden browser: 

• Point your mouse to the name of the hidden browser. (The name of the browser appears along 
the outer edge—either the sides or the bottom—of the application window.) 

The browser appears and remains visible as long as the cursor is somewhere within the browser 
window. If you move the cursor away while the browser is temporarily shown, the browser 
becomes hidden again. 

To show a browser: 

1 Point your mouse to the name of the hidden browser. (The name of the browser appears along 
the outer edge—either the sides or the bottom—of the application window.) 

The browser appears. 

2 Click the Auto-Hide button ( ), located in the upper-right corner of the browser. (The icon is 
sideways when the browser is hidden.) 
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Editing study object properties in the Properties Browser 
1 Select the study object. 

2 Select the Properties Browser. 

Note: If the Properties Browser is not visible, select View > Properties. 

3 Edit the properties of the study object. After changing each property, press Enter, or tab to the 
next property. 

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.  

For descriptions of the properties for study and library objects, see the Appendix. 
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Navigating to a specific Explorer bar, editor, or browser 
1 From the application toolbar, select Tools > Go to Window. 

The Go to Window dialog box appears. 

2 Select an Explorer bar, editor, or browser. 

3 Click Go To. 
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Customizing the workspace 

Arranging fields, tabs, and browsers 
You can arrange the order of:  

• Fields in most grids. 

• Tabs in editors. 

• Browsers that are grouped. 

To arrange the order of fields, tabs, or browsers: 

• Drag a field, tab, or browser to a new position. 
 

Resetting window layout and message boxes 
You can reset the following information for yourself only: 

• Window layout 

• Reset location and visibility of all browsers.  

• Reset the size of the application window (for example, minimized or maximized). 

• Message boxes 

Deselect the Do not show again setting for all information messages. Messages that you chose not 
to see now appear. 

To reset window layout or message boxes: 

1 Select Tools > Options.  

The Central Designer Options dialog box appears. 

2 Click Reset Window Layout or Reset Message Boxes. 

3 Click OK. 
 

Showing and hiding the status bar 
The Status bar and toolbar are at the bottom of the application window. 

1 Select Tools > Options.  

The Central Designer Options dialog box appears. 

2 Select or deselect Show Status Bar. 

3 Click OK. 

For more information, see Status toolbar - Option descriptions (on page 147). 
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Changing the number of projects that appear in the Recent Projects list 
By default, the six most recently viewed study and library projects appear on the Home Page.  

1 Select Tools > Options.  

The Central Designer Options dialog box appears. 

2 In the [number] part of the Display [number] projects in Recent Projects list option, type the number 
of projects to appear. 

3 Click OK. 
 

Choosing what appears on startup 
1 Select Tools > Options.  

The Central Designer Options dialog box appears. 

2 From the At Startup drop-down list, select one of the following options:  

• Show HomePage—The Home Page appears after you log on. 

• Show Workspace—A blank workspace with no project appears after you log on. 

• Load Most Recent Project—The project you opened last appears in the workspace after you log 
on. 

3 Click OK. 
 

Filtering your view of system-specific study objects 
The main toolbar contains a View Targets drop-down list that allows you to view objects for one 
target application or all target applications. Only the target applications that are enabled in the 
Targets workspace in the Central Designer Administrator application and selected in the Targets field 
in the General tab for a study appear in the list. 

To filter your view of system-specific study objects: 

• From the View Targets drop-down list on the main toolbar, select an option: 

• All—(Default selection in every project) All study objects appear. 

• <target application name>—Only study objects for the selected target application appear. 
 

Viewing more than one tab in the workspace 
1 In the Project Explorer, select a study object. 

The editor for the study object appears in the workspace.  

2 Click one of the tabs, and drag it within the workspace, without releasing the mouse button.  
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The mouse cursor changes to a plus sign with arrows. 

Arrow buttons appear in the workspace. For example:  

 
Point your mouse to an arrow button, and the application area where the tab will appear is 
highlighted, as shown in the following example. After you find the desired location for the tab, 
release the mouse button. 

 

Filtering data in a grid 
You can filter data in most grids, such as the grid in the Collaboration Notes Browser. 

For example, if you created multiple collaboration notes based on several collaboration note types, 
you can filter to view only the collaboration notes of a certain type. 

To filter the data that appears in a grid: 

1 In any grid, right-click a field, and select Filter Row. 

Filtering fields appear at the top of every column in the grid. 

2 To use a filtering operator, click the filter operators button ( ), and select an operator. If you 
do not select an operator, Starts with is used by default. 

3 In the filter field, type the text to use for the filter.  

As you type, an incremental filter of the column is performed. 

4 To remove the filter, click the Clear Filter Criteria button, located at the end of the field. 

To remove the filter row: 

• In any grid, right-click any field, and deselect Filter Row. 
 

Grouping data in a grid 
To view the grouping panel and group data in a grid: 

1 In a grid, right-click any field, and select Group. 

The grouping panel appears above the grid.  

2 Drag a field to the grouping panel to group the grid by that field. You can group by one or more 
fields. 

To remove the grouping panel: 

• In a grid, right-click a field, and deselect Group. 
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Showing and hiding a field 
To change the fields that appear in a grid: 

1 In any grid, right-click any column, and select Columns. 

The Columns dialog box appears. 

2 Select fields that appear in the Available Columns or Displayed Columns lists, and use the Add, 
Remove, Add All, or Remove All buttons to move them to the correct list. 

3 Optionally, to arrange the order of fields in the Displayed Columns list, select a field and click 
either Move Up or Move Down. 

4 Click OK. 

To hide a field: 

• In any grid, right-click the field you want to remove, and select Hide Column. 
 

Sorting data in a grid 
1 In any grid, select a field one time.  

The data from the field is sorted in ascending (if letters, alphabetical) order. 

2 To sort the data in descending order (if letters, reverse alphabetical), select the field a second 
time. 
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Planning teams and collaboration 
In the Central Designer application, you can develop multiple studies simultaneously, and multiple 
users can work on the same study simultaneously. 

 

Questions to consider Notes 

How will work be divided and 
assigned? 

For example: 

• Who will work on each study? Do study designers in your 
organization specialize in particular therapeutic areas? 

• Do you want different users to manage study objects in 
libraries and study objects in studies? 

• Will different users create study objects and rules? 

• Do you want to assign supervisors to review the work of 
other users? 

• If your studies will be localized, is translation performed as a 
separate activity or by the user who creates study objects? 

How will people work 
collaboratively when tasks are 
divided?  

Which activities must be performed sequentially, and which can 
be performed concurrently? For example, the following activities 
depend on the existence of a study object but can be performed in 
any order after the study object has been created: 

• Defining study object properties. 

• Defining form layout. 

• Translating text. 

• Creating rules. 

In how much detail do you 
want to break down tasks? 

• What types of tasks do you want to define? 

• Which teams should perform particular task types? 

How do you want to use 
collaboration notes? What types 
of collaboration notes do you 
want to define? 

For example, you could use collaboration notes to communicate: 

• Design specifications for study objects. 

• Other information about study objects. 

• Instructions to other users. 

• Status information about study objects that are in the process 
of development. 

How will the order in which 
you develop study objects 
affect your team assignments? 

The Central Designer application supports building studies from 
the top down, from the bottom up, or a combination of 
approaches. In what order do you prefer to develop study 
objects? For example, you could have one team member build or 
copy all of the required codelists while another creates the study 
workflows.  
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Questions to consider Notes 
How will reuse affect your 
validation and formal testing 
plans? 

After a study object has been validated, it should not be necessary 
to retest it in every study where it is used. 

 
 

Example of collaboration 

Note: The following table provides sample roles only. You can set up roles in a manner that is 
appropriate for your organization. 

 

Role Responsibilities Collaboration actions 
Clinical project 
manager 

• Collects requirements. 

• Writes or co-writes the 
protocol document. 

• Decides the users who will 
work on each study.  

Sets up study teams. 

Study architect Compiles a study by: 

• Collecting pre-approved 
form resources. 

• Defining study workflow. 

• Specifying where new 
forms are needed. 

• Designs the workflow of the study. 

• Creates tasks for study objects 
requiring more work, such as forms 
that must be designed or rules that 
must be created. 

• Assigns the tasks to the study 
development team. 

Study development 
team 

Builds new forms specified by 
the study architect. 

• Attaches collaboration notes to study 
objects to share information during 
study development. 

• As each form is completed, creates a 
task to translate the form into the 
required languages and assigns it to the 
study translation team. 

Study translation 
team  

Translates form resources for 
use in multiple language 
environments. 

Completes the translation tasks.  

Study development 
project manager 

Manages the progress of the 
project.  

Checks the statuses of tasks to ensure that 
the project is on schedule. 
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Example—Using a standard task 
A study architect is creating a study event and has added several standard forms from the library. She 
needs a form for capturing test results but is unable to create it. She uses a standard task to assign the 
work. 

a The study architect creates and names a blank form.  

b On the form, the study architect creates a standard task that contains instructions to design 
the form, including the information that the form must capture. If the instructions are 
already written, she can attach the document to the task. The study architect assigns the task 
to the form design team. 

c A member of the form design team sees the task in the Home Page. The form designer 
double-clicks the task, and the specified project and form open.  

d The form designer accepts the task. 

e The form designer uses the instructions in the task to build the form. If he needs help from 
rule designers, translators, or other specialists, he creates new tasks for the form and assigns 
them to the other teams. 

f The form designer completes the form and changes the status of the task to Complete. 

g After reviewing the work and verifying that it is complete, the study architect changes the 
status of the task to Closed. 

 

Example—Using a translation task 
A form designer is creating a form in English. He needs to translate the form into French (France) 
and Portuguese (Brazil), but he does not speak either language. 

a The form designer creates the form in English and saves it.  

b The form designer creates two translation tasks for the form. In each task, he chooses one 
language into which the form must be translated. The first task requests translation into 
French (France), and the second task requests translation into Portuguese (Brazil). He 
assigns both tasks to the translation team.  

c A member of the translation team sees the task in the Home Page. The translator double-
clicks the task and the specified project and form open.  

d The translator accepts the task.  

e The translator uses the instructions in the task to translate the form.  

f After completing the translations, the translator changes the status of the task to Complete. 

g After reviewing the work and verifying that it is complete, the form designer changes the 
status of the task to Closed. 

Note: In general, create a translation task for each locale that requires translation. For example, if 
you create three tasks, for translation into French, Spanish, and Japanese, a different person can 
accept each task. If a single person performs all translations for all locales, you can create a 
single translation task for all locales. 
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Planning libraries 

Guidelines for library development 
Creating study objects 

• Create study objects with reuse in mind, and reuse study objects as much as possible. Creating 
study objects takes some time, but you will save time in the long run when you reuse the study 
objects. 

• Build study objects in a library using a top-down or bottom-up approach, just as you can for 
study objects in a study.  

• Try to design study objects completely before adding them to a library. For example, add rules to 
study objects before adding the study objects to a library, so you do not need to recreate the 
rules every time you reuse the study objects. 

Organizing libraries 

Consider creating a different library for therapeutic areas, specific components, and the product that 
is being tested. For example: 

• You can create an oncology library, a pediatrics library, and an infectious diseases library. 

• You can create separate production libraries for approved user-defined functions and approved 
codelists. 

Types to create 

A library that has been built and maintained appropriately is a powerful tool that helps to decrease 
the time and effort needed for building a study. You can set up libraries as needed. Oracle 
recommends creating two different types of libraries, stag ing libraries (on page 29) and production 
libraries (on page 30). 
 

Staging libraries 
 

About staging libraries  
Use Use a staging library to hold study objects before you add them to a 

production library.  

You can add categories and keywords and change the values of custom 
properties in the staging library.  

When you plan the study objects that will be reused, consider forms as 
well as other study objects that will help you build a study more quickly.  

Users Oracle recommends allowing only librarians to work in the library. 

Number to create One or many. 

Adding study objects A librarian can copy study objects as needed from production studies 
and test studies to a staging library.  
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About staging libraries  
Modifications to study 
objects 

A librarian can add appropriate information needed for storing the study 
objects in a production environment.  

Oracle recommends allowing only the librarian to modify the study 
object. 

Searches Oracle recommends that you do not give users the rights to search 
staging libraries.  

 
 

Production libraries 
 

About production 
libraries 

 

Use Use production libraries for study objects that have been tested in the 
target application and that will be reused in other studies.  

Users Oracle recommends allowing only librarians to work in the library. 

Number to create You can create one or many. Oracle recommends creating multiple 
production libraries to maximize scalability.  

When planning library development, encourage the use of standards. As 
the number of libraries grows, you can restrict searches to specific libraries 
so that you are searching only for study objects that are related to the study 
that you are developing. 

Adding study objects Oracle recommends that you develop an approval process for adding study 
objects to a production library. The approval process, which happens 
outside of the Central Designer application, might be conducted by a 
standards committee. 

After a study object has been tested, approved, and added to a production 
library, you can add the study object to additional production libraries 
without retesting it. Therefore, you can use the principles of reuse for 
building libraries as well as studies. 

If you use the Copy > Link option, the new study object retains a link to 
the original study object.  

Modifications to study 
objects 

To maintain the integrity of a production library, do not modify study 
objects that are in the library, except in unusual circumstances in which the 
change must be propagated to all studies that use the study object, or if the 
change: 

• Is trivial, such as a spelling mistake. 

• Does not affect testing. 

• Is necessary for all users.  

Oracle recommends modifying a study object outside the production 
library, and then adding the modified study object to the production library 
as a new study object.  
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About production 
libraries 

 

Searches Oracle recommends that you allow users to search production libraries and 
view all published objects in them. 

Questions to consider 
while planning 

• How will you use categories and keywords to organize your study 
objects?  

A good categorization strategy will help you find study objects more 
efficiently. You can use categories for higher-level categorization and 
keywords for lower-level categorization.  

• What naming convention will you use for study objects, mappings, and 
functions?  

A naming convention will help you identify different types of study 
objects in your search results and will prevent you from giving the 
same name to two study objects in different libraries.  
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Illustrations of library workflow 

Illustration: Example of a production library 
 

Example of a production library 

Production library

Study element
  Contains the cycle of study  
  events for an oncology study.

AE/CM (study event)
 Form 1: AE (repeating form)
 Form 2: CM (repeating form)

Codelists Forms

Logical schema 
(for rules)

Logical schema 
(for a data extract)

 

The illustration provides examples of content that you can include in a production library, 
including: 

• Study elements. 

• Study events.  

• Forms (in or not in study events). 

• Codelists.  

• Mappings.  
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Illustration: Building libraries using study objects from production studies 
 

Building libraries using study objects from production studies 

 

The illustration shows how you can add study objects from a production study to a production 
library. The production study has been validated in the Central Designer application and fully tested 
in the target application. 

The numbers indicate the order in which study objects move among studies and libraries. 

Oracle recommends implementing a process that requires study objects to be approved before they 
can be added to a production library. This task might be performed by a standards group.  
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Illustration: Building libraries from scratch 
 

Building libraries from scratch 

 

The illustration shows how you can create study objects in a test study and then add them to a 
production library.  

Oracle recommends implementing a process that requires study objects to be approved before they 
can be added to a production library. This task might be performed by a standards group.  
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Illustration: Building a study using libraries 
 

Building a study using libraries 

 

The illustration shows how you can add study objects from a production library directly to a 
production study. The production study has been validated in the Central Designer application and 
fully tested in the target application. 
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Illustration: Modifying study objects in production libraries 
 

Modifying study objects in production libraries 

 

The illustration shows how you can modify study objects that are in a production library.  

Oracle recommends updating the version number of the study object in the staging library to track 
changes.  

The processes determined by your company determine whether trivial changes, such as a typo 
correction, need to be retested in the target application. 

Oracle recommends implementing a process that requires study objects to be approved before they 
can be added to a production library, even if they have only been modified and have already been in 
a production library. This task might be performed by a standards group.  
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Illustration: Multiple instances of study objects in production libraries 
 

Multiple instances of study objects in production libraries 

Arthritis studies
production library

Cholesterol studies
production library

Migraine studies
production library

Study events

Study events

Forms

Vital Signs
    Item 1: itm_wgt
    Item 2: itm_hgt
    Item 3: itm_bmi

Vital Signs_2
    Item 1: itm_wgt
    Item 2: itm_bps
    Item 3: itm_bmi2

Vital Signs_2
    Item 1: itm_wgt2
    Item 2: itm_hgt2
    Item 3: itm_bmi2

Adverse Events
 Item 1: itm_AE
 Item 2: itm_date onset

Study events

DEM
 Item 1: itm_dob
 Item 2: itm_scr date
 Item 3: gender

Forms

Forms

itm_wgt

 

Study objects, including forms and items, can appear multiple times in a single library and can also 
appear in other libraries. For example, in the illustration: 

• The following forms were copied with the Copy > Link option: 

 Vital Signs—Appears in both the Arthritis and Migraine libraries. 

 DEM—Appears in both the Migraine and Cholesterol libraries. 

 Adverse Events—Appears in all three libraries. 

• An item may be in a library in multiple places. For example, the itm_wgt is: 

 In the Migraine library as part of the Vital Signs_2 form. 

 In both the Migraine and Arthritis libraries as part of the Vital Signs form. 

 In both the Migraine and Arthritis libraries as a standalone item. 
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Planning how to manage study objects 
Central Designer libraries make it possible to store and reuse the study objects that make up a study. 
When planning the development of a study, consider how you want to manage study objects. 

 

Questions to consider Notes 

Do you prefer to develop 
studies based on your data 
analysis and reporting needs or 
based on the forms used to 
collect data? 

The Central Designer application supports both approaches: 

• Data-based—You can start by developing mappings. 

• Form-based—You can start by developing forms, items, and 
other study objects, or by creating a study workflow. 

You can also work on both approaches simultaneously. 

What types of libraries do you 
want to maintain? 

For example, libraries for: 

• Therapeutic areas. 

• Functions. 

• Codelists and codelist items. 

• Customers (CRO). 

• Mappings for SDTM or ODM. 

Do you have an existing library 
that you want to use? 

You can import libraries in CSML or ODM format. 

How do you want to be able to 
search for study objects? (How 
will you categorize study 
objects?) 

For example: 

• By therapeutic area 

• By customer (CRO) 

• By study 

What types of study objects 
will be reused in multiple 
studies? 

For example: 

• Standard forms. 

• Study objects with rules. 

Who will be responsible for 
setting up libraries and for 
determining the content of 
libraries? 

Study object management tasks can include: 

• Naming (for example, enforcing adherence to a naming 
convention). 

• Categorizing. 

• Making changes. 

• Publishing (making study objects available for reuse). 
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Questions to consider Notes 
How do you want to use study 
templates? 

Any part of study object definition can be stored in a template, 
including a whole study, and you can create templates from all 
types of study objects and from mappings. For example, a study 
template can include: 

• Standard study objects, including child study objects such as 
codelists. 

• Default settings of study object properties. 

• Team members. 

• Full or partial workflows. 

• Rules. 

• Mappings 

How will study object reuse 
affect your testing of study 
designs? 

If you perform formal testing on study objects before saving them 
in a library, it should not be necessary to retest them each time 
they are reused. 

Will you develop naming 
conventions for study objects? 
How will your reporting needs 
affect naming conventions? 

Consider that study objects have RefNames and titles: 

• A RefName is the formal name of a study object. RefNames 
are: 

• Referenced in rules. 

• Deployed to the InForm software. 

• A title is an additional name that you can make more readable 
than a RefName (for example, titles can contain spaces and 
special characters). Titles are: 

• Not referenced in rules. 

• Not deployed to the InForm application. 

Additionally, a data set and data series in a mapping can have an 
alias, which, if present, is used as the column heading in a 
customer-defined database (CDD). 

How do you prefer to test 
study objects? 

You could: 

• Create study objects in a study, validate and deploy the study, 
and move tested study objects to a library. 

• Create study objects in a test library, use them in a study to 
test them, and move tested study objects into a library for 
general use. 
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Planning rules and edit checks 
Rule definition accommodates different levels of technical expertise. 

 

Questions to consider Notes 
What types of rules and edit 
checks does the study require? 

What types of rules can you create on standard study objects that 
can be reused? 

What standard edit checks can 
be defined in a rule template?  

 

What types of functions do you 
require, in addition to the 
functions included with the 
Central Designer application? 

 

What types of additional 
functions would make the 
development of rules simpler or 
would make rules easier to 
reuse? 

The functionality encapsulated in functions and rule templates 
does not need to be tested in every study object where it is used. 

How do you want to assign the 
development of rules to the 
members of your team? 

Consider: 

• Will one user create rule specifications and another user 
implement the rules? 

• Which rules can be created with templates or functions by 
users with no programming experience? 

• Which rules require users with programming experience? 

How do you plan to test new 
data-entry rules? 

You can use the Rule Test Cases dialog box to test data-entry 
rules, global conditions, and workflow rules. 

How do you plan to test new 
functions that you develop? 

 

 
 



 User Guide  

Oracle® Health Sciences Central Designer 2.0 41 

Planning the study workflow 
 

Questions to consider Notes 
What is the structure of your study? Does the study include: 

• Multiple treatment arms? 

• Unscheduled visits? 

• Repeating forms or visits? 

• Dynamic visits, forms or controls? 

• Common forms? 

Do you prefer to develop a study 
from the top down or from the 
bottom up? 

You can use the workflow tools to: 

• Summarize the flow of a study as a reference for the users 
who then develop the detailed definitions of study 
objects. This is a particularly useful communication 
device in complex studies. 

• Connect previously defined study objects. 

When data is collected at multiple 
points in a study, do you want to 
reuse those study objects or make 
them repeating? 

Repeating study objects (study events and forms) enable you 
to see all instances of the collected data in one location, or to 
navigate easily between instances.  
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Planning mappings and data extracts 
You can group study data by using mappings. A mapping is a data grouping that provides an 
alternate data view of a study.  

 

Questions to consider Notes 

What types of reports do you 
need to generate while the 
study is in process? What types 
study data will you need after 
the study is complete? 

 

How do you want to map data 
from an InForm study? 

The Central Designer application supports: 

• Customer-Defined Database (CDD) mappings. 

• CIS mappings to the Clintrial application. 

Do you want to use a mapping 
for rules? 

A mapping for rules allows you to: 

• Write rules that are outside the scope of a study object. 

• Write rules that use arrays of data values. 

Do you want to create data 
extracts that conform to a 
particular standard such as 
SDTM or ODM? 
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Implementing collaboration 

Creating and modifying tasks 

Tasks 
About tasks 

A task is a request that you attach to a study object (a study, study element, study event, form, or 
item). A task is similar to a collaboration note except that you assign a task to an individual or to a 
whole study team. In a task, you can include detailed information and specify a due date and priority. 
You can format the text of a task and attach a file to it. 

Example of using tasks 

For example, a study workflow designer builds the framework for a study and includes information 
about the rules that will be required. A study architect can create rules to use as placeholders, without 
defining their expressions, and then create tasks for rule creation and assign them to the rule 
development team.  

Level at which to create tasks 

You can create a task on the study object, such as the form to be designed, or the parent study 
object, if the study object has not been created. 

If the study object does not exist, consider creating a placeholder study object and then creating the 
task on the study object. For example, when the task assignee double-clicks the task in the Home 
Page, the Project Explorer opens, and the user is brought directly to the study object. 

In general, create one task for each activity to be completed so that completed and remaining work 
can be assessed accurately. 

Copying study objects with tasks 

Tasks are not copied when a study object is copied from a library or published in a library. 

Task types 

When you create a task, you must choose a type on which to base it. 
 

Task types 
Administrators create task types in the Central Designer Administrator application. Task types are 
used to identify the type of the task and the way the task is used. Task types can be classified as 
Standard or Translation. Administrators select a default team to which tasks of each type are 
assigned. Selecting a default team is optional for standard tasks.  

When you create a task, you choose a task type on which to base the task.  

You can create multiple task types for each task classification. Task classifications are predefined and 
you cannot modify them. 
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Task 
classification 

Description Example 

Standard Used for all non-translation tasks assigned to 
an individual or team. 

When you create a standard task, you can 
override the default assignment. 

• Task name: Create form 

• Default teams: Study 
designers, Form designers 

Translation Used for tasks that request translation of a 
study object into one or more languages. 

When you create a translation task, you 
choose the language into which the study 
object must be translated.  

Note: Oracle recommends selecting only one 
language for each translation task, unless you 
expect that the same person will translate into 
all of the selected languages. 

• Task name: Translate form 

• Default team: Translation 
team. 

 

 
 

Task statuses 
Tasks appear in the Home Page and the Tasks Browser. 

• Tasks that are assigned to you appear in the Home Page. 

• All tasks appear in the Tasks Browser. 

Note: If a task is overdue, the status displayed in the status field is Overdue—[Current status], such 
as Overdue—Accepted. 

 

Procedure Task status Description 

Creating a task (on 
page 48). 

Open When you create a task, you assign it to one or more 
individuals or teams. 

Accepting a task (on 
page 57). 

Accepted When you accept a task, you take responsibility for 
completing the task. Only one person can accept a task, 
and you can only accept tasks that are assigned to you. 

After you accept a task, you can: 

• Mark it as Complete after you finish all required work. 

• Unaccept it if you will no longer work on the task.  

Unaccepting a task 
(on page 57). 

Open You can unaccept a task that you have accepted but will 
no longer work on. An unaccepted task is assigned to the 
team to whom it was originally assigned. If no default 
team was selected, you are prompted to assign the task to 
a team or individual.  
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Procedure Task status Description 

Completing a task 
(on page 57). 

Completed You can mark as Complete only those tasks that you have 
accepted. A completed task is assigned to the task creator.  

The task creator can do the following to a completed task: 

• Close it if work is complete.  

• Reopen it if work is not complete.  

Closing a task (on 
page 57). 

Closed You can close completed tasks that you created. You close 
a task after you verify that all work has been completed. A 
closed task is assigned to the task creator. 

Reopening a task 
(on page 57). 

Open Two people can reopen a task, the person who created it 
and the person who completed it. A reopened task is 
assigned to the individual or team to whom it was assigned 
by default. If no default team was selected, you are 
prompted to assign the task to a team or individual. 

 

 
 

Task workflow 
In the following illustration, activities appear in boxes with task statuses below them. 
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Creating a task 

Note: You must save a study object before you can attach a collaboration note or task. 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Tasks Browser, click New Task.  

The Task Editor dialog box appears. 

3 From the Task Type drop-down list, select the type of task to create. (Task types are defined in the 
Central Designer Administrator application.) 

4 From the Priority drop-down list, choose a priority for the task. 

5 From the Due drop-down list, choose the date that the task is due.  

6 On the Instructions tab, type the instructions for the task. 

7 To edit the appearance of the text, use the buttons on the toolbar. 

8 To add an attachment, complete the following steps: 

Note: The maximum size of the attachment is determined by a variety of factors, including 
information defined in the configuration file, available hard disk space, and available 
memory. To determine the approximate maximum attachment size, check the 
maxRequestLength attribute in the machine.config file. 

a Click the Attachments button ( ).  

The Attachments dialog box appears.  

b Click Add.  

The Open dialog box appears.  

c Navigate to a file, and click Open.  

Click OK.  

9 If you are creating a Standard task, select the Assignment tab and choose the team (or teams) or 
user (or users) to assign the task to.  

or  

If you are creating a Translation task, select the Languages tab and choose the languages to which 
the task must be translated. (Only the languages configured as supported locales in the Central 
Designer Administrator application appear.) 

Note: You must assign every task to at least one individual or team. For translation tasks, 
the default assignment for the task type is used. 

10 Click OK. 

For more information, see Task Editor dialog box - Option descriptions (on page 145). 
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Changing the assignees for a standard task 
When the status of a task is open, you can change the assignees for a standard task, but you cannot 
remove all assignees from the task. 

Note: You cannot change the assignees for translation tasks. 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Tasks Browser, select a task. 

3 On the toolbar, click Edit. 

The Task Editor dialog box appears. 

4 Click the Assignment tab. 

5 Modify the users or teams to which the task is assigned. You must assign the task to at least one 
person or team.  

6 Click OK. 

For more information, see Task Editor dialog box - Option descriptions (on page 145). 
 

Deleting a collaboration note or task 
Only the creator of a task or a user with the necessary rights can delete a task. Consider deleting tasks 
that were created in error or that are no longer relevant. Tasks provide an audit trail for assigned 
activities, so you should not delete tasks if you want to maintain an audit trail of assigned activities.  

If too many tasks appear on the Home Page, use filters to view, for example, only Open or Accepted 
tasks.  

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 For tasks—In the Tasks Browser, select a task. 

For collaboration notes—In the Collaboration Notes Browser, select a collaboration note. 

3 Click Delete. 

A message asks you to confirm the deletion. 

4 Click Yes. 
 

Editing a collaboration note or task 
You can edit the text of collaboration notes and tasks, and you can remove attachments from 
collaboration notes.  

To edit the text of a task: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Tasks Browser, select a task. 

3 On the toolbar, click Edit, or double-click the task. 
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The Task Editor dialog box appears. 

4 Edit the task as necessary, and click OK. 

To edit the text of a collaboration note: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Collaboration Notes Browser, select the collaboration note that you want to edit. 

3 On the toolbar, click Edit, or double-click the collaboration note. 

The Collaboration Note Editor dialog box appears.  

4 Edit the collaboration note as necessary, and click OK. 

To remove an attachment from a collaboration note: 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Collaboration Notes Browser, select a collaboration note, and click Edit. 

The Collaboration Note Editor dialog box appears.  

3 Click the Attachments button (a paperclip icon).  

The Attachment dialog box appears.  

4 Select the file that you want to remove, and click Remove.  

5 Click OK. 

For more information, see: 

Collaboration Note Editor dialog box - Option descriptions (on page 142). 

Task Editor dialog box - Option descriptions (on page 145). 
 

Printing a collaboration note or task 
1 In the Project Explorer, select a study object (study design, study element, study event, form, 

section, item, codelist, codelist item, mapping, data set, or data series). 

2 Do one of the following: 

• For tasks—In the Tasks Browser, select a task. 

• For collaboration notes—In the Collaboration Notes Browser, select a collaboration note. 

3 Click Print. 
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Tasks Browser 
The Tasks Browser displays all tasks that are attached to the study object that is selected in the 
Project Explorer and, optionally, its child study objects. All users can see the tasks assigned to them. 

In the Tasks Browser, you can: 

• Create, view, sort, filter, and group tasks. 

• Modify and delete a task.  

• Print tasks. 

• Select Show Children. You see all tasks attached to the selected study object and its children. 

• Filter the tasks that appear. For more information, see Filtering data in a grid (on page 22). 

By default, the browser is located at the bottom of the application window. 

To open the Tasks Browser: 

• Select the View menu, and make sure Tasks is selected. 

For more information, see Tasks Browser - Option descriptions (on page 144). 
 

Creating a collaboration note 
You can create a collaboration note from the Project Explorer and from the Collaboration Notes 
Browser. 

Note: You must save a study object before you can attach a collaboration note or task. 

1 In the Project Explorer, select a study object (study design, study element, study event, form, 
section, item, codelist, codelist item, mapping, data set, or data series). 

2 Right-click the study object, and select Add Collaboration Note. 

or 

In the Collaboration Notes Browser, click New Note. 

The Collaboration Note Editor dialog box appears. 

3 From the Note Type drop-down list, select a collaboration note type.  

Note: Collaboration note types are defined in the Central Designer Administrator 
application. 

4 On the Instructions tab, type the instructions for the task. To edit the appearance of the text, use 
the buttons on the toolbar. 

5 To add an attachment, complete the following steps: 

Note: The maximum size of the attachment is determined by a variety of factors, including 
information defined in the configuration file, available hard disk space, and available 
memory. To determine the approximate maximum attachment size, check the 
maxRequestLength attribute in the machine.config file. 
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a Click the Attachments button ( ).  

The Attachments dialog box appears.  

b Click Add.  

The Open dialog box appears.  

c Navigate to a file, and click Open.  

Click OK.  

6 Click OK.  

For more information, see Collaboration Note Editor dialog box - Option descriptions (on page 
142). 
 

Collaboration notes 
A collaboration note is a note that you attach to any study object, such as a project, study, study 
element, study event, form, or item. A collaboration note is like an electronic sticky note in which 
you include annotations, comments, messages, and file attachments. View the collaboration notes 
that are attached to a study object and, optionally, to its children, in the Collaboration Notes 
Browser. 

When you create a collaboration note, you must choose a type on which to base it. 
 

Collaboration note types 
When you create a collaboration note, you choose a collaboration note type on which to base the 
collaboration note. Administrators define collaboration note types in the Central Designer 
Administrator application. Collaboration note types are used to identify the type and purpose of a 
collaboration note. You can filter the view of collaboration notes in the Collaboration Notes Browser 
according to type.  

For example, an administrator might create a collaboration note type called Information to provide 
important information about study objects in a study and a Usage note type to tell where a study 
object can be used. 
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Collaboration Notes Browser 
The Collaboration Notes Browser displays the collaboration notes that are attached to the study 
object that is selected in the Project Explorer and, optionally, its child study objects. 

In the Collaboration Notes Browser, you can: 

• Create, view, sort, filter, and group collaboration notes. 

• Modify and delete a collaboration note. 

• Print one or more collaboration notes. 

• Select Show Children. You see all collaboration notes attached to the selected study object and 
its children. 

• Filter the collaboration notes that appear. For more information, see Filtering data in a grid 
(on page 22). 

By default, the browser is located at the bottom of the application window. 

To open the Collaboration Notes Browser: 

• Select the View menu, and make sure Collaboration Notes is selected. 

For more information, see Collaboration Notes Browser - Option descriptions (on page 142). 
 

About locking study objects 

Determining whether a study object is locked 
Only the user who holds the lock can modify a study object. The following types of locks are 
available: 

• An automatic lock, also known as an implicit lock, is applied to a study object when you modify 
it and released when you save or close without saving. 

• A requested lock, also known as an explicit lock, is applied to a study object when you explicitly 
lock a study object and released only when you unlock the study object. You might request a 
lock if you plan to work on a study object for an extended period of time.  

To determine whether a study object is locked: 

• In the Project Explorer, view the icon for the study object. 

• Normal icons appear for unlocked study objects.  

• Shaded icons appear for locked study objects. 

• If the lock icon is green, you hold the lock. 

• If the lock icon is red, someone else holds the lock. The tooltip for the study object has 
the name of the user who holds the lock. 

or 

In the Properties Browser, check whether the Locked property is set to True or False. 
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Locking and unlocking a study object 
You can lock and unlock a study object (study design, study element, study event, form, section, 
item, codelist, and codelist item). 

To explicitly lock a study object: 

• In the Project Explorer, right-click a study object, and select Lock. 

The study object is locked, and a green lock icon appears in the Project Explorer. 

To unlock a study object: 

Note: If you unlock a study object without saving, you are prompted to save changes, discard 
changes, or cancel. 

• In the Project Explorer, right-click a study object, and select Unlock. 

The study object is unlocked, and the green icon in the Project Explorer is removed. 
 

Locking and unlocking a workflow rule 
To explicitly lock a workflow rule: 

1 In the Project Explorer, select a study design, study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click a workflow rule, and select Lock Rule. 

Note: Workflow rules appear as diamond-shaped objects in the workflow. 

To unlock a workflow rule that you explicitly locked: 

1 In the Project Explorer, select a study design, study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click a workflow rule, and select Unlock Rule. 
 

Locking and unlocking a global condition 
1 In the Project Explorer, select a study design, study element, or study event. 

2 Select the Workflow Diagram tab. 

3 On the toolbar, click Global Conditions. 

The Edit Global Conditions dialog box appears. 

4 To explicitly lock a global condition, right-click a global condition, and select Lock. 

5 To unlock a global condition that you explicitly locked, right-click a global condition, and select 
Unlock. 
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Locking and unlocking a data-entry rule 
A lock is automatically applied when you begin editing a rule and is released when you save the rule. 
If you want to work on a rule for an extended period of time, you can explicitly lock it to prevent 
others from working on it. 

1 In the Project Explorer, select the study object on which the data-entry rule is created. 

2 Select the Rules tab. 

3 To explicitly lock a data-entry rule, right-click the data-entry rule, and select Lock. 

4 To unlock a data-entry rule that you explicitly locked, right-click the data-entry rule, and select 
Unlock. 

 

Revoking and transferring a lock on a study object 
You can perform the following actions on a study object (study design, study element, study event, 
form, section, item, codelist, and codelist item): 

• Revoke someone else's lock on a study object.  

• For a study object that you locked in another session, such as on another computer, transfer the 
lock to your current session. 

If a study object has a parent object that is locked by another user: 

• You cannot revoke the lock on the study object. 

• If you revoke the lock on the parent object, remote locks on the parent object's children are also 
revoked. 

Note: When you revoke a lock, any unsaved changes made by the person who holds the lock are 
lost. 

To remove another user's lock on a study object: 

1 In the Project Explorer, right-click a study object that someone else has locked, and select Revoke 
Lock. 

2 In the confirmation message, click Yes. 

Any unsaved changes that the other user made are lost, and the lock is removed. 

To transfer a lock from another session: 

1 In the Project Explorer, right-click a study object that someone else has locked, and select 
Transfer Lock. 

2 In the confirmation message, click Yes. 
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Working in a collaborative environment 

Interacting with assigned tasks 

Viewing all tasks assigned to you 
You can view all tasks assigned to you in the Home Page in the My Recent Tasks Since section and 
the My Tasks section. 

• On the toolbar, click the Home Page button ( ). 

The Home Page appears, and the My Recent Tasks Since and My Tasks sections display tasks 
assigned to you. 

 

Accepting, unaccepting, completing, closing, and reopening a task 
1 In the Project Explorer, select a study object (study design, study element, study event, form, 

section, item, codelist, codelist item, mapping, data set, or data series). 

2 In the Tasks Browser, select a task. 

3 On the toolbar, click an action. 

or 

Double-click the task. In the Task Editor dialog box, click an action. 

For more information, see Task Editor dialog box - Option descriptions (on page 145). 
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About projects, studies, and libraries 
 

Characteristic Description 
About projects Projects are containers used to hold study design building blocks. You 

can create two types of projects: 

• Study project—A project containing one or more studies that are 
related to each other. 

• Library project—A project containing a library. 

Number of studies 
and libraries to create 

You can create one library in each library project. There is no limit on the 
number of studies you can create in a study project. However, you might 
experience performance degradation if you have multiple studies in a 
single project, especially if the number of study objects is large. 

Contents Studies and libraries contain the same types of study objects. A study 
object is a study building block that appears in the Project Explorer.  

Repository All study objects and components are stored in a single database instance 
called the repository. The repository can be organized into multiple 
libraries, each of which can be managed differently and can serve a 
different purpose. For example, you can organize libraries by therapeutic 
area or by team. Central Designer libraries store study objects for reuse 
and help enforce standards. 

A library project is a project containing a library. A library is a container 
used to store related study objects and templates to be published for 
reuse in studies or other libraries. A library provides a logical view of the 
study objects in the repository. 

A librarian creates libraries within library projects and then includes 
resources from the repository or defines new resources within the library 
itself.   

If you have the appropriate rights (assigned in the Central Designer 
Administrator application) and you are a member of the library team, you 
can: 

• Create study objects and templates. 

• Publish study objects for other team members to use in study 
designs. 

• Search for study objects using categories and keywords.  

Reuse Study objects that are created in libraries can be copied easily into 
multiple studies. Additionally, study objects that are created and saved in 
studies are available for reuse when copied directly from the repository. 
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Characteristic Description 
System library Oracle recommends that you do not modify information in the System 

Library. Instead, copy item types from the System Library to another 
library, and modify information in the new library.  

When you create an item, you can choose to base it on any of the types 
in the libraries in the Library List, so make sure you add the new library 
to the list. Optionally, if you do not want the item types in the System 
Library to appear as options, you can remove the System Library from 
the Library List. 
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Library administration 
The study objects and components that are used to design studies are stored in the repository. A 
library is a container used to store related study objects and templates to be published for reuse in 
studies or other libraries. A library provides a view of the study objects in the repository 

To set up a library in which users can develop and publish study objects, you use the tabs of the 
Library Editor in a library within a library project. 

In the Library Editor, you define library properties, such as the supported locales and form layouts 
for deployment, the users who can work in the library, and the functions and constants that can be 
used when creating rules for study objects in the library. 

Note: To define additional properties for a study object, consider using custom properties. In the 
Central Designer Administrator application, an administrator creates custom properties and can 
provide predefined values or allow Central Designer users to provide values. For more 
information, see the Administrator Guide. 

 

Creating a library 
When you create a library, the Central Designer application creates a library project with the same 
name by default. You can change the library project name when creating the library. Each library 
project can have only one library. 

1 Select File > New Library Project. 

The New Library dialog box appears. 

2 Type a name and description.  

3 In the Targets section, select the target applications for which you will create study objects in the 
library.  

4 To change the name of the associated library project, select the Library Project tab, and type a 
name and description for the library project. 

5 Click OK. 
 

Opening and closing a study or library project 
To open a study or library project: 

• In the Recent Projects List of the Home Page, double-click a study or library project. 

or 

a Select File > Open, or press Ctrl+O.  

The Open dialog box appears. 

b Optionally, in the Filter field, specify the text to use for filtering the list of study or library 
projects.  

The list of study or library projects changes to include only projects whose name or 
description includes the specified text (not case-sensitive). 

c Optionally, in the Project Types field, select whether to show only study or only library 
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projects. 

Note: To appear in the list of study and library projects, a project must match both the 
text in the Filter field and the project type selected in the Project Types field. 

d Select a study or library project, and click Open. 

To close a study or library project: 

1 Select File > Close. 

2 If prompted, confirm that you want to save changes. 
 

Setting up library teams 

Users Browser searches 
To open the Users Browser: 

• Select the View menu, and make sure Users is selected. 
 

Characteristic Description 
Use To find users and add them to: 

• A study team (in a study project), which an administrator creates as a role 
with a study scope in the Central Designer Administrator application. 

• A library team (in a library project), which an administrator creates as a role 
with a library scope in the Central Designer Administrator application. 

Note: A user must be assigned to the corresponding role to be added to a team. 

Location of the 
Users Browser 

By default, the browser is located to the right in the application window. 

Features You can: 

• Create and save search criteria for personal or global use.  

• Open, close, delete, rename, and switch to different searches. 

Required search 
parameters 

No required parameters. 

Optional search 
parameters 

Use one, several, or none of the following: 

• Text 

• Categories 

• Keywords 

The asterisk (*), percent sign (%), and underscore (_) are wildcard operators, 
which are inserted before and after text. For example, dem automatically 
becomes *dem*. Use a comma as a delimiter. 
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Characteristic Description 
How the search is 
performed 

Text, keywords, categories, and libraries are connected with the AND operator. 
Criteria within each parameter are connected with the OR operator. For 
example: 

• Text that you type 

AND 

• Keyword1 OR Keyword2 

AND 

• Category1 OR Category2 

Which 
information is 
searched 

User names, display names, titles, first names, and last names of: 

• Active users 

• Inactive users 

Note: You can add inactive but not terminated users to teams. View the status 
of users in the Central Designer Administrator application. 

Search results Users are listed in alphabetical order according to display name, with user names 
in parentheses.  

 
 

Finding and adding a user to a library team and saving the search 
An administrator creates library teams as library roles in the Central Designer Administrator 
application. A user must be assigned to the corresponding role to be added to a team. 

For example, if a user is assigned to the Librarian library role in the Central Designer Administrator 
application, the user must be a member of the Librarian library team for a library (in the Central 
Designer application) to work in the library. You assign users to roles in the Central Designer 
Administrator application and to study and library teams in the Central Designer application. You 
assign a user to a library team for the selected library only. 

Note: To view all users, click Find without entering parameters. Depending on the size of the 
repository, this search might take several minutes.  

To add a user to a library team: 

1 Open a library project and select the library containing the team to which you want to add a user. 

2 Select the Users Browser. 

3 Optionally, to name the search: 

a Select Actions > New Search. The Actions menu is located at the top of the browser. 

The New search dialog box appears. 

b Type a name for the search, and click OK. 

The name of the search appears on a tab to the right of the browser. 

4 In the Enter search text field, type text that appears in the user's name or display name, title, first 
name, or last name. 
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5 To include categories and keywords (on page 71) as parameters, click the down arrows button 
( ) next to the Search Filter, and then: 

• Optionally, select the Categories tab, and select one or more categories. 

• Optionally, select the Keywords tab, and select one or more keywords. 

The parameters you select appear in the field below the Search Filter. 

6 Click Find. 

The Central Designer application performs a search based on your search criteria. For more 
information about how searches work, see Users Browser searches (on page 63). 

7 In the Project Explorer, select the Library Information Explorer bar. 

8 Select the library. 

9 Select the Teams tab. 

All teams created in the library scope in the Central Designer Administrator application appear in 
the workspace. 

10 In the [Study name] - Teams section, select a team.  

The name of the team appears above the right section on the tab.  

11 In the Users Browser, select a user, and drag the user to the right section. 

The user is added to the team. You can add the user to more teams or add different users to 
teams. 

Note: You can also add a user to a team by dragging the user directly to the team name in 
the left section. 

Note: The user that you added must log out and log on again to have the privileges 
associated with the team. 

To save the search: 

1 Select Actions > Save Search to Repository. The Actions menu is located at the top of the browser. 

The Save Search to Repository dialog box appears. 

2 Optionally, type a description for the search. 

3 Select an option: 

• Just me—Only you can see and use the search. 

• Everyone—Everyone can see and use the search. 

4 Click Save. 
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Opening a search saved in the repository 
All saved searches are stored in the repository, which contains all data created and saved in the 
application. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Open Search from Repository. The Actions menu is located at the top of the 
browser. 

The Open Search from Repository dialog box appears. 

3 Select a search, and click Open. 

The search opens. A tab with the name of the search appears to the right of the browser. 
 

Clearing search parameters 

Note: If you clear the parameters of a saved search but do not save after clearing, the search is 
saved with parameters. 

• In the Libraries Browser or Users Browser, click Clear Search, which is located at the top of the 
browser. 

The following information is cleared: 

• Text in the Enter search text field. 

• Selected categories and keywords. 

• Selected libraries (in the Libraries Browser only). 
 

Closing an active search 
All saved searches are stored in the repository, which contains all data created and saved in the 
application.  If you close a saved search, the search is removed from your view but is not deleted. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select a tab. Tabs are located along the right side of the browser. 

3 Select Actions > Close Active Search. The Actions menu is located at the top of the browser. 

The search is closed. If it is a saved search, it remains in the repository. If it is not saved, it is 
removed and cannot be reopened. 

 

Deleting a search from the repository 
1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Delete Search from Repository. The Actions menu is located at the top of the 
browser. 

The Delete Search from Repository dialog box appears.  

3 Select a search, and click Delete. 
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Removing a user from a study or library team 
1 In a study, select the Study Information Explorer bar. 

or 

In a library, select the Library Information Explorer bar.  

2 Select the study or library. 

3 Select the Teams tab. 

4 In the left section, right-click the user, and select Remove from Team. 
 

Library security 
Access to a library is determined by the following library security features. 

 

Security feature Where to perform Description 
Assign rights and 
roles (in the 
Administrator Guide) 

Central Designer 
Administrator 

Libraries contain published and unpublished 
resources for reuse within studies. The librarian 
manages the users who are granted access to a 
library. 

Assign users to 
library teams (on 
page 64) 

Library An administrator must add you to a library study 
team before you can create or modify objects in 
that library. 

Enable and disable 
a library (on page 68) 

Library Libraries are enabled (or made accessible to other 
users) by default. The librarian can enable or 
disable the library at any time. For example, a 
librarian might disable a library to create and 
organize its resources before making the library 
visible to other users. When the library is ready for 
use, the librarian enables it.  

Note: You cannot search a disabled library. 

Publish library 
objects (on page 70) 

Library You must publish a study object that was created 
in a library to allow other users to search for it in 
the Libraries Browser. 

Create a library list 
(in the InForm Design 
Guide) 

Study You can search only libraries that appear in a 
study's library list for study objects to include in 
the study. 

Protect and 
unprotect study 
objects (on page 68) 

Study or library • You can: 

• Protect study objects in studies and libraries to 
prevent users from making changes. 

• If you protect a study object, all of its children 
are also protected. 

• Protect an entire study or library. 
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Disabling and enabling a library 
You can disable a library to: 

• Prevent users from using library resources while you are working on them. 

• Close a library that you no longer use.  

Members of a library team can work in a disabled library if they have the necessary rights. However: 

• Study administrators cannot add the library to the Library List for a study. 

• Study designers cannot search for study objects in the library, even if it is already in the Library 
List for the study. 

To disable or enable a library: 

1 In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click a library, and select or deselect Enable Library. 
 

Protecting and unprotecting a library 
To protect a library: 

1 In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click the library and select Protect. 

The selected library and all of the study objects within the library are protected. 

The icons to the left of the library and all of the study objects within the library change to reflect 
a protected status. 

Note: You cannot delete study objects that are the direct children of a protected study object. 
After you protect a study object, you cannot select Undo, but you can select Unprotect. 

To unprotect a library: 

1 In the Project Explorer, select the Library Information Explorer bar. 

2 Right-click the library and select Unprotect. 

The selected library is unprotected. 

The icon to the left of the library changes to reflect an unprotected status. 

Note: Unprotecting a library or a study object in a library does not affect study objects that you 
copied from the library into a study. 
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Publishing, republishing, and unpublishing 

About publishing, republishing, and unpublishing 
You must publish study objects that were created in a library to allow users to search for them in the 
Libraries Browser. You can publish, republish, and unpublish study objects only in a library. You 
must save a study object before you publish or republish it. 

In a library, you can publish any of the following. 
 

What to publish Notes 
A single study object.  When you publish a study object, you publish its 

most recent version or revision. 

A study object and its child study objects.  • When you publish a form and its children, 
sections on the form are also published. 

• Publishing child study objects is not supported 
for mappings. 

• If you modify a study object or one of its 
children, you can use the republish option to 
publish the study object and its children again. 

• If you copy a study object with child study 
objects from the Libraries Browser to a study or 
library, the child study objects are also copied, 
regardless of whether they are published. 

All study objects.   
 

Note: To prevent users from finding study objects using the Libraries Browser, unpublish the study 
objects. 

 

Guidelines for publishing, republishing, and unpublishing 

• Publish and reuse study objects at the highest-level study object that makes sense. For example, 
consider publishing and reusing forms rather than individual items, unless you specifically need 
individual items to be available in a library. A reused form can save you more time than a reused 
item.  

• Where possible, consider publishing and reusing study events and study elements rather than 
forms. 

• Consider publishing codelists and codelist items so they can be shared and reused. 
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Workflows and published study objects 

You can develop study workflows in either a study or a library, and you can use study objects found 
in a Libraries Browser search to define a workflow in a study in the following ways: 

• Adding a published study object to a workflow—You can drag a published study object from 
the Libraries Browser to a workflow tab in a study (for example, you can drag a published study 
event to the Workflow Diagram tab in the Study Editor or Study Element Editor). When you do 
this, the study object from the Libraries Browser is added to the workflow in the study. 

• Replacing a published study object in a workflow—You can drag a published study object 
from the Libraries Browser onto a study object in a study (for example, you can drag a published 
form from the Libraries Browser and drop it onto a form object in the Workflow Diagram tab in 
the Study Event Editor of a study). When you do this, the study object from the Libraries 
Browser replaces the definition of the study object. This method enables you to create an outline 
of a study workflow without defining the properties of the study objects and then to replace the 
placeholder study objects with fully defined, published study objects. 

 

Publishing, unpublishing, and republishing a study object 
Publishing a study object (a study element, study event, form, section, item, codelist, and codelist 
item) created in a library makes it available for copying into a study. Unpublishing a study object 
makes it unavailable for future copying unless you republish it. 

To publish or republish a study object (with or without child study objects): 

1 In a library project, save the study object that you want to publish or republish. 

2 In the Project Explorer, right-click a study object, and: 

• To publish—Select Publishing > Publish. 

• To republish—Select Publishing > Republish. 

3 If prompted, confirm whether to publish or republish the child study objects. 

To publish or republish all study objects in a library: 

1 Select File > Save Project. 

2 Do one of the following: 

• To publish—In the Project Explorer, right-click a library, and select Publish Study > Publish. 

• To republish—In the Project Explorer, right-click a library, and select Publish Study > 
Republish. 

To unpublish a study object (with or without child study objects): 

1 In the Project Explorer of a library project, right-click a study object, and select Publishing > 
Unpublish. 

2 If prompted, confirm whether to unpublish the child study objects. 

To unpublish all study objects in a library: 

• In the Project Explorer of a library project, right-click a library, and select Publish Study > 
Unpublish. 
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Publishing a template 
After creating or modifying a template, you must do the following to make your changes available: 

• For study project templates and study templates, save the template. 

• For all other study object templates, save and publish the template at any time. Your changes are 
not available to others until you publish the template. 

1 Open a library project. 

2 In the Project Explorer for a library, select the Types and Templates Explorer bar. 

3 Expand the Templates folder, and expand the folder for the type of study object (for example, the 
Study Events folder). 

4 Right-click the template, and select Publish. 
 

Publishing a type 
After you create or modify a type, save and publish the type. Your changes are not available to others 
until you publish the type. 

1 Open a library project. 

2 In the Project Explorer for a library, select the Types and Templates Explorer bar. 

3 Right-click a type, and select Publish. 
 

Categorizing study objects 

Categorization of study objects 
You can categorize a study object with keywords and categories to facilitate searching for study 
objects in the Libraries Browser. You must save a study object before categorizing it. 

Usefulness of categorization 

Categories and keywords are especially helpful in libraries with many study objects. When study 
objects are categorized, you can find a study object by selecting categories or keywords when you 
search rather than scanning study objects in the search results list. 

Types of keywords and categories 

The following keywords and categories are available. 
 

Type of keyword or category Location in 
Libraries Browser 

System keywords are keywords that are installed by default with the Central 
Designer application or that an administrator creates in the Central Designer 
Administrator application.  

Keywords tab > 
System list 

User keywords are keywords that a Central Designer user creates.  

You cannot view keywords that other users create, and other users cannot 
view your user keywords. 

Keywords tab > 
User list 
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Type of keyword or category Location in 
Libraries Browser 

Automatically generated categories are categories that automatically catalog 
study objects by auditing information (for example, the study object type, 
original author, creation date, and library in which the study object was 
created). 

Categories tab >  
Automatically 
Generated tree 

Manually generated categories are categories that you create by dragging 
keywords to the Categories tree. 

Categories tab >  
Manually Generated 
tree 

 

All study objects are categorized in the following way:  

• In a study: [Study Project Name] > Study > [Study Name].  

• In a library: [Library Project Name] > Library > [Library Name]. 

The categorization information appears below a Project category. When you change the name of a 
project, library, or study, the corresponding category is automatically updated. 

When to categorize 

If you have a categorization plan, consider categorizing study objects as you create them. If you 
expect your categorization plan to change, consider categorizing study objects after creating most of 
them. 

Note: You can categorize multiple study objects at once in study object container editors.  

Example 

In the following example, cardiology appears as a category. The categories of heart, arteries, and 
veins appear below cardiology, and cardiology also appears below the therapeutic area category.  

You can search for a study object that has been categorized with cardiology: 

• No matter where cardiology appears in the Categories tree. 

• When cardiology appears only under therapeutic area. 

• When cardiology appears with arteries, heart, and veins below it. 
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Categorizing a study object 
You categorize a study object (study design, study element, study event, form, section, item, codelist, 
and codelist item) with keywords and categories to facilitate searching for study objects in the 
Libraries Browser. 

1 In the Project Explorer, right-click a study object, and select Categorize.  

The Categorize dialog box appears.  

2 Optionally, select one or more the categories on the Categories tab.  

Note: If you select a category, all child categories beneath it are also selected. 

3 Click Next, or select the Keywords tab. 

The Keywords tab appears. 

a Optionally, select the keywords from the list of system keywords or the list of user-defined 
keywords. 

b To create a keyword, type the keyword in the Keywords field, and press Enter. Separate 
multiple keywords with a comma. 

The keyword is added to the list of User keywords. 

4 Click Apply. 
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Finding and using study objects in a library 

Searching for study objects 

Libraries Browser searches 
To open the Libraries Browser: 

• Select the View menu, and make sure Libraries is selected. 
 

Libraries Browser 
searches 

 

Use To find items, forms, and other study objects in a study or library, and then 
copy the study objects into a study or library. 

Location of the 
Libraries Browser 

By default, the browser is located to the right in the application window. 

Features • Create and save search criteria for personal or global use.  

• Open, close, delete, rename, and switch to different searches. 

Required search 
parameters 

• In a study project, you must select at least one library.  

• In a library project, selecting a library is optional.  

Optional search 
parameters 

Use one, several, or none of the following: 

• Text 

• Categories 

• Keywords 

• Libraries 

Note: You can select libraries in study projects only. Choose from the 
libraries in the Libraries tab. 

The asterisk (*), percent sign (%), and underscore (_) are wildcard operators, 
which are inserted before and after text. For example, dem automatically 
becomes *dem*. Use a comma as a delimiter. 
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Libraries Browser 
searches 

 

How the search is 
performed 

Text, keywords, categories, and libraries are connected with the AND 
operator. Criteria within each parameter are connected with the OR operator. 
For example: 

• Text that you type 

AND 

• Keyword1 OR Keyword2 

AND 

• Category1 OR Category2 

AND  

• Library1 OR Library2 
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Libraries Browser 
searches 

 

Information that is 
searched 

Titles, RefNames, and descriptions of: 

• Study elements and study events. 

• Forms and items. 

• Codelists and codelist items.  

• Mappings. 

Titles and RefNames of: 

• Templates and types.  

RefNames of:  

• Functions. 

• Constants. 

Additionally: 

• In a study project 

• In selected libraries, only published study objects are searched.  

• In libraries you do not select, no study objects are searched.  

• Studies are not searched.  

For more information about publishing, see Publishing, republishing, 
and unpublishing (on page 69). 

• In a library project 

• In selected libraries, only published study objects are searched, unless 
you select Include latest object revisions in Repository.  

If you select Include latest object revisions in Repository:  

• The latest revisions of study objects in libraries are searched. 

• All study objects in all studies are searched.  

If you leave the checkbox unselected, studies are not searched.  

• In libraries you do not select, only the latest revisions of study 
objects are searched. 

Note: The Include latest object revisions in Repository checkbox is available in 
the Search Filter section only in a library project. 
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Libraries Browser 
searches 

 

Search results • In a study project 

• Results include only published study objects, which appear below the 
Objects Found container and are organized by library.  

• In a library project 

Study objects are grouped according to whether they are the published 
versions or the latest revisions.  

• Below the Objects Found container, published study objects are 
organized by library and then study object type, such as form or 
item. 

• If you select Include latest object revisions in Repository, the Repository 
container appears below all library containers and holds the latest 
revisions of study objects, organized by study or library and then 
study object type, such as form or item.  

• If the published version of a study object is different from the 
latest revision, the study object appears in two places—in the 
container for the library that holds it (for the published version), 
and below the Repository container (for the latest revision).  

• If the latest revision is the same as the published version, the 
study object appears as a published study object, in the top 
section, organized by library.  

Study objects appear as follows: 

Title (RefName): Description   

Copied study 
objects 

If you copy a study object with child study objects from the Libraries 
Browser to a study or library, the child study objects are also copied, 
regardless of whether they are published. 

When you drag a study object that is in a library from the Libraries Browser 
to another library, you are prompted to choose whether you want to link to 
the existing study object and its children or create new copies of the study 
object and its children. 

When you drag a study object that is in a library from the Libraries Browser 
to a study, or drag a study object that is in a study from the Libraries Browser 
to a library, new copies of the study object and its children are created. 

When you copy a template from the Libraries Browser, a study object 
without a link to the template is created.  
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About searching for a template or type 
To create a study object from a template, find the template in the Libraries Browser and copy it to a 
study. To narrow your Libraries Browser search, you can select categories that limit the search.  

You can select one or more of the following categories, which are automatically applied to templates 
and types, to narrow your search. 

 

Category type Where the categories appear in the Categories tab of the Libraries 
Browser 

Template categories Template categories appear below Automatically Generated > Template. 

Type categories Type categories appear below Automatically Generated > Types: 

• Item—User-created items and System Library types, including Integer 
Item, Text Item, Float Item, Compound Item, and Date Time Item. 

• Primitive Type—Items that are installed with the Central Designer 
application, including Integer Variable, Text Variable, Float Variable, 
Compound Variable, and Date Time Variable.  

 
 

Finding and adding a study object to a study or library and saving the 
search 

In a library, you can create, save, and publish study objects, and then use the Libraries Browser to 
copy them into studies or other libraries. You can also copy study objects created in studies into 
libraries.  

To search using the Libraries Browser, select a library, study, or study object in the Project Explorer. 

Note: To view all results, search without entering criteria. Depending on the size of the repository, 
this search might take several minutes. 

To add a study object to a study or library from the Libraries Browser: 

1 Open a study or library. 

2 In the Project Explorer, select any study object except the library project or study project. 

3 Select the Libraries Browser. 

4 Optionally, to name the search: 

a Select Actions > New Search. The Actions menu is located at the top of the browser. 

The New search dialog box appears. 

b Type a name for the search, and click OK. 

The name of the search appears on a tab to the right of the browser. 

5 To search by title, RefName, or description of the study object, type text in the Enter search text 
field. 

6 To include categories, keywords, and libraries as parameters: 

a Click the double down arrows ( ) next to the Search Filter. 
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b Optionally, select the Categories tab, and select one or more categories. 

c Optionally, select the Keywords tab, and select one or more keywords. For more information 
about categories and keywords, see Categorization of study objects (on page 71). 

d If you are in a study project, select the Libraries tab, and select the libraries to search. You 
must select at least one library. This step is optional if you are in a library project. 

The parameters you select appear in the field below the Search Filter. 

7 Click Find. 

The Central Designer application performs a search based on your search criteria. 

For more information about how searches work, see Libraries Browser searches (on page 74). 

8 Make sure the Project Explorer is selected. 

9 From the Libraries Browser, do one of the following: 

• To add the study object to a parent (for example, add an item to a form)—Drag the study 
object to the parent study object.  

• To add the study object outside the hierarchy of the study (available in a library)—Drag 
the study object to the folder for the study object. For example, drag a study event to the 
Events folder. 

The result depends on the type of project to which you added the study object. For more 
information, see Results of adding study objects to studies and libraries from the Libraries 
Browser (on page 82). 

Note: Study objects are added to the bottom of the list of child study objects under the 
parent. 

To save the search: 

1 Select Actions > Save Search to Repository. The Actions menu is located at the top of the browser. 

The Save Search to Repository dialog box appears. 

2 Optionally, type a description for the search. 

3 Select an option: 

• Just me—Only you can see and use the search. 

• Everyone—Everyone can see and use the search. 

4 Click Save. 
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Clearing search parameters 

Note: If you clear the parameters of a saved search but do not save after clearing, the search is 
saved with parameters. 

• In the Libraries Browser or Users Browser, click Clear Search, which is located at the top of the 
browser. 

The following information is cleared: 

• Text in the Enter search text field. 

• Selected categories and keywords. 

• Selected libraries (in the Libraries Browser only). 
 

Closing an active search 
All saved searches are stored in the repository, which contains all data created and saved in the 
application.  If you close a saved search, the search is removed from your view but is not deleted. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select a tab. Tabs are located along the right side of the browser. 

3 Select Actions > Close Active Search. The Actions menu is located at the top of the browser. 

The search is closed. If it is a saved search, it remains in the repository. If it is not saved, it is 
removed and cannot be reopened. 

 

Opening a search saved in the repository 
All saved searches are stored in the repository, which contains all data created and saved in the 
application. 

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Open Search from Repository. The Actions menu is located at the top of the 
browser. 

The Open Search from Repository dialog box appears. 

3 Select a search, and click Open. 

The search opens. A tab with the name of the search appears to the right of the browser. 
 

Deleting a search from the repository 
1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search). 

2 Select Actions > Delete Search from Repository. The Actions menu is located at the top of the 
browser. 

The Delete Search from Repository dialog box appears.  

3 Select a search, and click Delete. 
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Reusing study objects 

About reusing an item on a form 
You can reuse an item on a form as long as the item's reuse does not create identical context paths 
for the item. A context path is created with only the visit, form, section, and top-level item, even if 
the top-level item has child items or has items that are conditional on it. For instance, consider the 
following hierarchies in the Central Designer application and InForm application: 

  

Hierarchy in the Central Designer 
application 

Becomes the following in the InForm 
application 

Study event > Form or section >  

Item 1 

Item 2 (conditional on Item 1) 

Item 3 (Compound item, conditional on Item 
2) 

Item 4 (Has a rule, conditional on Item 3) 

Item 4 (Has a rule, conditional on Item 1) 

Visit > Form > Section > 

Item 1 

Item 2 (Conditional on Item 1) 

Item 3 (Conditional on Item 2) 

Item 4 (Has a rule, conditional on 
Item 3) 

Item 4 (Has a rule, conditional on Item 1) 

 

In this example, using Item 4 in two places creates the following identical context paths, causing 
validation to fail. The context paths appear below in bold; the non-bold information is the additional 
information that makes the item's placement unique but, that information is not visible to the Central 
Designer application when it tries to determine when rules run: 

• Visit > Form > Section > Item 1 > Item 2 > Item 3 > Item 4 

• Visit > Form > Section > Item 1 > Item 4 

If Item 4 were not conditional on Item 1, you could reuse the item without issues because the 
hierarchy would appear in the following way: 

 

Hierarchy in the Central Designer 
application 

Becomes the following in the InForm 
application 

Study event > Form > Section (optional) >  

Item 1 

Item 2 (conditional on Item 1) 

Item 3 (Compound item, conditional on Item 
2) 

Item 4 (Has a rule, conditional on Item 3) 

Item 4 (Has a rule) 

Visit > Form > Section > 

Item 1 

Item 2 (Conditional on Item 1) 

Item 3 (Conditional on Item 2) 

Item 4 (Has a rule, conditional on 
Item 3) 

Item 4 (Has a rule) 
 

In this example, the following context paths would exist for Item 4. Because the information in the 
context paths is unique down to the first-level item, the reuse is acceptable. 



Chapter 4  Reusing study objects  
 

82 Oracle® Health Sciences Central Designer 2.0 

• Visit > Form > Section > Item 1 > Item 2 > Item 3 > Item 4 

• Visit > Form > Section > Item 4  
 

Results of adding study objects to studies and libraries from the Libraries 
Browser 

The following table describes the results of searching for a study object in the Libraries Browser and 
then adding it to a library or study. 

Note: In the following sections, the library or study that contains the study object is the source 
location. The library or study to which you are adding a study object is the target location. 

 

Process Results of adding the study object 

Library to library 

(The study object is 
in a library, and 
you are adding the 
study object to a 
library.) 

You are prompted to choose one: 

• Link to the existing study object and its children. 

The study object and its children are added to the target location as links. 
Each study object is a single study object that exists in multiple libraries. If 
you change a study object in either library, the change is reflected in the 
other library.  

• Copy the study object and its children to the target location.  

If the study object or any of the child objects have already been copied 
into the target location, new copies of the study objects are not created. 
The existing study objects are referenced correctly by other study objects 
that are copied in.  

For the study object or any children that have not been copied into the 
target location, new copies are created.  

If you change a study object in either library, the study object in the other 
library is not updated.  
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Process Results of adding the study object 
Library to study 

(The study object is 
in a library, and 
you are adding the 
study object to a 
study.) 

or 

Study to library 

(The study object is 
in a study, and you 
are adding the 
study object to a 
library.) 

Copies of the study object and its children are created in the target location. If 
you change a study object in either the target or original location, the study 
object in the other location is not updated. 

Because two study objects in a study cannot have the same RefName, the 
Central Designer application renames study objects in a study when you: 

• Drag a study object from a library to a study, and its RefName is identical 
to an existing study object in the study.  

• Use the Copy > With Children and the Copy > Without Children options.  

When a study object is renamed, it is appended with "_1" (or similar).  

Note: Study object names in a library might not be unique. Additionally, a 
study object can appear in multiple places in a study if it is copied using the 
Copy > Link option. 

Note: If you drag and drop a study object that is mapped to a data series, and 
the study object already exists in the library, the database contains a data point 
for the study object, and the drop operation reuses that data point as is. The 
application warns you that the drag and drop operation is not supported. If 
you continue, any data mappings in the dropped study object that are different 
from the data mappings that are associated with the study object that already 
exists in the library are removed. 

 

Note: You cannot have duplicate RefNames in a study. Duplicate RefNames are allowed in a 
library with the following exceptions:  

• All children of a study object must have unique RefNames. For example, a form can contain 
only one item with the RefName of Item1. However, a library can contain multiple study objects 
with the RefName of Item1. 

• Below any given parent, such as a study event, all child study objects must have unique names. 
For example, a library cannot contain two nonlinked items named Weight on two forms that are 
on the same study event. 

Note: A linked item can appear on two forms in the same study event. 
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Results of modifying study objects that have been copied to studies and 
libraries 

The following table describes the results of modifying a study object after you drag the study object 
from the Libraries Browser to a study or library. 

Note: In the following sections, the library or study that contains the study object is the source 
location. The library or study to which you are adding a study object is the target location. 

 

Action Result Example 

After you add a study object from a 
library to a library using the 
Libraries Browser: 

  

If you modify the study object or one 
of its children in the source location 
and drag the modified study object 
objects to the target location: 

You are prompted to choose 
one of the following: 

• Update the study object 
in the target location.  

If you choose this 
option, the study object 
and any modified 
children are updated, but 
unchanged study objects 
are not updated.  

• Create a link to the 
updated study object 
and its children in the 
target location.  

If you choose this 
option, a new RefName 
is created for the study 
object in the target 
location.  

After you add a form from 
LibraryA to LibraryB using 
the Libraries Browser, if you 
modify the form or one of 
its items in LibraryA and 
drag the modified form or 
item to LibraryB, you are 
prompted to choose one of 
the options described above. 

If you modify the study object in the 
target location and then drag the study 
object to the source location: 

You are prompted to choose 
one of the following: 

• Update the study object 
in the source location.  

• Create a link to the 
modified study object.  

After you add a form from 
LibraryA to LibraryB using 
the Libraries Browser, if you 
modify the form in LibraryB 
and then drag the form to 
LibraryA, you are prompted 
to choose one of the 
options described above. 

After you add a study object from a 
library to a study or from a study to 
a library using the Libraries 
Browser: 
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Action Result Example 
If you create a new study object in the 
target location and drag a child of the 
original study object to the new study 
object: 

The two child study objects 
in the target location are 
automatically linked.  

After you add FormA from 
a library to a study using the 
Libraries Browser, if you 
create FormB in the study 
and drag ItemA (a child of 
FormA) to FormB using the 
Libraries Browser, ItemA on 
FormA and ItemA on 
FormB are automatically 
linked in the study. 

If you modify the original study object 
in the source location and then drag it 
to the same parent in the target 
location: 

You are prompted with the 
following two options: 

• Update the study object 
and its children in the 
target location.  

The study object and 
any modified children 
are updated to the study 
object that you 
previously added. 
Unchanged study 
objects are not updated. 

• Cancel adding the 
original study object and 
its children to the target 
location. 

After you add FormA from 
a library to EventA in a 
study using the Libraries 
Browser, if you modify 
FormA in the library and 
then drag it again to EventA 
in the study, you are 
prompted to choose one of 
the options described above. 

If you modify the original study object 
in the source location and then drag it 
to a different parent (that does not 
already contain the study object) in the 
target location: 

You are prompted with the 
following two options: 

• Update the study object 
and its children in the 
target location.  

The study object and 
any modified children 
are linked to the study 
object in the target 
location, and the study 
object in the target 
location is updated. 

• Cancel adding the 
original study object and 
its children to the target 
location. 

After you add FormA from 
a library to EventA in a 
study using the Libraries 
Browser, if you modify 
FormA in the library and 
then drag it to EventB 
(which does not yet contain 
FormA), you are prompted 
with the options described 
above.  
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Action Result Example 
If you modify one or more children of 
the study object in the source location 
and then drag the study object to the 
target location: 

You are prompted with the 
following two options: 

• Update the children in 
the target location.  

The child study objects 
that were modified are 
updated in the target 
location. 

• Cancel adding the 
original study object and 
its children to the target 
location.  

After you add FormA from 
a library to a study using the 
Libraries Browser, if you 
modify one or more items 
on FormA in the library and 
then copy FormA to the 
study again, you are 
prompted with the options 
described above. 

If you drag the study object that you 
already added to the same parent in 
the target location: 

You receive a message 
indicating that the study 
object cannot be added to 
the same parent more than 
once if the study object has 
not been updated.  

After you add FormA from 
a library to a study using the 
Libraries Browser, if you 
have not modified FormA 
and try to add FormA to the 
study again using the 
Libraries Browser, a 
message appears, indicating 
that the study object cannot 
be added to the parent more 
than once if the study object 
has not been updated. 

 

Notes:  

If you create a study object in the source location, add it to a target location, and then drag the 
study object back to the source location without modifying the study object in the target location, 
you are asked if you want to update the study object.  

For example, if you create a study object in LocationA (either a study or library), copy it to 
LocationB (either a study or library), and then drag the study object from LocationB back to 
LocationA without modifying it in LocationB, you are asked if you want to overwrite the study 
object in LocationA or cancel. If you updated the study object in LocationA and you choose to 
overwrite, you lose the changes when the study object from LocationB is added to LocationA. 

If you add a study object to a study from a library, copy and paste the study object within the 
study, and then add the study object from the library to the study again, none of the copies is 
updated. 

The RefNames of study objects are never updated when a study object is updated. 

You cannot use the Libraries Browser to create multiple copies of a study object within a target 
location. Use the Copy option to create multiple copies of a study object within a study or library. 

To determine whether a study object is a link or a copy of another study object, check the 
Identifier field in the Properties Browser. If the identifiers are identical, the study objects are links; 
otherwise, they are copies. 
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Results of adding templates to studies and libraries 
The children of templates are treated like regular study objects unless they are also marked as 
templates. For example, if you add a codelist template from a library to two different items in 
another library, the codelist items are links as long as they are not marked as templates.  

You can add study objects to a study template using the Libraries Browser. If you copy a study object 
from a library to a study template and then create a study from the study template, the study objects 
in the study are linked to the original study objects in the library. 
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Copying, cutting, and pasting 
When you copy and paste a study object (on page 89), all of its child study objects are copied with 
it. The method of copying that you choose determines whether the new study object and new child 
study objects retain links to the original study objects. 

When you copy a study object into a study twice, the two study objects are links to each other. 

You can cut linked study objects but not instances of study objects. Cutting a link is the same as 
deleting the link to (but not the instance of) the study object. After cutting, you must paste the link 
on the correct parent study object. For example, you can cut an item that is on a form and then paste 
it on another form. 

The following copying options are available. 
 

Copying option Description 
Link • The new study object retains a link to the original. If either the original 

or the new study object is modified, the other study object is modified, 
and all other reference copies of it within the study are also modified. 

• All child study objects are copied with links to the original study objects. 

With children • The new study object has no link to the original. If either the original or 
the new study object is modified, the other study object is not affected. 

• All child study objects are also copied and do not retain links to the 
original study objects. Therefore, a change to either the original or new 
child study objects does not affect the other. 

Without children • The new study object has no link to the original. If either the original or 
the new study object is modified, the other study object is not affected. 

• All child study objects are copied with links to the original study objects. 
Therefore, if either an original or a new child study object is modified, 
the other study object is modified, and all other reference copies of it 
within the study are also modified. 

 

Note: Advanced copying options (Link, With children, and Without children) are not available for 
codelist items. When you copy a codelist item, a copy of the original codelist item is created with 
a new identifier. 
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Renamed RefNames 

Because two study objects in a study cannot have the same RefName, the Central Designer 
application renames study objects in a study when you: 

• Drag a study object from a library to a study, and its RefName is identical to an existing study 
object in the study.  

• Use the Copy > With Children and the Copy > Without Children options.  

When a study object is renamed, it is appended with "_1" (or similar).  

Note: Study object names in a library might not be unique. Additionally, a study object can appear 
in multiple places in a study if it is copied using the Copy > Link option.  

 

Copying and pasting a study object 
1 In the Project Explorer, right-click a study object and select Copy. Select one of the following 

copying options from the menu that appears: 

Link: (Not available for study elements and study events) 

• The new study object retains a link to the original. If either the original or the new study 
object is modified, the other study object is modified, and all other reference copies of it 
within the study are also modified. 

• All child study objects are copied with links to the original study objects. Therefore, if either 
an original or a new child study object is modified, the other study object is modified, and all 
other reference copies of it within the study are also modified. 

With children: 

• The new study object has no link to the original. If either the original or the new study 
object is modified, the other study object is not affected. 

• All child study objects are also copied and do not retain links to the original study objects. 
Therefore, a change to either the original or new child study objects does not affect the 
other. 

Without children: 

• The new study object has no link to the original. If either the original or the new study 
object is modified, the other study object is not affected. 

• All child study objects are copied with links to the original study objects. Therefore, if either 
an original or a new child study object is modified, the other study object is modified, and all 
other reference copies of it within the study are also modified. 

2 In the Project Explorer, right-click a parent study object, and then select Paste. 

Note: You cannot copy study objects as links from one study to another within the same 
study project. 

When you copy a template from the Libraries Browser, a study object without a link to the template 
is created. 
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Dragging and dropping study objects 
You can drag and drop a study object in the Project Explorer to copy a study object as a link.  

When you drag a study object that is in a library from the Libraries Browser to another library, you 
are prompted to choose whether you want to link to the existing study object and its children or 
create new copies of the study object and its children. 

When you drag a study object that is in a library from the Libraries Browser to a study, or drag a 
study object that is in a study from the Libraries Browser to a library, new copies of the study object 
and its children are created. 

Note: Before you copy a study object by dragging and dropping it, you must first navigate to the 
Explorer bar and folder in which the target study object exists. 

The following table describes the target study objects onto which you can copy each study object 
type. 

 

Study object Location of available target study objects 
Study element Visit Schedule Explorer bar > Study Design folder. 

Study event • Visit Schedule Explorer bar > Study Design folder > Element name. 

or 

• Elements and Events Explorer bar > Elements folder > Element name. 

Form Elements and Events Explorer bar > Events folder > Event name. 

Items • Forms and Transactions Explorer bar > Target application folder > Forms 
folder > Form name. 

or 

• Forms and Transactions Explorer bar > Target application folder > Forms 
folder > Non-Clinical folder > Form name. 

Codelist Items Explorer bar > InForm items folder > Item name.  

Notes: 

For the item, the Use Codelist option must be selected. 

The codelist must match the type of the item. For example, you can drag an 
integer codelist only to an integer item. 
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Cutting and pasting a study object 
You can cut linked study objects but not instances of study objects. 

1 In the Project Explorer, right-click a study object, and select Cut. 

The study object is removed from the Project Explorer. 

2 Right-click a parent study object (such as a form, if you cut an item), and select Paste. 

The study object appears under its parent study object in the Project Explorer. 
 

Copying and moving data-entry rules 
To copy and paste a data-entry rule: 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 In the grid, select a rule. 

4 Right-click the rule, and select Copy. 

5 In the Project Explorer, select a study object onto which to copy the rule. 

6 Right-click the study object and select Paste. 

The pasted data-entry rule appears in the grid, and the row containing the pasted data-entry rule 
is selected. 

Note: You can also copy and paste a data-entry rule by holding down the Ctrl key, dragging the 
rule from the Rules tab, and dropping it onto a study object. 

To move a data-entry rule: 

1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 
section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 In the grid, select a rule. 

4 Right-click the rule, and select Cut. 

The data-entry rule is grayed out. 

Note: When you select Cut, the data-entry rule is not immediately deleted from its parent 
study object. The rule is only deleted when you paste it onto another study object. If you do 
not paste a cut rule, it remains associated with its original parent study object. This 
behavior is different from the cut and paste functionality that is used when you move a 
study object in the Project Explorer. In the Project Explorer, when you cut a study object, it is 
immediately deleted from its parent study object. 

5 In the Project Explorer, select a study object. 
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6 Right-click the study object and select Paste. 

The data-entry rule is removed from the original study object on which it was created, the pasted 
data-entry rule appears in the grid, and the row containing the pasted data-entry rule is selected.  

Note: You can also move a data-entry rule by dragging the rule from the Rules tab, and dropping it 
onto a study object without holding down the Ctrl key. 

 

About copying study objects grouped by data mappings 
The following table explains how study objects are copied when they are part of a data mapping. You 
can copy study objects from a library to a study or another library as well as from a study to another 
study. You also can copy study objects in the Project Explorer.  

When you copy a data mapping, data set, or data series within a study or library, the new study object 
contains item mappings. 

 

Copied study 
object 

Copied within a study or library Copied from one study or library to 
another 

Data mapping, 
data set, or data 
series 

Mappings to items that are part of 
the data series are retained in the new 
study object. 

Item mappings are not copied to the 
new study object. 

Item, Form, or 
study event that is 
mapped to a data 
series 

The new study object is mapped to 
the data series. 

If you break the link between the 
original and the new study object, the 
new study object is still mapped to 
the data series.  

The study object is copied, but data 
mappings are not copied. 

Note: If you drag and drop a study 
object that is mapped to a data series, 
and the study object already exists in the 
library, the database contains a data 
point for the study object, and the drop 
operation reuses that data point as is. 
The application warns you that the drag 
and drop operation is not supported. If 
you continue, any data mappings in the 
dropped study object that are different 
from the data mappings that are 
associated with the study object that 
already exists in the library are removed. 

 

Note: When a data series is copied within a study or library, the items that are part of a data 
series are not copied, but data series mappings to items are copied. For example, if an item is 
added to a data series, and the item is mapped to be part of the data series only when the item 
appears in a specific form, the mapping of the item to the data series for the form is copied. 
Similarly, if you copy a data set or mapping definition containing a data series, the mappings are 
also copied. If you use the new data series in another study, the mappings are retained. If you 
later add the item and form that are mapped to the data series to the study containing the data 
series, the mapping appears in the Data Series Summary tab. 
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Working with templates and types 

About templates 
 

Characteristic Description 
Definition A template is study object that is either partially or fully defined and that can 

be used to create other study objects. 

Available for You can create templates for the following study objects:  

• Study projects 

• Studies 

• Study elements 

• Study events 

• Forms 

• Items 

• Codelists 

• Mappings 

Purpose of study 
templates 

Study templates can decrease the time and effort required to build a study. 
Think about how to set up study templates to minimize work that users 
might need to perform. For example, you might create templates for different 
therapeutic areas, compounds, devices, and biologic areas. 

After creating After you create and publish a template, users can create study objects from 
the template. You do not need to publish study project templates and study 
templates to make them available. 

When you create a study object, you can (but are not required to) create it 
from a template. 

History links A study object created from a template inherits the characteristics of the 
template but has no history link to the template. Therefore, changing the 
template does not affect the study object, and the reverse is also true. 

Versions Templates do not have versions; therefore: 

• For study project templates and study templates, the last saved version 
of a template is used when you create a study project or study from the 
template. 

• For other study object templates, the last published version of a 
template is used when you create a study object from a template.  
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Characteristic Description 
Where to view 
templates 

Study project and study templates are viewable when you create a study 
project or study. You can view all other templates in the library project in 
which they are created in the following places in the Project Explorer: 

• Under the Templates container. For example, within the Templates 
container, the Forms container has all form templates.  

• Under the containers for each study object.  

Rule templates You can also create rule templates. 
 

Note: You can protect templates and types. However, if you create a new study object from a 
protected template or type, the newly created study object is not protected. 
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About types 
A type is a study object that is either partially or fully defined and can be used to create other study 
objects. Types are like templates except that types appear as options in the Actions menu and in the 
Project Explorer menu when you create a new study object. Types are used only for items. Some 
commonly used types, including Float, Text, and Integer, are included in the system library. 

Marking an item as a type automatically marks it as a template, as well. 

Types have the following requirements:  

• You can create types for items only. 

• You can create types in libraries only. 

• An item marked as a type is automatically marked as a template (and you cannot remove the 
template categorization).  

After you create an item type and publish it, other users can create items from the type.  

When you create an item, you must select a type on which to base it, and you choose from types that 
are in: 

• The System Library. These types are installed with the Central Designer application. 

• Libraries that appear in the Library List for the study.  

If a type with the same name appears in both the System Library and another library, the type from 
the non-System Library is used for creating the item. 

An item created from a type inherits the characteristics of the type on which it was based, but the 
item has no history link to the type. Therefore, a change to the type does not affect the item, and the 
reverse is also true. Additionally, types do not have versions, so the last published version of a type is 
always used. 

Types appear in the following places in the Project Explorer: 

• In a library, types appear under the Types container. For example, the Items container contains 
all item types in the library. 

• In studies and libraries, item types appear under the container for items. 

Note: You can protect templates and types. However, if you create a new study object from a 
template or type, the newly created study object is not protected. 
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Differences between templates and types 
 

Characteristic Templates Types 

Purpose To provide predefined information 
about a study object.  

You are not required to base new 
study objects on templates. 

To provide predefined information 
about an item.  

When you create an item, you must 
choose a type on which to base it.  

You can create 
templates and types 
for the following 
study objects 

Study projects, studies, study 
elements, study events, forms, 
items, codelists, and mappings. 

Items only. 

How to create study 
objects from a 
template or type 

Creating a study project or 
study: 

You are allowed but not required to 
choose a template.  

Creating all other study objects: 

To create a study object based on a 
template, find the template in the 
Libraries Browser and then copy it 
to your study.  

For more information, see 
Creating a study object from a 
template (on page 99). 

Creating an item: 

You must choose an item type. 

For more information, see Creating 
an item from a type (on page 100). 

 
 

Information you can define for templates and types 
The following table contains examples of the kinds of information that you can define for templates 
and type. All study objects created from a template or type inherit the characteristics of the template 
or type. 

Note: You can create a study object, such as a study or study event, copy study objects to it from 
a library, and then mark the study object as a template. If you use the template to create a study 
object, the study objects that were copied from the library do not retain history information from 
the study objects in the library. 

 

Study object Information you can define 
Templates  

Study project • The references required for creating studies in the project, such as protocols or 
goals.  

• Any studies or study objects that are contained in the project. 
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Study object Information you can define 
Study • Study deployment requirements, including languages and form layouts. 

• Study language requirements.  

• A defined Library List containing the libraries from which study objects and 
templates will be taken to build the study. 

• The references required for building a study, such as a protocol or study goals.  

• The users (assigned to study teams) who will be working on the study. 

• The instructions and Help information for the study. 

• The functions and constants that will be used in the study. 

• Workflow components, including commonly used forms, special forms, and 
any other commonly used study objects. 

• Mappings, including items and mappings to items, forms, and study events. 

Study element • The study objects contained in the study element and their workflow.  

• Instructions and Help for the study element.  

Study event • The study objects contained in the study event and their workflow.  

• Instructions and Help for the study event.  

Form • A designed layout.  

• The study objects contained in the form.  

• Instructions and Help for the form. 

Item  • Design information, including a question, title, units, and length. 

• A codelist including codes and labels.  

• Data entry rules, such as a range check.  

• A designed layout.  

• Instructions and Help for the item. 

Codelist • The codes and labels contained in the codelist.  

Mapping • A name, RefName, and description of the mapping. 

• The data sets, data series, and items contained by the mapping. 

Types  

Item • Design information, including a question, title, units, and length. 

• A codelist including codes and labels.  

• Data entry rules, such as a range check.  

• A designed layout.  

• Instructions and Help for the item. 
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Marking a study object as a template 
1 Do one of the following: 

• For study projects and studies—Open a study project. 

• For all other study objects—Open a library project. 

2 In the Project Explorer, right-click a study project, study, or study object, and select Set Advanced 
Options. 

The Advanced Options dialog box appears. 

3 Select Mark as Template, and click OK. 

4 (Not for study project templates and study templates) Optionally, to make the template available for 
others to use, right-click the template, and select Publish. Only published study objects appear in 
the search results for the library in which they are created. 

Note: Study project templates and study templates are available to be used by default. 

After creating or modifying a template, you must do the following to make your changes available: 

• For study project templates and study templates, save the template. 

• For all other study object templates, save and publish the template at any time. Your changes are 
not available to others until you publish the template. 

 

Modifying a template 
After creating or modifying a template, you must do the following to make your changes available: 

• For study project templates and study templates, save the template. 

• For all other study object templates, save and publish the template at any time. Your changes are 
not available to others until you publish the template. 

To modify a study project template or study template: 

1 Select File > Open.  

The Open Project dialog box appears.  

2 Select the study project template or the study project that contains the study template, and click 
Open.  

Note: Only users with rights to modify templates can see templates in the Open Project 
dialog box. 

3 Modify the template, and save the changes. 

To modify other study object templates: 

1 In the Project Explorer for a library, select a study object template. 

2 Modify the template, and save the changes. 

3 To make the template available for use, right-click the template, and select Publish. 
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Removing a template categorization from a study object 
To remove a template categorization from a study project or study template: 

1 Select File > Open.  

The Open Project dialog box appears.  

2 Select the study project template or the study project that contains the study template, and click 
Open.  

Note: Only users with rights to modify templates can see templates in the Open Project 
dialog box. 

3 In the Project Explorer, right-click the study project or study, and select Set Advanced Options.  

The Advanced Options dialog box appears. 

4 Deselect Mark as Template, and click OK. 

To remove a template categorization from other study objects: 

1 In the Project Explorer for a library, select the Types and Templates Explorer bar. 

2 Right-click a template, and select Set Advanced Options.  

The Advanced Options dialog box appears.  

3 Deselect Mark as Template, and click OK. 
 

Creating a study object from a template 
To create a study element, study event, form, item, codelist, codelist item, or mapping from a 
template, you search for the template in the Libraries Browser and then copy it into your study or 
library.  

A study object created from a template inherits the characteristics of the template but has no history 
link to the template. Therefore, changing the template does not affect the study object, and the 
reverse is also true. 

1 Open a study or library, and make sure a library, study, or other study object (but not a library 
project or study project) is selected. 

2 Select the Libraries Browser. 

3 To search by title, RefName, or description of the study object, type text in the Enter search text 
field. 

4 To include categories, keywords, and libraries as parameters: 

a Click the double down arrows ( ) next to the Search Filter. 

b Optionally, select the Categories tab, and select one or more categories. 

c Optionally, select the Keywords tab, and select one or more keywords. For more information 
about categories and keywords, see Categorization of study objects (on page 71). 

d If you are in a study project, select the Libraries tab, and select the libraries to search. You 
must select at least one library. This step is optional if you are in a library project. 
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The parameters you select appear in the field below the Search Filter. 

Note: For more information about narrowing your search using template categories, see 
About searching for a template or type (on page 77). 

5 Click Find. 

The Central Designer application performs a search based on your search criteria. 

6 In the Libraries Browser, select a template from the search results, and drag it to the appropriate 
location in the Project Explorer.  

A new study object is created in the Project Explorer from the template. The new study object 
has the same name as the template but is editable. 

7 Type a name for the study object, and press Enter. 
 

Marking an item as a type 
1 In the Project Explorer for a library, right-click an item, and select Set Advanced Options. 

The Advanced Options dialog box appears. 

2 Select Mark as Type, and click OK. 

3 To make the type available for others to use, right-click the type, and select Publish. 
 

Modifying a type 
1 In the Project Explorer for a library, select the Types and Templates Explorer bar. 

2 Select and modify the type.  

3 To make the type available for others to use, right-click the type, and select Publish. 
 

Removing a type categorization from an item 
After you remove a type categorization from an item, the item type is no longer listed with the item 
types that appear when you create a new item. 

1 In the Project Explorer for a library, select the Types and Templates Explorer bar. 

2 Right-click a type, and select Set Advanced Options.  

The Advanced Options dialog box appears.  

3 Deselect Mark as Type, and click OK. 
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Creating an item from a type 
When you create an item, you must choose a type on which to base it. You can create items in 
studies and libraries. 

Note: If you are working in a study project, the only types available to you are the types in the 
libraries in the Library List for the study. 

1 In the Project Explorer, select the Items Explorer bar. 

2 Right-click the InForm Items node, and select New Item > [Item type]. 

The Object Name dialog box appears. 

3 Enter the Title, RefName, and optionally, a Description, and click OK. 

Note: You can protect templates and types. However, if you create a new study object from a 
template or type, the newly created study object is not protected. 
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Creating, replacing, updating, and deleting 

About creating study objects 
 

Characteristic Description 
Naming conventions Oracle recommends developing naming conventions, which help you 

identify study objects that appear in search results in the Libraries 
Browser. 

Parents You can create study objects on the following parents. You create a: 

• Study element on a study design. 

• Study event on a study design or study element.  

• Form on a study event. 

• Section on a form.  

Note: You cannot create a section outside the hierarchy. You must 
create a section on a form. 

• Item on a form or section. 

• Codelist on an item. 

• Codelist item on a codelist.  

RefNames and titles When developing naming conventions, consider that all study objects 
(except study projects, library projects, libraries, and studies) have 
RefNames and titles, which can be different. 

• RefNames are referenced in rules and are deployed to the target 
application. Therefore, they must: 

• Follow C# variable standards. 

• Start with a letter or an underscore.  

• Contain only letters, numbers, and underscores.  

• Be unique within a study or library. For example, you cannot 
have a form and an item with RefNames of DOV in the same 
study or library. 

• Titles are the more readable display names for study objects. They 
can contain spaces and special characters, but are not referenced in 
rules and are not deployed to the target application.  
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Characteristic Description 
Automatically generated 
RefNames 

When you create a new study object (not by copying an existing study 
object), its title and RefName are automatically generated. For example, 
the title of a new integer item is Integer Item, and the RefName is 
IntegerItem. The first time you rename the study object, both the title and 
RefName are updated. Subsequent changes to the study object name 
change the title but not the RefName.  

Some words cannot be used for RefNames. For more information, see 
Reserved words for RefNames (on page 136). 

Viewing RefNames or 
titles 

In the Project Explorer, you can select whether to display RefNames or 
titles for study objects, and this selection is reflected in most tabs in the 
workspace. 

Order to create study 
objects 

You can create study objects in any order. Consider the following 
options: 

• Start by determining whether any required study objects already exist 
in libraries. 

• If you are working from the study protocol, you might want to start 
with the study workflow to create an overview of the study. 

• If you are working from CRF specifications: 

• Determine whether the study contains study objects and 
components that can be reused in multiple locations. 

• Create these study objects and components (for example, 
codelists, constants, date time items) first. 

 
 

Renaming a study object 
1 In the Project Explorer, right-click a study object, and select Rename. 

The study object name becomes editable.  

2 Type a name for the object, and press Enter.  

Note: You can also rename a study object by clicking the name of the study object once. The 
name becomes editable. 

 

Renaming a study object in a workflow diagram 
1 In the Project Explorer, select the study object. 

2 Select the Workflow Diagram tab. 

3 Right-click the workspace, and select the Rename option for the study object. 

In the workflow diagram, the name becomes selected. 

4 Type the new name for the study object, and press Enter, or click outside the study object. 
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About deleting 
The way a study object and its children are deleted depends upon whether the study object is an 
instance or a link. Before deleting a study object, make sure that you understand the implications of 
the deletion. 

For more information, see: 

• Instances and links (on page 107). 

• How instances are deleted (on page 109). 

• How links are deleted (on page 110). 

When you delete a study object from a library, the study object is removed from the database only if 
it is not in any other library. 
 

Deleting a study object 
You can delete any study object, including a study (the study design is also deleted), study event, 
study element, form, section, item, codelist, and codelist item. The way that study objects are deleted 
depends on whether they are instances or links. 

Note: If you delete a study object that has been copied as a link, only the selected study object is 
deleted. No copies of it are deleted. For more information, see Copying, cutting, and pasting (on 
page 88). 

• In the Project Explorer, right-click a study object, and select Delete. 

If a confirmation message appears, select the appropriate option. For more information, see 
About deleting (on page 106). 

 

Deleting a study object in a workflow diagram 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click a study object, and select Delete. 
 

Deleting a study object in a workflow grid 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Grid tab. 

3 Right-click the gray box located at the beginning of a row, and select Delete. 

Note: To delete multiple study objects, select multiple rows. 
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Deleting a workflow rule from a workflow diagram 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 Right-click the rule in the workflow diagram, and select Delete Rule. 
 

Deleting a global condition 
1 In the Project Explorer, select a study design (in a study only), study element, or study event. 

2 Select the Workflow Diagram tab. 

3 On the toolbar, click Global Conditions, or right-click in the workflow, and select Global Conditions. 

The Edit Global Conditions dialog box appears. 

4 Select a global condition in the list, and click Delete. 

5 Click OK. 
 

Deleting one or more rules 
1 In the Project Explorer, select a study design (in a study only), study element, study event, form, 

section, or item. 

The editor for the study object appears in the workspace. 

2 Select the Rules tab. 

3 Select one or more rules, pressing CTRL or Shift to select multiple rules. 

4 On the toolbar, click Delete. 

Note: If any of the selected rules are locked by someone else or on a study object that is 
protected by someone else, the Delete options are grayed out. 

 

About instances and links 

Instances and links 
 

Type Description Appearance in the Project Explorer 

Instance An actual 
study object in 
a study 

Study objects that are instances appear in study object containers.  

For example, all study elements in the Elements container are 
instances. 

Link A link to a 
study object in 
a study. 

Study objects that are links appear as children in study object 
containers. 

For example, if a study event is a child of a study element in the 
Elements container, the study element is an instance, and the study 
event is a link.  
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Viewing the parents of a linked form 
You can view the parents of a form, section, item, codelist, or codelist item that: 

• You copied using the Copy > Link option.  

• You use on multiple parents. 

To view the parents of a linked study object: 

1 In the Project Explorer, select a study object, and confirm that a blue icon ( ) appears in the 
upper-left corner of the study object's icon. 

Note: If the icon does not appear, the study object could be used multiple times in the study 
but always on the same parent. 

2 Right-click the study object, and select Show Parents. 

The Show Parents dialog box appears.  

3 Review the paths of the parent study objects in the current project. 

The paths begin with the project name and work down; the last study object listed is the parent. 

4 To copy paths to the Microsoft Windows clipboard: 

a To copy one path, select it and click Copy. 

or 

Click Copy All.  

b Paste the information in a text editor. 

Notes: 

• Show Parents is available in both a study and library, but it lists only the parents in the current 
project. 

• Show Parents is not available for a study object on a single parent that appears multiple times, 
such as an item on a form that is used multiple times in a study. 

 

Breaking the link of a study object 
Breaking the link of a study object creates a new study object in the place of the original study object. 

• The new study object is identical to the original, except it has a new study object identifier.  

• The original study object remains in the study, but the link to it is removed from the study object 
tree in the Project Explorer. 

You must choose whether to break the links of child study objects. Child study objects for which 
links are not broken become the children of the new study object and are no longer the children of 
the original study object. 

Note: You can break links for study objects that are links only. You cannot break the links of study 
objects that are instances. For more information, see Instances and links (on page 107). 
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To break the link of a study object: 

• In the Project Explorer, right-click a study object and point to Break link, and select one of the 
following options: 

With new children: 

• The original study object is removed from the study object tree in the Project Explorer (but 
not the study), and an identical study object (with a new identifier) is created in its place. 

• If the original study object has child study objects, the child study objects are also removed 
from the study object tree in the Project Explorer, and identical study objects (with new 
identifiers) are created in their places. The new child study objects are children of the new 
study object, and the original children are no longer associated with the original parent study 
object. 

With links to children: 

• The original study object is removed from the study object tree in the Project Explorer (but 
not the study), and an identical study object (with a new identifier) is created in its place. 

• If the original study object has child study objects, the child study objects are not changed. 
However, they are no longer associated with the original study object. Instead, they become 
the children of the new study object. 

 

How instances are deleted 
 

Description Example When you delete the Gender item 
No child study 
objects. 

Not used by other 
study objects in the 
study. 

Item name—
PregnancyTest 

• No codelist. 

• Not used on any 
form. 

The instance of the PregnancyTest item is 
removed from the study. 

No child study 
objects. 

Used by one or more 
study objects in the 
study. 

Item name—
PregnancyTest 

• No codelist. 

• Used on the Visit1 
and Visit2 forms.  

A dialog box informs you that the delete will 
remove all links to the instance. You can 
continue or cancel. 

If you continue: 

• The instance of the PregnancyTest item is 
removed from the study.   

• The links to the PregnancyTest item are 
removed from the Visit1 and Visit2 forms. 

One or more child 
study objects that are 
not used by any other 
study object. 

Not used by other 
study objects in the 
study. 

Item name—
PregnancyTest 

• Has a codelist. 

• Not used on any 
form. 

The instance of the PregnancyTest item is 
removed from the study. 

You are asked if you want to include the child 
study objects in the delete.  

• If you select Yes, the codelist is deleted.  

• If you select No, the codelist is not deleted.  
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Description Example When you delete the Gender item 
One or more child 
study objects that are 
used by one or more 
other study objects. 

Not used by other 
study objects in the 
study. 

Item name—
PregnancyTest 

• Has a codelist. 

• Not used on any 
form. 

The instance of the PregnancyTest item is 
removed from the study.  

The codelist on the item is not affected because 
it is being used by one or more other study 
objects in the study. 

One or more child 
study objects that are 
not used by any other 
study object. 

Used by one or more 
study objects in the 
study. 

Item name—
PregnancyTest 

• No codelist. 

• Used on the Visit1 
and Visit2 forms.  

A dialog box informs you that the delete will 
remove all links to the instance. You can 
continue or cancel.  

If you continue: 

• You are asked if you want to include the 
child study objects in the delete.  

 If you select Yes, the codelist is 
removed from the study. 

 If you select No, the codelist is not 
affected.  

In addition:  

• The instance of the PregnancyTest item is 
removed from the study.  

• The links to the PregnancyTest item are 
removed from the Visit1 and Visit2 forms   

 
 

How links are deleted 
 

Description Example Results of deleting the item 
Has child study 
objects or has no 
child study objects. 

Is used by multiple 
study objects. 

Item name—
PregnancyTest 

• Has a codelist or 
has no codelist. 

• Used on the Visit1 
and Visit2 forms. 

When you delete the PregnancyTest item from a 
form (for example, the Visit2 form): 

• The link to the PregnancyTest item is deleted 
from the Visit2 form. 

• The link to the PregnancyTest item remains 
on the Visit1 form. 

The PregnancyTest item can be used on other 
forms. 

Has no child study 
objects.  

Is used by a single 
study object. 

Item name—
PregnancyTest 

• No codelist. 

• Used on the Visit2 
form only. 

The link to the PregnancyTest item is deleted 
from the Visit2 form, and the instance of the 
PregnancyTest item is removed from the study. 
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Description Example Results of deleting the item 
Has one or more child 
study objects.  

Is used by a single 
study object. 

Item name—
PregnancyTest 

• Has a codelist.  

• Used on the Visit2 
form only. 

The link to the PregnancyTest item is removed 
from the Visit2 form. 

If the codelist on the item is used by only the 
PregnancyTest item, then you are asked if the 
child study objects should be included in the 
delete: 

• If you select Yes, the instances of the codelist 
and its codelist items are removed from the 
study.  

• If you select No, only the PregnancyTest 
item is removed from the study. The codelist 
still exists and can be used by other items.  

 

Note: When you delete the final link of a study object, you receive a message that only a single link 
to the study object exists in the study or library, and you are asked if you want to delete the study 
object from the study or library after the link is removed. If you click: 

• Yes—Both the link to the study object and the study object itself are deleted from the study or 
library. 

• No—The link to the study object is removed from the study or library, but the study object 
remains in the study or library. 
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Adding study objects 
If a study object exists in a study but has not been added to the study object hierarchy, you can use 
the Add To browser to locate the study object and add it to a parent study object. 
 

About the Add To browser 
The Add To browser displays the list of study objects, within the current study, that you can add to 
the selected study object. For example, if you select a form, the Add To browser contains a list of 
items and sections that you can add to the selected form. 

In the Add To browser, you can: 

• Filter the list of available study objects by: 

• Typing a keyword. 

• Specifying the fields on which to apply the filter (RefName, Title, Description, or Labels). 

• Display the filtered list of study objects by RefName or Title. 

• Do the following for the selected study object: 

• Copy a study object with or without its children. 

• Add a link to a study object. 

Before you add a study object using the Add To browser, you can also view details about the study 
object, including: 

• Study object properties.  

• Parent study objects 

• Form layout (available for InForm forms only). 
 

Adding study objects to a study from the Add To browser 
In the Project Explorer, select a study object. 

To open the Add To browser 

• In the upper-right corner of the application window, select Add To. 

To filter study objects in the Add To browser 

1 Do one of the following: 

• In the Filter field, type a keyword. 

• Click Advanced Filtering. 

a Specify the properties on which to apply the filter. 

b Specify the display format for the filtered results. 

2 Click Refresh Results (  ). 
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To view details for a study object in the Add To browser 

1 In the Add To browser, select the study object. 

2 Click Show Details. 

The Show Details dialog box appears. 

3 Do one of the following: 

• To view the form layout for forms, select the Preview Form tab. 

• To view properties for the study object, select the Object Details tab. 

• To view the parent study objects for the study object, select the Referenced By tab. 

To add a study object from the Add To browser 

• Select the study object and do one of the following: 

• Drag the study object from the Add To browser and drop it onto the study object selected 
in the Project Explorer. 

• Select the Add link drop-down list, and select one of the following: 

• Add as link—Adds a link to the study object. 

• Add with children—Adds a copy of the study object and the study object's children. 

• Add without children—Adds a copy of the study object without the study object's children. 
 

Previewing study objects in the Add To browser 
1 In the Project Explorer, select a study object. 

2 To open the Add To browser, in the upper-right corner, select Add To. 

3 In the Add To browser, select a study object to preview. 

4 Click Preview. 

The Preview Object dialog box appears. 

5 If the study object you selected is an InForm form, select Preview Form to view the form layout. 
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Saving study objects 

About saving study objects 
 

Characteristic Description 
What you can save • A study object and its child study objects. 

• All study objects in a study. 

• All study objects in a study project.  

Study objects that 
are saved 

Only the study objects that have been modified since the last save are saved. 

Level at which to 
save 

• If you are working on multiple study objects and are not finished with all 
of them, you might want to save individual study objects after you finish 
working on them using Actions > Save. 

• If you are working at a global level (for example, on mappings) you 
might want to save at the project level (File > Save Project or Ctrl+S). 

Locks that are 
released 

Saving releases the locks that you hold on all study objects that you have 
edited. 

• If you are collaborating with users who need access to study objects you 
are working on, consider saving as soon as you are finished with each 
study object.  

• If you are working on multiple related study objects and do not want to 
release the locks until the related work is completed, consider not saving 
until you exit the study or library, or apply explicit locks.  

Undoing You cannot undo after a save action. 

Note: Although you cannot undo after a save, you can revert to a previous 
version or revision. If you are unsure whether you want to keep the changes 
you are making, you might not want to save so you can still undo your 
changes.  

Revisions When you save a study object, a revision (on page 119) is created. 
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Saving one or more study objects 
To save a study object: 

• In the Project Explorer, right-click a study object, and select Save. 

To save all study objects in a study: 

1 In the Project Explorer, select the Study Information Explorer bar.  

2 Right-click a study, and select Save Study. 

To save all study objects in a study project: 

• Select File > Save Project, or press Ctrl+S. 
 

Saving a rule 
You can save a rule at any stage of development. For example, you can save a rule after providing 
only the name and description, and a more technical user can create the expression. You can also 
save a rule that has errors and return to it later. Validation checks the syntax of all rules. 

• At any time in the Rule Wizard, click Finish. 
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References 
A reference is a text note, a link to a Web page or file (URL), a document, or a combination of all 
three, that is attached to a study project for users to consult during the development of a study. 

You can attach a reference to a study or study project and view references already attached to a study 
or project.  

References include standard operating procedures, protocols, naming or project standard documents, 
and other relevant documents. Study designers can use reference information to construct a study. 

You can attach the following references: 

• A shortcut that references a file. 

For example, you can attach a shortcut to a file if the file is checked in to a version-control 
application and you want all users to view the most recent version.   

• A physical file.  

You can attach a physical file if the file is stored in a location that everyone cannot access.  

• A shortcut that references a URL address. 

You can attach the address of a web site that contains information relevant to a study. 

References attached to a study project are available for all studies in the project, but references 
attached to a study are available only for the study. 

Note: Version control is available only for study objects and is not available for references.   
 

Attaching a reference to a study 
1 In the Project Explorer, select the Study Information Explorer bar. 

2 Select a study. 

3 Select the References tab. 

4 In the Title field in the top grid, type a name for the reference. 

5 In the Attachments section (located in the lower-right corner), click the drop-down arrow next to 
the Add File button.  

A menu of attachment options appears.  

6 Attach one of the following references.  
 

To attach the following Perform these steps 

Shortcut to a file 1 Select Attach file. 

The Open dialog box appears.  

2 Navigate to the file that you want to attach, select the file, and 
click Open. 

A reference to the file appears in the Attachments section. 
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To attach the following Perform these steps 

Physical copy of a file 1 Select Copy and Attach File. 

The Open dialog box appears.  

2 Navigate to the file that you want to attach, select the file, and 
click Open. 

The file appears in the Attachments section. 

Shortcut to a URL address 1 Select Attach URL. 

The Attach URL dialog box appears.  

2 In the field, type the URL address.  

A shortcut to the URL appears in the Attachments section. 
  

Note: The maximum size of the attachment is determined by a variety of factors, including 
information defined in the configuration file, available hard disk space, and available memory. To 
determine the approximate maximum attachment size, check the maxRequestLength attribute in 
the machine.config file. 

 

Removing a reference from a study 
1 In the Project Explorer, select the Study Information Explorer bar. 

2 Select a study. 

3 Select the References tab. 

4 In the Attachments section, select a reference. 

5 Click Remove. 
 

Maximum attachment size 
By default, the maximum size of a file that is attached as a reference is 10 MB. When a user copies or 
attaches a file in the References editor, an error message appears if the size exceeds the configured 
maximum. 

The maximum file size is set in the DesignerUI.config file, in the <ReferencesEditor> section. To 
change it, update the <MaxFileAttachmentSize> value, using an integer value in megabytes. 
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About versions and revisions 

Versions 
A version is an explicitly requested audit history record for a study object. Every study object has a 
version that is composed of three numbers: the major number, the minor number, and the revision 
number, which appear in the following format:  

<Major number>.<Minor number>.<Revision number> 

For example, for version 1.2.34, the major number is 1, the minor number is 2, and the revision 
number is 34. 

When you version a study object, you can choose to increment either the major or minor number. 
When you increment the major number, the minor number and revision number are both reset to 0. 
When you increment the minor number, the revision number is reset to 0. For example, for version 
1.2.34: 

• If you increment the major number, the new version is 2.0.0. 

• If you increment the minor number, the new version is 1.3.0. 
 

Versioning and revising a study object 
You can version and revise a study object (study design, study element, study event, form, section, 
item, codelist, and codelist item). 

To version a study object: 

1 In the Project Explorer, right-click a study object, and select Create Version. 

The Create Version dialog box appears. 

2 Select one of the following increment options: 

• Increment major number—Increment the major number by one and reset minor and revision 
numbers to 0. 

For example, version 1.2.34 changes to 2.0.0. 

• Increment minor number—Increment the minor number by one and reset revision number to 
0. 

For example, version 1.2.34 changes to 1.3.0. 

3 Type a version label and description. 

4 Click Create. 

Note: The version or revision of a study object is saved in the Revision property in the Properties 
Browser. 

To revise a study object: 

• Save your changes. 

Revisions are generated automatically when you save a study object with changes. The revision 
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number for all saved study objects is incremented by 1 automatically. 

Note: The version or revision of a study object is saved in the Revision property in the Properties 
Browser. 

 

Reverting to a previous version or revision of a study object 
You can revert to a previous version or revision of a study object (study design, study element, study 
event, form, section, item, codelist, and codelist item) if the study object is not locked by another 
user. 

Note: A revision is created automatically every time someone edits a study object and saves the 
changes. A version is created only when you explicitly request it. 

1 In the Project Explorer, right-click a study object, and select Audit History. 

The History Viewer dialog box appears. 

2 Select one of the following options: 

• View Versions—All versions of the selected study object appear in the top grid.  

• View Every Edit—All revisions of the study object appear in the top grid.  

3 Double-click the version or revision to which you want to revert. 

4 Click Revert to. 

The study object reverts to the selected version or revision. 

For more information, see History Viewer dialog box - Option descriptions (on page 149). 
 

Revising study objects 

Revisions 
A revision is an audit history record that is created automatically when a user edits a study object and 
saves the changes. Study objects are revisioned automatically when you save them, and their versions 
are updated automatically. Every study object has a version that is composed of three numbers: the 
major number, the minor number, and the revision number, which appear in the following format:  

<Major number>.<Minor number>.<Revision number> 

For example, for version 1.2.34, the major number is 1, the minor number is 2, and the revision 
number is 34. 

When you save a study object after making changes, the revision number increases by 1. When you 
version a study object, the revision number is automatically reset to 0. 
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Object revisions in the InForm application 
Object revisions are created in the InForm application when you perform the following actions: 

• Modify study objects. 

• Use linked study objects multiple times in a study. 

• Deploy a study that was previously deployed in earlier releases of the Central Designer 
application. 

Only some object revisions are visible in the InForm application, but all revisions are reported during 
submission by the CRF Submit application. 

 

  
 

How modifying study objects affects revisions in the InForm application 

In a study that has already been deployed, object revisions are created for modified study objects.  
 

Modified study object Result in the InForm application 
Study event A new revision is created for the visit.  

Form A new form revision is created. 

Section New revisions are created for both the section and the form on 
which it is used.  

Item New revisions are created for the item as well as the section and 
form on which it is used.  

Note: Sections are created for all items in the InForm application 
by default, so a revision is created for the default section if the item 
is not in a section in the Central Designer application. 

Control portion of an item 
(for example, the information 
that appears in the right 
column of a layout). 

New revisions are created for the control and item as well as the 
section and form on which the item is used.   
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How using linked study objects affects revisions in the InForm application 

Object revisions are sometimes created during the initial deployment of a study when an item, 
section, or form is used as a link (that is, it is used multiple times in a study).  

Because the presentation of a study object (its layout) is separated from the data of study objects, you 
can create different layouts for each instance of the study object. Object revisions are created for the 
study objects with modified layouts.  

For example, if the Dem form is used on two study events and each form has a different form title in 
the Layout tab, a form revision is created for one of the Dem forms in the InForm application. 

The following table provides examples of information that, when you modify it for a linked study 
object, results in the creation of object revisions.  

 

Form 
modifications 

Section modifications Item modifications 

• Form title • Section note 

• Section header 

• Section title 

• Caption override 

• Codelist item label override 

• Size of a text box 

• Width of the question column 

• Orientation of radio buttons, checkboxes, or a 
group control 

 
 

How deployment of a study created with an earlier release of the Central Designer 
application affects revisions in the InForm application 

If you deploy a study using release 1.0 or 1.1 and then upgrade to a later release, revisions are created 
for study events, forms, sections, and items that existed during the deployment from release 1.0 or 
1.1.  

 

Study object 
deployed in release 
1.0 or 1.1 

Result in the InForm application when the study is deployed 

Study event A new revision is created for the visit.  

Form A new form revision is created. 

Section New revisions are created for both the section and the form on which it is 
used. 

Item New revisions are created for the item as well as the section and form on 
which it is used.  

Note: Sections are created for all items in the InForm application by 
default, so a revision is created for the default section if the item is not in 
a section in the Central Designer application. 
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Study object 
deployed in release 
1.0 or 1.1 

Result in the InForm application when the study is deployed 

Control portion of an 
item (for example, the 
information that 
appears in the right 
column of a layout). 

New revisions are created for the control and item as well as the section 
and form on which the item is used.   

 
 

Post-production revision management 
A study design represents the root of the study workflow, including study events, forms, and rules 
that govern the behavior of study events and forms. The study workflow is independent of locale; 
therefore, there are special considerations for designing a single study with different workflows for 
different sites or locales in the target application. 

For example, consider the case where you want to add a form to a visit in some sites or locales but 
not to others. Because the study has only one study workflow, the form must be added to all sites. 
Your options are: 

• Create a workflow rule or global condition for the form that causes the form to never appear 
unless the site code or locale is one that has been specified. This approach might work for simple 
cases, but the approach can create maintenance problems if there are many similar 
customizations, or if different sites require different versions of the form. 

• Create a separate workflow for the different sites. This approach would normally require having 
two study designs in the study, which is not supported by the Central Designer application. 

Many production multi-site studies undergo different maintenance paths, in which some changes are 
distributed to all sites and others are limited to only a few sites. The Central Designer application 
does not allow you to create a single study with multiple study designs (in other words, multiple 
workflows) that you maintain in parallel.  

However, you can split the different maintenance paths into separate copies of the study, each of 
which can be maintained separately, as follows:  

1 Create a study that will be used in production. Consider this study to be the 1.0 study.  

2 Create a deployment package and deploy and install it in all study sites.  

3 Export the study and import it into a new study (which can be, but does not have to be, part of 
the same study project). The new study is comparable to a 1.1 branch. The new study will be 
maintained separately from the existing study.  

4 Before making any changes to the new study, create a baseline and deployment package. This 
package is identical to the original study package. The new package will be the basis for 
incremental deployment packages in the 1.1 study. 

5 Add study objects to or modify the 1.1 study. 

6 Create an incremental deployment package, and deploy the package to the specific sites that 
require the changes.  

This approach requires you to maintain both studies independently of each other. For example, if 
you modify a form in one study, the change is not propagated to the form in the other study unless 
the study object is in a library and is used in both studies. 
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Viewing audit history for a study object 
You can view the audit history for a study object (study design, study element, study event, form, 
section, item, codelist, and codelist item) in the History Viewer dialog box. The History Viewer 
shows the properties and structure of the study object, including its children, but it does not show 
associated rules or layout information.  

1 In the Project Explorer, right-click a study object, and select Audit History. 

The History Viewer dialog box appears. 

2 Select one of the following options: 

• View Versions—All versions of the selected study object appear in the top grid. 

• View Every Edit—All revisions of the study object appear in the top grid. 

3 Click among the versions or revisions to view the structure of the study object (in the lower-left 
grid) and the properties for the study object selected in that grid (in the lower-right grid). 

For more information, see History Viewer dialog box - Option descriptions (on page 149). 
 

Viewing the differences between two versions or revisions of a study object 
In the History Differences dialog box, you can view the differences between two versions or 
revisions of a study object, including the child study objects and properties, for each version or 
revision. A revision is created automatically every time someone edits a study object and saves the 
changes. A version is created only when you explicitly request it.  

1 In the Project Explorer, right-click a study object, and select Audit History. 

The History Viewer dialog box appears. 

2 Select one of the following options: 

• View Versions—All versions of the selected study object appear in the top grid. 

• View Every Edit—All revisions of the study object appear in the top grid. 

3 In the Revision/Version grid, select the two versions or revisions that you want to compare: 

a To select the first version or revision, double-click within the gray box at the left end of the 
row. 

b To select the second version or revision, click within any field in the row. 

4 Click Differences. 

The History Differences dialog box appears. 

5 In the top grid, compare the child study objects that appeared in each version or revision. In the 
bottom grid, compare the properties of the study object in each version or revision. 

For more information, see History Viewer dialog box - Option descriptions (on page 149). 
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Exporting and importing text for translation 

About exporting and importing text 
You can export all text strings for a target application and locale into a CSV file, translate them 
locally, and then re-import the translated strings. 

This option is useful for outsourcing translations. After exporting the text strings for a selected target 
application and locale to a CSV file, you can send the file to a third-party translation vendor to 
translate the strings. When the translated strings are returned, you import them back into the Central 
Designer database. You perform the export and import separately for each locale to be translated. 

You can export and import text strings at any time during the development of a study, including 
updates after a study has gone live. For example, to generate a test file to validate the process with a 
translation vendor, you can export the text strings for a partially developed study. When the study is 
completely developed, you can export the strings again, have the vendor translate the remaining 
strings, and import the completed translation file. 

Note: The text string export and import feature works only with the current format of layouts. If 
your study contains layouts that were created in release 1.2 or earlier of the Central Designer 
application, you must convert the layouts to the current format before exporting or importing text 
strings. For more information, see Converting layouts (in the InForm Design Guide). 

 

Exporting text strings from a study or library 
1 In the Project Explorer, right-click a study or library, and select Translations > Export. 

The Export Translations dialog box appears. 

2 Fill in the fields of the dialog box. For more information, see Export Translations dialog 
box—Option descriptions (on page 148). 

3 Click Export. 

The Central Designer application exports all of the text strings that match the selected criteria 
and saves them in CSV format in the location you specified. Status messages appear in the 
Export log results field. 

4 To save the export log file, click Save Log Results As and select a location. 

5 To interrupt the export process, click Stop. 

The export process stops, and no further records are written to the output file. 

Note: You can undo a string export. 
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Importing translated text strings 
To import translated text strings successfully, make sure that the translation file is in the correct 
format and that all requirements for character formatting are met.  

For more information, see: 

• Translation file format (on page 126). 

• Translation file requirements (on page 127).  

1 In the Project Explorer, right-click a study or library, and select Translations > Import. 

The Import Translations dialog box appears. 

2 Browse to the location of the CSV file containing translated strings to import. 

3 Click Import. 

The Central Designer application imports each text string to the study object specified in the 
CSV file. Status messages appear in the Import log results field. If an entry cannot be imported 
(for example, if the import process cannot acquire a lock on the target study object), a message is 
written to the import log, and the import continues with the next entry. You can re-import the 
file to process modified or corrected entries. 

4 To save the import file messages, click Save Log Results As, and select a location. 

5 To interrupt the import process, click Stop. 

The import process stops, and no further records are updated in the study. Records that were 
updated before the stop remain in the study. 

Note: You can undo a string import. 

 

Translating exported text strings 
After the text strings for a study or library are exported, a translator adds translated strings to the 
exported file.  

• In the exported file, provide translated values for each text string, and save the file. 

Note: If you use Microsoft Excel spreadsheet software as the CSV file editor, you must import the 
exported file as Unicode UTF-8; you cannot simply open the file and edit it. Additionally, you must 
export the edited file as Unicode UTF-8 CSV; you cannot save it and preserve the correct 
formatting. You might want to develop a Microsoft Excel macro specification or other tool that 
performs this processing. For guidance, see the Microsoft Excel documentation. 

For more information, see: 

• Translation file format (on page 126). 

• Translation file requirements (on page 127). 
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Translation file format 
The translation export and import CSV file consists of a header and translation records in the 
following formats.  

Header 

The header contains the following values: RefName,OwnerType,SrType, Id,Revision, 
<ReferenceLocaleValue>,< LocaleToTranslate> 

• <ReferenceLocaleValue>—Locale of the strings from which to translate, as specified in the Locale 
to translate from field of the Export Translations dialog box. Example: en-US. 

• <LocaleToTranslate >—Locale to which text strings are being translated, as specified in the Locale 
to translate field of the Export Translations dialog box. Example: fr-FR. 

Example of file header 

RefName,OwnerType,SrType,Id,Revision,en-US,fr-FR 
Records 

Each translation record contains the following fields: <RefName>,<OwnerType>,<SrType, 
<Id>,<Revision>,<ReferenceLocaleValue>,< LocaleToTranslate>, as described in the following table. 

 

Field Description 
RefName RefName of the study object that owns the string. 

 

OwnerType Internal type of the study object that owns the string resource. 

SrType Internal type of the field that references the string resource. 

Id GUID of the string resource in CSML. 

Revision Revision number of the study object for which the text string is 
defined. 

ReferenceLocaleValue Text string in the locale to translate. 

LocaleToTranslate Translated text string. This value is empty when you export the file. 
The translator fills in the value before you import the file. 

Note: The LocaleToTranslate is the only value that may be 
changed in each record. 

 

Examples of file records 

Layout_5fxx,LayoutPlan,ItemCaption,d067b170-8885-11e1-b0c4-0800200c9a66,12, 
"DOV Form","Forme pour la date de visite"  
Itm_DOB,DateTime,Question,26beca46-663e-4841-ab8b-03ff6b7a78f9,5,"Date of 
Birth","Date de naissance" 
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Translation file requirements 
• Do not change any values in the translation file except the strings in the LocaleToTranslate 

position (last field in each record). 

• The header record must be present. 

• Each record must conform to the following standards: 

• All records must have the same number of fields. 

• RefName and Id fields must not be empty. 

• RefName length must be less than or equal to 63 characters. 

• Revision and OwnerType lengths must be less than or equal to 255 characters. 

• ReferenceLocaleValue and LocaleToTranslate lengths must be less than or equal to 32000 
characters. 

• Double quotation marks (") are required for any field that contains a line break, double quote, or 
comma and are optional for any other field. 

• If a field contains a double quotation mark character [for example, Dizzy ("Groggy")], you must 
include another double quotation mark as an escape character, as follows: "Dizzy (""Groggy"")" 

• Lines must end with a Windows-style (CRLF) line terminator. 
 

Checking for empty strings 
You can generate a list of the empty strings in a study for a specified locale. 

1 In the Project Explorer, select a study. 

2 Do one of the following: 

• Select Actions > Translations > Check for Empty Strings. 

or 

a Select Actions > Translations > Export Strings for Translation. 

The Export Strings for Translation dialog box appears. 

b Click Check for Empty Strings. 

The Check for Empty Strings dialog box appears. 

3 In the Locale drop-down list, select the locale to check. 

4 Click Run. 

The empty strings in the study appear in the Empty strings for study < study name> grid. 

5 To navigate to the location of an empty string, click the button at the left of the Owner RefName 
column, and select Goto empty string. 
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Importing and exporting a study 
Importing and exporting are useful for: 

• Working with customer support to analyze problems in a study. 

• Moving a study from one server to another. 

Note: Exporting and importing do not preserve notes, categorization, or ancestry. 

 

About importing 
You can import study objects into a library or study. For example, if a study contains many study 
objects that you expect to reuse, you can use the import feature to create the study objects quickly in 
a library or study. After a study has been imported, you can revise, add, or delete study objects as 
needed. 

You can import a file in CSML or ODM format 

• Clinical Study Markup Language (CSML) is an XML-based markup language developed by 
Oracle for representing and exchanging clinical data definitions created in the Central Designer 
application. 

• Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data 
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data. 

For example, you can use the CSML option to import an exported Central Designer study into 
another study.  

Note: You cannot import a CSML file into a library if the file contains a study design. A CSML file 
contains a study design if you exported the CSML from a study. To add study objects that are in a 
CSML file to a library, import the CSML file into a study, use the Libraries Browser to search for 
the study objects, and then drag them to the library.  

 

Importing study objects 

Note: You cannot import a CSML file into a library if the file contains a study design. A CSML file 
contains a study design if you exported the CSML from a study. To add study objects that are in a 
CSML file to a library, import the CSML file into a study, use the Libraries Browser to search for 
the study objects, and then drag them to the library.  

1 In the Project Explorer, right-click a study or library, and select Import Study. 

The Central Designer Import Wizard appears. 

2 Complete the pages of the Central Designer Import Wizard. Click Next after you finish filling in each 
page. On the Import Type page, select the source of the data to import.  
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Based on your selection, the Central Designer Import Wizard prompts for different information 
as you progress through the wizard. 

After you select a file to import and click Next, the wizard reviews all the study objects in the 
file. This process might take several minutes. 

3 On the final page of the Central Designer Import Wizard, click Finish. 

If you are importing a CSML file containing study objects for a system that is not selected as a 
Deployment System for the study or library, a message appears; choose one of the following 
options: 

• Continue with the import, and select all the systems in the CSML file as Deployment 
Systems. If you choose this option, continue to the next step. 

• Cancel the import. 

A slide-up message appears in the lower-right corner to indicate when the job starts and 
completes. 

4 When the job completes, check the status in the Jobs Browser. 

5 Review the imported study objects, and add, delete, or modify them as necessary. 

Note: If you uninstall a deployment system, you cannot import a CSML file that contains study 
objects for that system. 

For more information, see: 

Import Wizard options - CSML or ODM file (on page 150). 

Import Wizard options - InForm resources (on page 151). 
 

Viewing import job results 
1 In the Project Explorer, select a study or library. 

2 In the row of browser tabs, select the Jobs Browser. 

The Jobs Browser appears. 

Note: In the Jobs Since list, you can select the period for which you want to view job results. 
You can also sort the list by the Name or Start Time column to locate a job quickly by a 
specific starting date. 

3 Click Refresh. 

The list of jobs is refreshed from the database.  

4 On the toolbar, click Show Job Results, and expand the results for an individual job. 

Information, warning, and error messages appear for the jobs run in the selected period. 

Note: To view the complete text of a message that is truncated because of column size, 
hold the cursor over the portion of text that is visible. Alternately, select a row, and then 
right-click it and select Properties. 
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CSML metadata imports 
If you export and then re-import a study using the CSML format, the Study Design object is 
overwritten. (Each study has only one Study Design object.) The following rules apply when an 
imported study object and an existing study object have the same object ID. 

 

Import target Imported study object has the 
same ID as a study object in... 

Result 

Study Any other study. The ID of the imported study object is 
changed to a new ID. 

All references to the imported study 
object in the import are updated to refer 
to the new ID. 

 The same study. The ID of the imported object does not 
change. 

Library Any library. The ID of the imported object does not 
change. 

 Any study. The ID of the imported study object is 
changed to a new ID. 

All references to the imported study 
object in the import are updated to refer 
to the new ID. 

 

When functions are declared in the study CSML, functions are imported except under the following 
circumstances: 

• When you import CSML in a study, and a function in the CSML already exists in a library that is 
in the Library List for the study. The function is already available for use. You do not receive an 
error or warning.  

• When the function assembly does not exist in the database. You receive a warning. 
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ODM metadata imports 
The Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data 
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data. ODM is a 
vendor-neutral, platform-independent format used for importing, exporting, and archiving clinical 
study data and metadata. 

The Central Designer import feature supports a subset of the ODM standard, using only the 
metadata that fits into the Central Designer CSML schema. 

You can import metadata in ODM format into the Central Designer application as long as the 
metadata: 

• Complies with version 1.3 of the ODM standard. 

• Contains only standard ODM objects with no extensions. 

• Has a file type of Snapshot and contains only one study, one metadata version, and one protocol. 

• Includes measurement units that are present in the Central Designer Units definition in the 
database. 

Note: If the metadata contains units that are not present in the Central Designer database, 
a warning occurs, and the units are not imported. 

 

ODM mappings 

The following table describes how ODM elements are mapped to Central Designer study objects 
during import. 

 

ODM element Central Designer study object 
Study Study design 

StudyEventDef Study event 

FormDef Form 

ItemGroupDef  Section 

ItemDef (datatype=INTEGER) Integer item 

ItemDef (datatype=FLOAT) Float item 

ItemDef (datatype=DATE, TIME, DATETIME) Date time item 

ItemDef (datatype=TEXT, STRING) Text item 

CodeList CodeList 

CodeListItem CodeListItem 
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Considerations for ODM import in InForm studies 

You can reuse ODM-formatted study design metadata that is exported from a third-party 
application. Consider the following if you are importing metadata in ODM format into the Central 
Designer application to use in the creation of InForm studies or libraries. 

• Common visits—The ODM specification allows multiple common StudyEventDefs, while the 
Central Designer application allows only one common visit. 

All common StudyEventDefs in an ODM import file are consolidated into a single common 
visit after import. The forms defined for the common visits in the ODM import file appear in 
the single common visit in the Central Designer application. 

The CommonVisit definition for the common visit that appears in the Central Designer 
application contains a LongTitle and ShortTitle, which are populated by the Description and 
Name defined in the first common StudyEventDef in the ODM import file. 

• Units—The MeasurementUnit in the ODM import file is matched with entries in the Central 
Designer database based on unit symbols, but not unit names. If a unit in the ODM import file is 
not recognized as a unit in the Central Designer database, a warning message appears and the 
unit is not imported. 

• Metadata—The Central Designer application does not recognize some ODM metadata (for 
example, the attribute SDSVarName). Any element or attribute in the ODM import file that is 
not recognized by the Central Designer application is ignored, and is not imported. You cannot 
recover this metadata after import. 

• Rules—RangeCheck is the ODM simple range-checking attribute. Because the Central Designer 
application uses rules for range checking, ODM RangeChecks are imported as collaboration 
notes so that you can create the appropriate RangeCheck rules after importing. 

• Import file type—Snapshot ODM represents a complete picture of a study at a point in time. 
Transactional ODM represents the life of the study over time. The Central Designer application 
supports standard ODM with a file type of Snapshot. 

The Central Designer application does not support ODM file chaining. The ODM specification 
allows files to be chained together through the FileOID and PriorFileOID attributes. File 
chaining is primarily used in Transactional ODM, but can also be used in Snapshot ODM to 
break up study metadata into multiple files that are chained together. Transactional ODM uses 
file chaining to create a final end state of a study upon import completion. Because the Central 
Designer application does not support file chaining, if you import Transactional ODM, an error 
occurs. 

Note: You cannot import InForm metadata that you extracted from the InForm Adapter 
application with a Transactional file type. You must specify Snapshot as the file type 
parameter when you export data from the InForm Adapter application. For more 
information see the InForm Adapter User Guide. 

• Workflow—Because the OrderNumber attribute is optional for StudyEventDefs in an ODM 
import file, the order in which the StudyEventDefs appear in the ODM is the order in which 
they appear in the Central Designer workflow. 

• A study event with an OrderNumber attribute is assigned a sequence number, unless its 
predecessor in the workflow has a type of Scheduled. 

• A study event with no OrderNumber attribute is placed at the end of the workflow, in the 
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order in which it is read from the ODM import file. 

Note: Any study event, with or without an OrderNumber attribute, is assigned a sequence 
number of zero if its predecessor in the workflow has a type of Scheduled. 

• Localization—The Central Designer application imports localized data specified in an ODM 
import file. The translated data appears in the Central Designer application in the language to 
which it was localized. For more information, see the ODM specification for the TranslatedText 
element on the CDISC web site. 

The following localized study objects can be imported: 

• Forms. 

• Sections. 

• Items (Question, Text, and Description). 

• The decoded value for codelist items. 

• Symbols for measurement units. 

• Granularity—Granularity is an optional ODM file attribute. If present, it must be set to All or 
Metadata. If Granularity is set to Metadata, the document cannot contain AdminData , 
ClinicalData, or ReferenceData sections. 

• Naming uniqueness—The Central Designer application enforces naming uniqueness with 
Universal Unique Identifiers (UUIDs). A UUID is a Global Unique Identifer (GUID) that is 
created using the Object Identifier (OID) for a study object. If the OID is not a valid GUID or 
is already used by another object, the import process generates a GUID using Microsoft’s GUID 
generation algorithm. 

For example, during the import, to create a StudyEventOID, the Central Designer application: 

1 Truncates the OID to the maximum allowed length. 

2 Removes disallowed characters. 

In addition, within an ODM import file, ODM allows the reuse of RefNames if the RefName is 
for a different type of study object. However, the Central Designer application requires unique 
RefNames for all study objects in a study, and for all study objects in an import file. To enforce 
the uniqueness of RefNames in the import file, the Central Designer application adds prefixes to 
the imported study object RefNames according to the study object type. 

If an ODM import file contains study objects with the same RefName, the Central Designer 
application uses the following logic: 

• For study objects of the same type, the Central Designer application creates a new object 
with a different ID but the same RefName, and adds a prefix to the RefName. 

• For study objects not of the same type, the Central Designer application imports the study 
object and displays a warning that duplicate RefNames exist. 

Note: If you import multiple ODM files, and duplicate RefNames exist between the files, the 
Central Designer application allows you to import the study objects. You must resolve 
RefName conflicts after import in order to validate the study. 
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The Central Designer application applies the following prefixes for study objects with duplicate 
RefNames within an ODM import file. 

 

CSML object type Prefix 

StudyDesign SD_ 

StudyEvent SE_ 

DataView (from the FormDef definition in the ODM import file) DF_ 

DataView (from the ItemGroupDef definition in the ODM import file) DI_ 

IntegerVariable, FloatVariable, DateTimeVariable, or TextVariable VR_ 

CodeList CL_ 

CodeListItem CI_ 
 

 

Pre-import checking 

Pre-import checking verifies that the following conditions are met before ODM is transformed to 
CSML for import into the Central Designer application. 

• All requirements are met. For more information, see Considerations for ODM import in 
InForm studies (on page 131). 

• The input file is a well-formed XML file and is fully compliant with the ODM 1.3 schema. 

Note: Error and warning messages appear as Job Results in the Central Designer Job Browser. 

 

Post-import modifications 
After you import a study from an external source, you should review the imported study object 
definitions to identify the additions and changes they require. For example: 

• If you import a file in CSML format, Central Designer rules are created. If any rule refers to a 
user-defined function that does not exist in the target study, import the user-defined function to 
the study. If a required constant does not exist in the study or in a library that the study uses, add 
the constant or add the appropriate library to the Library List. 

• If you import from a source other than CSML, imported rules are not converted to Central 
Designer rules; instead, they appear as collaboration notes. You must create a rule for each rule 
in the import file that you want to use in the library or study. 

• In order to use imported study objects as valid deployable Central Designer study objects, you 
should review the imported study objects to add additional information that is not contained in 
the ODM format. For example, you must: 

• Create form layouts for imported forms. 

• Translate study object labels and text strings as needed for multi-lingual studies. 

• Create a range check rule for each imported ODM RangeCheck that you want to use in the 
library or study. For more information, see the Rules Reference Guide. 

• Resolve RefName conflicts for all study objects you want to deploy to a target application. 
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• Connect any scheduled imported events or elements in the proper order with arrows, and 
provide hours between the visits. 

• If studies or study objects were marked as templates, you must re-mark the study objects as 
templates. 

Note: If you harvest InForm resources and publish them in a library, both forms and sections 
appear in the forms group when you search for study objects. However, in the Project Explorer, 
forms and sections have different icons. Using naming conventions that clearly distinguish forms 
from sections is recommended. 

 

About exporting 
The export feature enables you to export a study or library to a file, for archiving or for importing 
back into the Central Designer application or to an ODM-compliant system. With the export feature, 
you can generate export files in Clinical Study Markup Language (CSML) or in Operational Data 
Model (ODM)-compliant format: 

• Clinical Study Markup Language (CSML) is an XML-based markup language developed by 
Oracle for representing and exchanging clinical data definitions created in the Central Designer 
application. 

• Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data 
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data. The 
Central Designer application exports XML that is compliant with the 1.3 version of the ODM 
standard. 

Note: When you export a study or library, you export the entire study or library. You cannot 
selectively export certain study objects. 

 

Exporting study objects 
1 In the Project Explorer, right-click the study or library from which you want to export study 

objects, and select Export Study. 

The Central Designer Export Wizard appears. 

2 Complete the pages of the Central Designer Export Wizard. Click Next when you finish filling out 
each page. 

3 On the final page of the Central Designer Export Wizard, click Finish. 

An export file is created in the location you specified in the wizard. 

Note: If errors result when you export to the ODM format, a dialog box containing the errors 
appears. 

For more information, see Export Wizard options (on page 148). 
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Reserved words for RefNames 
The following keywords and reserved words cannot be used as RefNames. You can use the following 
words as part of a RefName; for example, abstract_1 is allowed. 

Note: You cannot use non-English characters in RefNames. 

 

C# 
keywords     

 

• abstract • decimal • float • long • sbyte • typeof 

• as • default • for • namespace • sealed • uint 

• base • delegate • foreach • new • short • ulong 

• bool • do • goto • object • sizeof • unchecked 

• break • double • public • operator • stackalloc • unsafe 

• byte • else • if • out • static • ushort 

• case • enum • implicit • override • string • using 

• catch • event • in • params • struct • virtual 

• char • explicit • int • private • switch • volatile 

• checked • null • interface • protected • this • void 

• class • extern • internal • readonly • throw • while 

• const • false • is • ref • true  

• continue • fixed • lock • return • try  
 

 

Oracle keywords 
 

 

• AFROWID • ITEMSETID • SUBJECTVISITID 

• CD_COUNT • ITEMSETIDX • SUBJECTVISITREV 

• DATETIME • ITEMSETINDEX • SUBJECTID 

• DELETEDFORM • NOTDONE • SUBJECTINITIALS 

• DELETEDITEM • SECTIONID • VISITID 

• FORMID • SITECOUNTRY • VISITINDEX 

• FORMIDX • SITEID • VISITMNEMONIC 

• FORMINDEX • SITEMNEMONIC • VISITORDER 

• FORMMNEMONIC • SITENAME  

• FORMREV • STUDYVERSIONID  
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Rules-related keywords 

• Current 

• CurrentIndex 

• CurrentValuesIndex 

• CurrentAllValuesIndex 

• CurrentObjectsIndex 

• CurrentAllObjectsIndex 

Oracle reserved words 

A, ABORT, ACCESS, ACCESSED, ACCOUNT, ACTIVATE, ADD, ADMIN, ADMINISTER, 
ADMINISTRATOR, ADVISE, ADVISOR, AFTER, ALGORITHM, ALIAS, ALL, ALLOCATE, 
ALLOW, ALL_ROWS, ALTER,ALWAYS, ANALYZE, ANCILLARY, AND, AND_EQUAL, 
ANTIJOIN, ANY, APPEND, APPLY, ARCHIVE, ARCHIVELOG, ARRAY, AS, ASC, 
ASSOCIATE, AT, ATTRIBUTE, ATTRIBUTES, AUDIT, AUTHENTICATED, 
AUTHENTICATION, AUTHID, AUTHORIZATION, AUTO, AUTOALLOCATE, 
AUTOEXTEND, AUTOMATIC, AVAILABILITY, BACKUP, BECOME, BEFORE, BEGIN, 
BEHALF, BETWEEN, BFILE, BIGFILE, BINARY_DOUBLE, 
BINARY_DOUBLE_INFINITY, BINARY_DOUBLE_NAN, BINARY_FLOAT, 
BINARY_FLOAT_INFINITY, BINARY_FLOAT_NAN, BINDING, BITMAP, BITS, BLOB, 
BLOCK, BLOCKS, BLOCKSIZE, BLOCK_RANGE, BODY, BOTH, BOUND, BROADCAST, 
BUFFER, BUFFER_CACHE, BUFFER_POOL, BUILD, BULK, BY, 
BYPASS_RECURSIVE_CHECK, BYPASS_UJVC, BYTE, CACHE, CACHE_CB, 
CACHE_INSTANCES, CACHE_TEMP_TABLE, CALL, CANCEL, CARDINALITY, 
CASCADE, CASE, CAST, CATEGORY, CERTIFICATE, CFILE, CHAINED, CHANGE, 
CHAR, CHARACTER, CHAR_CS, CHECK, CHECKPOINT, CHILD, CHOOSE, CHUNK, 
CIV_GB, CLASS, CLEAR, CLOB, CLONE, CLOSE, CLOSE_CACHED_OPEN_CURSORS, 
CLUSTER, CLUSTERING_FACTOR, COALESCE, COARSE, COLLECT, 
COLLECTIONS_GET_REFS, COLUMN, COLUMNS, COLUMN_STATS, COLUMN_VALUE, 
COMMENT, COMMIT, COMMITTED, COMPACT, COMPATIBILITY, COMPILE, 
COMPLETE, COMPOSITE_LIMIT, COMPRESS, COMPUTE, CONFORMING, CONNECT, 
CONNECT_BY_ISCYCLE, CONNECT_BY_ISLEAF, CONNECT_BY_ROOT, 
CONNECT_TIME, CONSIDER, CONSISTENT, CONSTRAINT, CONSTRAINTS, 
CONTAINER, CONTENT, CONTENTS, CONTEXT, CONTINUE, CONTROLFILE, 
CONVERT, CORRUPTION, COST, CPU_COSTING, CPU_PER_CALL, CPU_PER_SESSION, 
CREATE, CREATE_STORED_OUTLINES, CROSS, CUBE, CUBE_GB, CURRENT, 
CURRENT_DATE, CURRENT_SCHEMA, CURRENT_TIME, CURRENT_TIMESTAMP, 
CURRENT_USER, CURSOR, CURSOR_SHARING_EXACT, 
CURSOR_SPECIFIC_SEGMENT, CYCLE, DANGLING, DATA, DATABASE, DATAFILE, 
DATAFILES, DATAOBJNO, DATE, DATE_MODE, DAY, DBA, DBA_RECYCLEBIN, 
DBTIMEZONE, DDL, DEALLOCATE, DEBUG, DEC, DECIMAL, DECLARE, 
DECREMENT, DEFAULT, DEFERRABLE, DEFERRED, DEFINED, DEFINER, DEGREE, 
DELAY, DELETE, DEMAND, DENSE_RANK, DEREF, DEREF_NO_REWRITE, DESC, 
DETACHED, DETERMINES, DICTIONARY, DIMENSION, DIRECTORY, DISABLE, 
DISASSOCIATE, DISCONNECT, DISK, DISKGROUP, DISKS, DISMOUNT, DISTINCT, 
DISTINGUISHED, DISTRIBUTED, DML, DML_UPDATE, DOCUMENT, 
DOMAIN_INDEX_NO_SORT, DOMAIN_INDEX_SORT, DOUBLE, DOWNGRADE, 
DRIVING_SITE, DROP, DUMP, DYNAMIC, DYNAMIC_SAMPLING, 
DYNAMIC_SAMPLING_EST_CDN, EACH, ELEMENT, ELSE, EMPTY, ENABLE, 
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ENCRYPTED, ENCRYPTION, END, ENFORCE, ENFORCED, ENTRY, ERROR, 
ERROR_ON_OVERLAP_TIME, ESCAPE, ESTIMATE, EVENTS, EXCEPT, EXCEPTIONS, 
EXCHANGE, EXCLUDING, EXCLUSIVE, EXECUTE, EXEMPT,EXISTS, 
EXPAND_GSET_TO_UNION, EXPIRE, EXPLAIN, EXPLOSION, EXPORT, 
EXPR_CORR_CHECK, EXTEND, EXTENDS, EXTENT, EXTENTS, EXTERNAL, 
EXTERNALLY, EXTRACT, FACT, FAILED, FAILED_LOGIN_ATTEMPTS, FAILGROUP, 
FALSE, FAST, FBTSCAN, FIC_CIV, FIC_PIV, FILE, FILTER, FINAL, FINE, FINISH, FIRST, 
FIRST_ROWS, FLAGGER, FLASHBACK, FLOAT, FLOB, FLUSH,FOLLOWING, FOR, 
FORCE, FORCE_XML_QUERY_REWRITE, FOREIGN, FREELIST, FREELISTS, 
FREEPOOLS, FRESH, FROM, FULL, FUNCTION, FUNCTIONS, 
GATHER_PLAN_STATISTICS, GBY_CONC_ROLLUP, GENERATED, GLOBAL, 
GLOBALLY, GLOBAL_NAME, GLOBAL_TOPIC_ENABLED, GRANT, GROUP, 
GROUPING, GROUPS, GROUP_BY, GUARANTEE, GUARANTEED, GUARD, HASH, 
HASHKEYS, HASH_AJ, HASH_SJ, HAVING, HEADER, HEAP, HIERARCHY, HIGH, 
HINTSET_BEGIN, HINTSET_END, HOUR, HWM_BROKERED, ID, IDENTIFIED, 
IDENTIFIER, IDENTITY, IDGENERATORS, IDLE_TIME, IF, IGNORE, 
IGNORE_ON_CLAUSE, IGNORE_OPTIM_EMBEDDED_HINTS, 
IGNORE_WHERE_CLAUSE, IMEDIATE, IMPORT, IN, INCLUDE_VERSION, 
INCLUDING, INCREMENT, INCREMENTAL, INDEX, NDEXED, INDEXES, 
INDEXTYPE, INDEXTYPES, INDEX_ASC, INDEX_COMBINE, INDEX_DESC, 
INDEX_FFS, INDEX_FILTER, INDEX_JOIN, NDEX_ROWS, INDEX_RRS, INDEX_SCAN, 
INDEX_SKIP_SCAN, INDEX_SS, INDEX_SS_ASC, INDEX_SS_DESC, INDEX_STATS, 
INDICATOR, INFINITE, INFORMATIONAL, INITIAL, INITIALIZED, INITIALLY, 
INITRANS, INLINE, INNER, INSERT, INSTANCE, INSTANCES, INSTANTIABLE, 
INSTANTLY, INSTEAD, INT, INTEGER, INTEGRITY, INTERMEDIATE, 
INTERNAL_CONVERT, INTERNAL_USE, INTERPRETED, INTERSECT, 
INTERVAL,INTO, INVALIDATE, IN_MEMORY_METADATA, IS, ISOLATION, 
ISOLATION_LEVEL, ITERATE, ITERATION_NUMBER, JAVA, JOB, JOIN, KEEP, 
KERBEROS, KEY, KEYFILE, KEYS, KEYSIZE,KEY_LENGTH, KILL, LAST, LATERAL, 
LAYER, LDAP_REGISTRATION, LDAP_REGISTRATION_ENABLED, 
LDAP_REG_SYNC_INTERVAL, LEADING, LEFT, LENGTH, LESS, LEVEL, LEVELS, 
LIBRARY, LIKE, LIKE2, LIKE4, LIKEC, LIKE_EXPAND, LIMIT, LINK, LIST, LOB, LOCAL, 
LOCALTIME, LOCALTIMESTAMP, LOCAL_INDEXES, LOCATION, LOCATOR, LOCK, 
LOCKED, LOG, LOGFILE, LOGGING, LOGICAL, LOGICAL_READS_PER_CALL, 
LOGICAL_READS_PER_SESSION, LOGOFF, LOGON, LONG, MAIN, MANAGE, 
MANAGED, MANAGEMENT, MANUAL, MAPPING, MASTER, MATCHED, 
MATERIALIZE, MATERIALIZED, MAX, MAXARCHLOGS, MAXDATAFILES, 
MAXEXTENTS, MAXIMIZE, MAXINSTANCES, MAXLOGFILES, MAXLOGHISTORY, 
MAXLOGMEMBERS, MAXSIZE, MAXTRANS, MAXVALUE, MEASURES, MEMBER, 
MEMORY, MERGE, MERGE_AJ, MERGE_CONST_ON, MERGE_SJ, METHOD, MIGRATE, 
MIN, MINEXTENTS, MINIMIZE, MINIMUM, MINUS, MINUTE, MINVALUE, MIRROR, 
MLSLABEL, MODE, MODEL,MODEL_DONTVERIFY_UNIQUENESS, 
MODEL_MIN_ANALYSIS, MODEL_NO_ANALYSIS, MODEL_PBY, MODEL_PUSH_REF, 
MODIFY, MONITORING, MONTH, MOUNT, MOVE, MOVEMENT, MULTISET, 
MV_MERGE, NAME, NAMED, NAN, NATIONAL, NATIVE, NATURAL, NAV, NCHAR, 
NCHAR_CS, NCLOB, NEEDED, NESTED, NESTED_TABLE_FAST_INSERT, 
NESTED_TABLE_GET_REFS, NESTED_TABLE_ID, NESTED_TABLE_SET_REFS, 
NESTED_TABLE_SET_SETID, NETWORK, NEVER, NEW, NEXT, NLS_CALENDAR, 
NLS_CHARACTERSET, NLS_COMP, NLS_CURRENCY, NLS_DATE_FORMAT, 
NLS_DATE_LANGUAGE, NLS_ISO_CURRENCY, NLS_LANG, NLS_LANGUAGE, 
NLS_LENGTH_SEMANTICS, NLS_NCHAR_CONV_EXCP, 
NLS_NUMERIC_CHARACTERS, NLS_SORT, NLS_SPECIAL_CHARS, NLS_TERRITORY, 
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NL_AJ, NL_SJ, NO, NOAPPEND, NOARCHIVELOG, NOAUDIT, NOCACHE, 
NOCOMPRESS, NOCPU_COSTING, NOCYCLE, NODELAY, NOFORCE, 
NOGUARANTEE, NOLOGGING, NOMAPPING, NOMAXVALUE, NOMINIMIZE, 
NOMINVALUE, NOMONITORING, NONE, NOORDER, NOOVERRIDE, NOPARALLEL, 
NOPARALLEL_INDEX, NORELY, NOREPAIR, NORESETLOGS, NOREVERSE, 
NOREWRITE, NORMAL, NOROWDEPENDENCIES, NOSEGMENT, NOSORT, 
NOSTRICT, NOSWITCH, NOT, NOTHING, NOVALIDATE, NOWAIT, NO_ACCESS, 
NO_BASETABLE_MULTIMV_REWRITE, NO_BUFFER, NO_CPU_COSTING, 
NO_EXPAND, NO_EXPAND_GSET_TO_UNION, NO_FACT, NO_FILTERING, 
NO_INDEX, NO_INDEX_FFS, NO_INDEX_SS, NO_MERGE, NO_MODEL_PUSH_REF, 
NO_MONITORING, NO_MULTIMV_REWRITE, NO_ORDER_ROLLUPS, NO_PARALLEL, 
NO_PARALLEL_INDEX, NO_PARTIAL_COMMIT, NO_PRUNE_GSETS, 
NO_PUSH_PRED, NO_PUSH_SUBQ, NO_QKN_BUFF, 
NO_QUERY_TRANSFORMATION, NO_REF_CASCADE, NO_REWRITE, NO_SEMIJOIN, 
NO_SET_TO_JOIN, NO_STAR_TRANSFORMATION, NO_STATS_GSETS, 
NO_SWAP_JOIN_INPUTS, NO_UNNEST, NO_USE_HASH, NO_USE_MERGE, 
NO_USE_NL, NO_XML_QUERY_REWRITE, NULL, NULLS, NUMBER, NUMERIC, 
NVARCHAR2, OBJECT, OBJNO, OBJNO_REUSE, OF, OFF, OFFLINE, OID, OIDINDEX, 
OLD, ON, ONLINE, ONLY, OPAQUE, OPAQUE_TRANSFORM, 
OPAQUE_XCANONICAL, OPCODE, OPEN, OPERATOR, OPTIMAL, 
OPTIMIZER_FEATURES_ENABLE, OPTIMIZER_GOAL, OPTION, OPT_ESTIMATE, OR, 
ORA_ROWSCN, ORDER, ORDERED, ORDERED_PREDICATES, ORGANIZATION, 
OR_EXPAND, OUTER, OUTLINE, OUT_OF_LINE, OVER, OVERFLOW, 
OVERFLOW_NOMOVE, OVERLAPS, OWN, PACKAGE, PACKAGES, PARALLEL, 
PARALLEL_INDEX, PARAMETERS, PARENT, PARITY, PARTIALLY, PARTITION, 
PARTITIONS, PARTITION_HASH, PARTITION_LIST, PARTITION_RANGE, PASSWORD, 
PASSWORD_GRACE_TIME, PASSWORD_LIFE_TIME, PASSWORD_LOCK_TIME, 
PASSWORD_REUSE_MAX, PASSWORD_REUSE_TIME, 
PASSWORD_VERIFY_FUNCTION, PCTFREE, PCTINCREASE, PCTTHRESHOLD, 
PCTUSED, PCTVERSION, PERCENT, PERFORMANCE, PERMANENT, PFILE, PHYSICAL, 
PIV_GB, PIV_SSF, PLAN, PLSQL_CODE_TYPE, PLSQL_DEBUG, 
PLSQL_OPTIMIZE_LEVEL, PLSQL_WARNINGS, POLICY, POST_TRANSACTION, 
POWER, PQ_DISTRIBUTE, PQ_MAP, PQ_NOMAP, PREBUILT, PRECEDING, PRECISION, 
PREPARE, PRESENT, PRESERVE, PRIMARY, PRIOR, PRIVATE, PRIVATE_SGA, 
PRIVILEGE, PRIVILEGES, PROCEDURE, PROFILE, PROGRAM, PROJECT, PROTECTED, 
PROTECTION, PUBLIC, PURGE, PUSH_PRED, PUSH_SUBQ, PX_GRANULE, QB_NAME, 
QUERY, QUERY_BLOCK, QUEUE, QUEUE_CURR, QUEUE_ROWP, QUIESCE, QUOTA, 
RANDOM, RANGE, RAPIDLY, RAW, RBA, READ, READS, REAL, REBALANCE, 
REBUILD, RECORDS_PER_BLOCK, RECOVER, RECOVERABLE, RECOVERY, RECYCLE, 
RECYCLEBIN, REDUCED, REDUNDANCY, REF, REFERENCE, REFERENCED, 
REFERENCES, REFERENCING, REFRESH, REF_CASCADE_CURSOR, REGEXP_LIKE, 
REGISTER, REJECT, REKEY, RELATIONAL, RELY, REMOTE_MAPPED, RENAME, 
REPAIR, REPLACE, REQUIRED, RESET, RESETLOGS, RESIZE, RESOLVE, RESOLVER, 
RESOURCE, RESTORE_AS_INTERVALS, RESTRICT, RESTRICTED, 
RESTRICT_ALL_REF_CONS, RESUMABLE, RESUME, RETENTION, RETURN, 
RETURNING, REUSE, REVERSE, REVOKE, REWRITE, REWRITE_OR_ERROR, RIGHT, 
ROLE, ROLES, ROLLBACK, ROLLUP, ROW, ROWDEPENDENCIES, ROWID, ROWNUM, 
ROWS, ROW_LENGTH, RULE, RULES, SAMPLE, SAVEPOINT, SAVE_AS_INTERVALS, 
SB4, SCALE, SCALE_ROWS, SCAN, SCAN_INSTANCES, SCHEDULER, SCHEMA, SCN, 
SCN_ASCENDING, SCOPE, SD_ALL, SD_INHIBIT, SD_SHOW,SECOND, SECURITY, 
SEED, SEGMENT, SEG_BLOCK, SEG_FILE, SELECT, SELECTIVITY, SEMIJOIN, 
SEMIJOIN_DRIVER, SEQUENCE, SEQUENCED, SEQUENTIAL, SERIALIZABLE, 



Chapter 5  Managing study objects  
 

140 Oracle® Health Sciences Central Designer 2.0 

SERVERERROR, SESSION, SESSIONS_PER_USER, SESSIONTIMEZONE, 
SESSIONTZNAME, SESSION_CACHED_CURSORS, SET, SETS, SETTINGS, 
SET_TO_JOIN, SEVERE, SHARE, SHARED, SHARED_POOL, SHRINK, SHUTDOWN, 
SIBLINGS, SID, SIMPLE, SINGLE, SINGLETASK, SIZE, SKIP, SKIP_EXT_OPTIMIZER, 
SKIP_UNQ_UNUSABLE_IDX, SKIP_UNUSABLE_INDEXES, SMALLFILE, SMALLINT, 
SNAPSHOT, SOME, SORT, SOURCE, SPACE, SPECIFICATION, SPFILE, SPLIT, 
SPREADSHEET, SQL, SQLLDR, SQL_TRACE, STANDBY, STAR, START, STARTUP, 
STAR_TRANSFORMATION, STATEMENT_ID, STATIC, STATISTICS, STOP, STORAGE, 
STORE, STREAMS, STRICT, STRIP, STRUCTURE, SUBMULTISET, SUBPARTITION, 
SUBPARTITIONS, SUBPARTITION_REL, SUBSTITUTABLE, SUCCESSFUL, SUMMARY, 
SUPPLEMENTAL, SUSPEND, SWAP_JOIN_INPUTS, SWITCH, SWITCHOVER, SYNONYM, 
SYSAUX, SYSDATE, SYSDBA, SYSOPER, SYSTEM, SYSTIMESTAMP, SYS_DL_CURSOR, 
SYS_FBT_INSDEL, SYS_OP_BITVEC, SYS_OP_CAST, SYS_OP_COL_PRESENT, 
SYS_OP_ENFORCE_NOT_NULL$, SYS_OP_MINE_VALUE, SYS_OP_NOEXPAND, 
SYS_OP_NTCIMG$, SYS_PARALLEL_TXN, SYS_RID_ORDER, TABLE, TABLES, 
TABLESPACE, TABLESPACE_NO, TABLE_STATS, TABNO, TEMPFILE, TEMPLATE, 
TEMPORARY, TEST, THAN, THE, THEN, THREAD, THROUGH, TIME, TIMEOUT, 
TIMESTAMP, TIMEZONE_ABBR, TIMEZONE_HOUR, TIMEZONE_MINUTE, 
TIMEZONE_REGION, TIME_ZONE, TIV_GB, TIV_SSF, TO, TOPLEVEL, TRACE, 
TRACING, TRACKING, TRAILING, TRANSACTION, TRANSITIONAL, TREAT, 
TRIGGER, TRIGGERS, TRUE, TRUNCATE, TRUSTED, TUNING, TX, TYPE, TYPES, 
TZ_OFFSET, UB2, UBA, UID, UNARCHIVED, UNBOUND, UNBOUNDED, UNDER, 
UNDO,UNDROP, UNIFORM, UNION, UNIQUE, UNLIMITED, UNLOCK, UNNEST, 
UNPACKED, UNPROTECTED, UNQUIESCE, UNRECOVERABLE, UNTIL, UNUSABLE, 
UNUSED, UPDATABLE, UPDATE, UPDATED, UPD_INDEXES, UPD_JOININDEX, 
UPGRADE, UPSERT, UROWID, USAGE, USE, USER, USER_DEFINED, 
USER_RECYCLEBIN, USE_ANTI, USE_CONCAT, USE_HASH, USE_MERGE, USE_NL, 
USE_NL_WITH_INDEX, USE_PRIVATE_OUTLINES, USE_SEMI, 
USE_STORED_OUTLINES, USE_TTT_FOR_GSETS, USE_WEAK_NAME_RESL, USING, 
VALIDATE, VALIDATION, VALUE, VALUES, VARCHAR, VARCHAR2, VARRAY, 
VARYING, VECTOR_READ, VECTOR_READ_TRACE, VERSION, VERSIONS, VIEW, 
WAIT, WELLFORMED, WHEN, WHENEVER, WHERE, WHITESPACE, WITH, WITHIN, 
WITHOUT, WORK, WRITE, XID, XMLATTRIBUTES, XMLCOLATTVAL, XMLELEMENT, 
XMLFOREST, XMLPARSE, XMLSCHEMA, XMLTYPE, X_DYN_PRUNE, YEAR, ZONE 

 



 

Oracle® Health Sciences Central Designer 2.0 141 

In this appendix 
Collaboration ....................................................................................................................................... 142 

Home page ........................................................................................................................................... 147 

Study objects ........................................................................................................................................ 148 

 
 

 A P P E N D I X  A  
Option and property descriptions 



Appendix A  Option and property descriptions  
 

142 Oracle® Health Sciences Central Designer 2.0 

Collaboration 

Collaboration Notes Browser—Option descriptions 
 

Option Description 
Fields  

Author Person who created the collaboration note.  

Created Date Date and time the collaboration note was created.  

READ-ONLY 

Description Description of the collaboration note. 

ID Unique identifier of the collaboration note. 

Object Name Study object to which the collaboration note is attached. 

Object Type Type of study object (such as form or study event) to which the 
collaboration note is attached. 

Type Collaboration note type on which the collaboration note was based. 
Collaboration note types are defined in the Central Designer Administrator 
application. 

Toolbar options  

New Note 
Edit 
Print 
Delete 

Create, edit, print, or delete the selected collaboration note.  

Show Children • Selected—You see all collaboration notes attached to the selected 
study object and its children. 

• Not selected—You see the collaboration notes that are attached to the 
selected study object only. 

Refresh Refresh the information in the Collaboration Notes Browser with 
information from the database. 

 
 

Collaboration Note Editor dialog box—Option descriptions 
 

Option Description 
Study (READ-ONLY.) Study with the study object to which the collaboration 

note is attached.  

Object Name (READ-ONLY.) Study object to which the collaboration note is attached.  

Object Type (READ-ONLY.) Type of study object to which you are attaching the 
collaboration note, such as a form or study event. 
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Option Description 
Note Type (REQUIRED.) Type of the collaboration note. An administrator defines 

collaboration note types in the Central Designer Administrator application. 

Author (READ-ONLY.) User who created the collaboration note. 

Instructions text field Text for the collaboration note.  
 

 

Task areas—Field descriptions 
The following fields appear in: 

• My Recent Tasks Since section of the Home Page. 

• My Tasks section of the Home Page. 

• Tasks Browser. 

Note: Some fields appear on the Home page, but not in the Tasks Browser. In addition, not all 
fields appear in the default view. Optionally, you can add the other fields to the browser view, and 
you can rearrange the order of fields. For more information, see Showing and hiding a field (on 
page 23). 

 

Field Description 
Completed By Person who completed the task. 

Completed Date Date and time the task was completed. 

READ-ONLY 

Created Date Date and time the task was created. 

Description Description of the task. 

Due Date Deadline for the task, selected by the task requester. If the task is overdue, 
the date is red. 

READ-ONLY 

Id Unique identifier for the task. 

Object Name Study object to which the task is attached. 

Object Type Task type.  

Owner User or team responsible for the task: 

• Assigned task—The assignee (or assignees). 

• Accepted task—The accepter.  

• Completed task—The creator.  

Priority Priority of the task. Options are Critical, High, Medium, and Low. 

Project Id Unique identifier for the project that contains the task. 

Project Name Project that contains the task. 
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Field Description 
Requested By Person who created the task. 

Status Status of the task. 

Study Id Unique identifier for the study that contains the task. 

Study Name Study that contains the task.  

Type Task type on which the task is based. An administrator defines task types 
in the Central Designer Administrator application. 

 
 

Tasks Browser—Option descriptions 

Note: Some fields appear on the Home page, but not in the Tasks Browser. In addition, not all 
fields appear in the default view. Optionally, you can add the other fields to the browser view, and 
you can rearrange the order of fields. For more information, see Showing and hiding a field (on 
page 23). 

 

Field Description 
Completed By Person who completed the task. 

Completed Date Date and time the task was completed. 

READ-ONLY 

Created Date Date and time the task was created. 

Description Description of the task. 

Due Date Deadline for the task, selected by the task requester. If the task is overdue, 
the date is red. 

READ-ONLY 

Id Unique identifier for the task. 

Object Name Study object to which the task is attached. 

Object Type Task type.  

Owner User or team responsible for the task: 

• Assigned task—The assignee (or assignees). 

• Accepted task—The accepter.  

• Completed task—The creator.  

Priority Priority of the task. Options are Critical, High, Medium, and Low. 

Project Id Unique identifier for the project that contains the task. 

Project Name Project that contains the task. 

Requested By Person who created the task. 

Status Status of the task. 
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Field Description 
Study Id Unique identifier for the study that contains the task. 

Study Name Study that contains the task.  

Type Task type on which the task is based. An administrator defines task types 
in the Central Designer Administrator application. 

 

 

Option Description 
New Task 
Edit 
Print 
Delete 

Create, edit, print, or delete a task.  

Accept 
Complete 
Close 
Reopen 
Unaccept 

Accept, complete, close, reopen, and unaccept a task.  

Show Children • Selected—You see all tasks attached to the selected study object and 
its children. 

• Not selected—You see the tasks that are attached to the selected 
study object only. 

Refresh Refresh the information in the Tasks Browser with information from the 
database. 

 

 

 
 

Task Editor dialog box—Option descriptions 
The second tab that appears in the Task Editor dialog box depends on the type of task that is 
selected. For standard tasks, the dialog box has an Instructions tab, and for translation tasks, the 
dialog box has an Assignment tab. 

 

Option Description 
Top toolbar  

Accept, Complete, 
Close, Reopen, 
Unaccept 

Accept, complete, close, reopen, and unaccept a task.  

Top section  

Study (READ-ONLY) Study with the study object to which the task is attached.  

Object Name (READ-ONLY) Study object to which the task is attached.  

Object Type (READ-ONLY) Type of study object on which the task was created. 

Created (READ-ONLY) Date and time the task was created. 
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Option Description 
Requested By (READ-ONLY) User who created the task.  

Status (READ-ONLY) Status of the task (Open, Accepted, Completed, or Closed). 

Task Type (REQUIRED.) Type of the task. An administrator defines task types in the 
Central Designer Administrator application. 

Priority (REQUIRED.) Priority of the task. Options are Critical, High, Medium, and 
Low. 

Due (REQUIRED.) Deadline for when the task must be completed.  

Default value—Current date and time. 

Owner (READ-ONLY) Person or team to which the task is assigned. 

Completed By (READ-ONLY) User who completed the task. 

Completed Date (READ-ONLY) Date and time the task was completed. 

Instructions tab  (Appears for standard tasks only) 

Instructions text 
field 

Text for the task.  

Assignment tab  (Appears for translation tasks only) 

[List of roles] List of roles to which the task can be assigned. If an administrator specified a 
default role to which the task type is assigned, the role is selected.  

 

Note: Use the buttons on the toolbar to add an attachment and format the text. 

 



 User Guide  

Oracle® Health Sciences Central Designer 2.0 147 

Home page 

Home Page—Section descriptions 
 

Section  Description 
Recent Projects List Projects you opened recently. 

For more information, see Changing the number of projects that 
appear in the Recent Projects list (on page 21). 

My Recent Tasks 
Since 

Tasks that are open and assigned to you. Use the drop-down list to see 
tasks added since yesterday, in the last three days, in the last week, and so 
on.  

My Tasks All tasks assigned to you. 
 

 

Status toolbar—Option descriptions 
 

Option Description 

 Appears when study objects are loading. 

 
You are logged on, and the application is connected to the application server. 

 or  
• (Green circle icon)—The application is pulling information from the 

application server.  

• (Yellow circle icon)—The application is unable to pull information from 
the application server. For example, network connectivity might be 
unavailable, or the server might have stopped responding.  

 or  
• (Gray circle icon)—The server is not processing information, and you can 

work.  

• (Blue circle icon)—The server is processing information. Wait until the 
process completes before performing another activity. 
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Study objects 

Export Translations dialog box—Option descriptions 
 

Option Description 
Field  

Locale to translate from Name of the locale in which the text strings to translate have 
been defined. 

Note: The Locale to translate from is not the global default 
locale that is defined in the Tools > Options dialog box, but 
rather any locale in which the text strings to export exist. 

Translate <locale name> to Locale into which strings will be translated. 

Target Target application for which to translate strings. 

Export file location Location and file name in which to store the file of strings to 
translate. By default  the file name has the format: 

<StudyName>_ExportTranslations_<TargetSystem>_<SelectedL
ocale>.csv 

For example: 

TestStudy_ExportTranslations_InForm_fr-FR.csv 

The Browse button enables you to browse to the location. 

Include empty locale values • If selected, the file of strings to translate includes strings 
that are empty in the locale to translate from. 

• If not selected, the export process skips empty strings. 

Export log results Displays messages that are generated during the export. 

Optionally, you can save these results to a file by clicking the 
Save Log Results As button. 

Button  

Check for Empty Strings Opens a window listing all strings that are empty in the locale 
to translate from. 

Save Log Results As Specifies the location of a log file containing the messages that 
are generated in the Export log results box during the export. 
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Export Wizard options 
 

Page Option Description 
Welcome  Introduction page. 

Export Type  Select the output format and exporter type. 

 Data Type CSML—Export in Clinical Study Markup Language 
format. 

ODM—Export in Operational Data Model-compliant 
format. The Central Designer application supports the 
ODM 1.3 standard. 

 Export Type Local—Export to the computer where the Central 
Designer application is installed. 

Export File Path Export 
Directory 

Specify the path name and file in which to save the export 
file, or click Browse to browse for the path name and file 
in which to save the export file. 

Ready to Export 
Central Designer 
Data 

 View a summary of the parameters that will be used for 
the export. 

 
 

History Viewer dialog box—Option descriptions 
 

Field Description 
Top section  

Object Name of the study object.  

Unlocked or Locked icon Indicates whether study object is locked or unlocked. 

Object [name of study 
object] section 

 

Revision/Version Revision or version number of the study object, with either Version or 
Revision in parentheses to indicate if it is a version or revision. 

Note: This value is for the selected study object only, not for the study 
in which the study object exists. This value may differ from the value 
that appears for the Revision property at the bottom of the History 
Viewer dialog box. 

Label • If you are viewing versions—Label given to the version when it 
was created. 

• If you are viewing revisions—Study Revision. 

Altered By Name of the user who modified the study object for the version or 
revision.  
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Field Description 
Date Day and time when the study object was modified for the version or 

revision. 

Description • If the last save created a version—The label and description 
applied for the version.  

• If the last saved created a revision—Auto-generated description 
text. 

View changing radio 
buttons 

 

View Versions All versions of the selected study object appear in the top grid. 

View Every Edit All revisions of the study object appear in the top grid. 

Buttons  

Differences (Enabled when you select two versions or revisions.) 

View the differences between two versions or revisions of a study 
object. 

Revert to Revert to a previous version or revision of a study object. 
 

 

Import Wizard options - CSML or ODM file 
 

Page Option Description 
Welcome  Introduction page. 

Import Type  Select the source of the data to import. 

 Import CSML or 
ODM file 

Generate study objects from a file in CSML or ODM 
format. 

 Harvest InForm 
Resources 

Generate study objects from the components of an 
InForm study. 

File Location Path of file to import Specify the path of the CSML or ODM import file, or 
click Browse to locate the import file. 

Rule Import Mode Rule Import Mode Only the Import as Collaboration Notes option is 
supported. With this option, each imported rule is 
converted to a collaboration note in the Central 
Designer application. 

Note: This option applies only if the Import Type is 
ODM; if the Import Type is CSML, the import 
process creates a Central Designer rule for each 
imported rule. 

Ready to Import 
Data to Central 
Designer 

 View a summary of the import options selected in the 
wizard. 
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Import Wizard options - InForm resources 
 

Page Option Description 
Welcome  Introduction page. 

Import Type  Select the source of the data to import. 

 Import CSML or 
ODM file 

Generate study objects from a file in CSML or ODM 
format. 

 Harvest InForm 
Resources 

Generate study objects from the components of an 
InForm study. 

InForm File 
Location 

 Select the file or trial from which to harvest resources. 

 RSP or XML file Specify the full path of the RSP or XML file 
containing MedML definitions of InForm trial 
components to import, or click Browse to browse to 
the file. 

Rule Import Mode Rule Import Mode Only the Import as Collaboration Notes option is 
supported. With this option, each imported rule is 
converted to a collaboration note in the Central 
Designer application. 

Ready to Import 
Data to Central 
Designer 

 View a summary of the import options selected in the 
wizard. 

 
 

References tab—Option descriptions 
 

Option Description 
Top section  

Title Name of the file or URL attachment.  

Preview Text that appears in the Description section. 

(Paper clip 
button) 

Indicates whether the reference has an attachment (a file, shortcut to a file, or 
URL address).  

Details section  

Description Description of the attachment.  

Attachments All file and URL attachments.  

Note: The default maximum file size is 10 MB. This value can be configured. 
For more information, see Maximum attachment size (on page 117) (in the 
User Guide). 
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A 
annotated study book 

A form-by-form summary of the design of a study. 
Optionally, it includes a time and events schedule, a 
preview of each form, and selected annotations that 
list design details. 

See also study book (on page 159). 
 

application role 

A role associated with administrative activities. 
 

arm 

See study arm (on page 159). 
 

authentication 

The method of ensuring that you are using the 
correct user name and password to log on. 
 

authorization 

The method of giving users access to information or 
functionality. Access is controlled using rights, roles, 
and teams. 
 

B 
baseline 

A snapshot of all components in a study. Validation 
creates a baseline. 
 

Baselines Browser 

A browser in which you view the results of 
validation and make temporary baselines public so 
that other users can work with them. 
 

branch 

See study branch (on page 159). 
 

C 
calculation rule 

A rule that sets the value of an item based on a 
calculation. 
 

catalog 

A collection of categories and keywords that can be 
attached to users and study objects to facilitate 
searching in the Libraries Browser and Users 
Browser. 
 

catalog administration 

The process of creating keywords and categories and 
assigning them to users and study objects for faster 
and more sophisticated searching. 
 

category 

A hierarchical grouping of keywords. You can create 
categories only from existing keywords. 
 

CDISC 

Clinical Data Interchange Standards Consortium. 
CDISC is an open, multidisciplinary, non-profit 
organization committed to the development of 
industry standards to support the electronic 
acquisition, exchange, submission and archiving of 
clinical trials data and metadata for medical and 
biopharmaceutical product development.   
 

checkbox 

A type of data entry control in which you can select 
one or more options by selecting the box that 
represents each option. 
 

clinical project 

See study project (on page 160). 
 

Glossary 
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clinical protocol 

See protocol (on page 158). 
 

clinical study 

See study (on page 159). 
 

codelist 

A collection of code-label pairs that gather together 
the entry choices for an item. A code-label pair 
consists of a single code (the value that is used for 
analysis) and a label (the value that is visible to 
users). 

See also codelist item (on page 154). 
 

codelist item 

A code-label pair consisting of a single code (the 
value that is used for analysis) and a label (the value 
that is visible to users). Multiple codelist items make 
up a codelist. 

See also codelist (on page 154). 
 

coding 

The process of selecting terms and codes from a 
dictionary for a verbatim 
 

coding dictionary 

A standardized collection of terms and the codes 
that correspond to those terms. 
 

coding map 

A study object that contains the necessary 
information to code an item. 
 

coding target 

See target item (on page 160). 
 

collaboration 

The process by which users with different roles and 
specialties can work together to create, validate, and 
deploy a study. 
 

collaboration note 

A note that you attach to any study object. 
 

collaboration note type 

A classification used to identify the type and purpose 
of a collaboration note. 
 

Collaboration Notes Browser 

A browser in which you work with collaboration 
notes. 
 

common form 

A form that is designed for use with multiple study 
events. The same data appears in the form in all 
study events in which the form is used. 
 

component 

Any design building block that is configured in a 
study or library. Design components include study 
objects (such as a project, study, study element, 
study event, form, or item) as well as rules, 
individual items selected from drop-down lists, and 
controls (such as checkboxes and radio buttons). 
 

compound item 

An item that has one or more child items that can 
have different data types. 
 

constant 

A value that is defined in a library or study and that 
can be referenced by any rule. 
 

constraint rule 

A rule that checks whether data is valid. Constraint 
rules are used to confirm that clinical data meets the 
requirements of the clinical protocol. 
 

container 

A node in the Project Explorer that contains zero or 
more study objects or components. 
 

context item 

An item that provides additional coding information, 
such as the indication and route of administration 
for drugs, that can be displayed with an item coded 
using the WHO-DD dictionary. 
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CSML 

Clinical Study Markup Language. CSML is an XML-
based markup language developed by Oracle for 
representing and exchanging clinical data definitions 
created in the Central Designer application. 

See also MedML (on page 157). 
 

custom data dimension 

See data dimension (on page 155). 
 

custom property 

A user-defined or default characteristic of a study 
object. 
 

D 
data dimension 

A key item for a data set. A data dimension specifies 
the additional information that will be saved when 
study data is collected. You can specify standard data 
dimensions (Study, Subject, Event and Event Index, 
Form and Form Index, and Item) and custom data 
dimensions. 
 

data series 

A grouping of one or more items with the same 
clinical meaning, such as one or more items that 
measure weight. 

See also data set (on page 155), mapping (on page 
157). 
 

data set 

A grouping of one or more related data series. 

See also data series (on page 155), mapping (on 
page 157). 
 

data type 

An attribute for items and data series. For an item, 
the data type determines the type of entry an item 
will accept. For a data series, the data type 
determines which items can be added to it. Data 
types include date time, integer, float, and text. 
 

data-entry rule 

A rule that checks whether data is valid or that sets 

the value of an item based on a calculation. 

See also workflow rule (on page 161). 
 

date time item 

An item used to collect date and time information 
on a form. 
 

deployment 

The process of sending a study to a target 
application. To collect data, a study must be 
deployed into a target application as a complete 
deployment package. 
 

dictionary metadata item 

An identifier that describes administrative data about 
a dictionary and that you can use to create a coding 
map. 
 

dictionary type 

A name or identifier for the metadata for a 
dictionary. 
 

drop-down list 

A data entry format in which you select an option 
from a list. 
 

dynamic form 

A form that is automatically generated in the 
InForm application when subject data satisfies 
certain criteria tested in another form. 
 

dynamic visit 

A visit that is automatically generated in the InForm 
application when patient data satisfies certain criteria 
tested in another visit. 
 

E 
edit check 

A data-entry rule that checks whether entered data is 
valid. 

See data-entry rule (on page 155). 
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element 

See study element (on page 159). 
 

event 

See study event (on page 159). 
 

explicit lock 

A lock that you request and that does not expire. 

See also implicit lock (on page 156). 
 

expression 

The part of a rule that specifies what to evaluate. 
 

F 
field 

The area in a data-entry window where the value for 
an item is entered or displayed. 
 

float item 

An item used to collect numerical values with 
decimal points. 
 

form 

A container for one or more items. A form can 
contain one or more sections and supports multiple 
locales and layouts. A form is deployed to a target 
application as a data-entry form used to collect 
subject information and other clinical data. 
 

full installation deployment package 

A deployment package that contains everything 
needed to deploy a complete study. 
 

function 

A reusable piece of code that extends the behavior 
of a rule. A function can be predefined or user-
defined. 
 

G 
global condition 

A logical construct that, when applied to a study 
object, determines whether the study object will 
appear for a particular subject. A global condition 

does not affect other study objects in the workflow. 

See also workflow rule (on page 161). 
 

globals 

Study objects and properties that are related to 
mappings. 
 

grouping 

A default or user-provided value used to organize 
custom properties of a study object. 
 

I 
implicit lock 

A type of lock used when you edit a study object. An 
implicit lock is automatically applied when you select 
or open a study object and is automatically released 
when you close or save a study object. 

See also explicit lock (on page 156). 
 

incremental deployment package 

A deployment package that contains a complete 
study based on a previously created deployment 
package, plus any additions or changes. 
 

integer item 

An item used to collect a numerical value without a 
decimal point. 
 

internationalization 

The process of configuring a study for translation 
into different languages or for different regional 
requirements. 
 

intrinsic rule 

A constraint rule or calculation rule based on a 
predefined rule template. 
 

item 

A study object used as a container for the collection 
of clinical data. 
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J 
Job Log Browser 

A browser in which you view the results of 
asynchronous jobs, such as validation or import. 
 

K 
keyword 

An identifier that is associated with users and study 
objects to facilitate more powerful and efficient 
searches. 
 

L 
Libraries Browser 

A browser in which you search the repository for 
study objects and then add them to studies or 
libraries. 
 

library 

A container used to store related study objects and 
templates to be published for reuse in studies or 
other libraries. A library provides a view of the study 
objects in the repository. 

See also repository (on page 158). 
 

Library List 

A hierarchical list of libraries from which resources 
can be used. The hierarchy determines the order in 
which libraries are searched. The Library List is 
defined for each study in the Study Editor.  
 

library project 

A project containing a library. 
 

library role 

A role associated with library activities. 
 

library team 

A group of users who have rights granted by a 
certain role to perform tasks in a particular library. 
 

locale 

A supported language or language variation. 
 

localization 

The process of designing a study for a specific 
locale. 
 

locked 

A state in which only the user who created the lock 
can modify a study object. Locks can be implicit or 
explicit. 

See also implicit lock (on page 156), explicit lock 
(on page 156). 
 

M 
mapping 

A data grouping that provides an alternate data view 
of a study. Mappings were previously called logical 
schemas. 

See also data series (on page 155), data set (on 
page 155). 
 

MedML 

An XML-based markup language developed by 
Oracle for representing and exchanging clinical data 
definitions created in the InForm application.. 

See also CSML (on page 154). 
 

method 

A block of code that is called by a rule and that is 
used to manipulate data. 
 

N 
normalization 

The process of converting data to a required format. 
 

O 
object 

See study object (on page 159). 
 

ODM 

Operational Data Model. ODM is an XML-based 
standard developed by the Clinical Data Interchange 
Standards Consortium (CDISC) for representing 
and exchanging clinical data. 
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P 
precondition 

The part of a rule that specifies when to evaluate the 
rule expression. 
 

project 

See library project (on page 157) and study project 
(on page 160). 
 

Project Explorer 

A browser that displays a view of the open project 
and the study objects it contains. 
 

Properties Browser 

A browser in which you can view and modify the 
properties of the study object selected in the Project 
Explorer. 
 

property 

A defining characteristic of a study object. 
 

protocol 

A detailed plan that describes how investigators 
conduct a study. The clinical protocol sets the 
guidelines for the study, describes the conditions of 
the study, and contains a set of forms on which 
clinical data is collected. 
 

publish 

The action that makes a study object created in a 
library available to other users. 

See also unpublish (on page 161). 
 

Q 
query 

A text string that appears on a CRF item in the 
InForm application when a rule on that item fails. 
When designing a rule in the Central Designer 
application, you can specify the query text and the 
circumstances under which a rule results in a query. 
 

R 
radio button 

A type of data entry format in which you must select 
a single item from a list of choices. 
 

reference 

A text note, a link to a Web page or file (URL), a 
document, or a combination of all three, that is 
attached to a study project for users to consult 
during the development of a study. 
 

RefName 

A unique identifier for a study object. 
 

repeating form 

A type of form for which the Repeating property is 
set to true. You use a repeating form to collect 
multiple instances of the same data at different dates 
and times. 
 

repository 

A single database instance that contains all Central 
Designer study objects, components, and users.  
 

revision 

An audit history record that is created automatically 
when a user edits a study object and saves the 
changes. 
 

right 

A predefined permission that controls access to a 
specific feature or activity in the Central Designer 
client or Central Designer Administrator client and 
that can be assigned to one or more roles. 

See also role (on page 158). 
 

role 

A collection of rights. When a user is assigned to a 
role, the rights associated with the role are granted 
to the user. 

See also library role (on page 157), study role (on 
page 160), and user role (on page 153). 
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role administration 

The process of managing tasks that users perform in 
the Central Designer and Central Designer 
Administrator applications, assigning rights to roles, 
and assigning roles to users. 
 

rule 

See data-entry rule (on page 155), workflow rule 
(on page 161). 
 

rule action 

The action, or actions, that takes place as a result of 
the evaluation of a rule expression. 
 

rule scope 

The set of study objects that a rule can reference. 
The scope of a rule is determined by the study 
object on which the rule is defined. 
 

rule template 

A function that is defined on a study object, study 
object template, or study object type and can be 
used as the expression clause of a rule. 
 

rule type 

See calculation rule (on page 153), constraint rule 
(on page 154), and intrinsic rule (on page 156). 
 

S 
SDTM 

Study Data Tabulation Model. SDTM is a CDISC 
model used to standardize data structures in data 
extracts. 
 

shared form 

See common form (on page 154). 
 

site 

A location that participates in a study. 
 

standard data dimension 

See data dimension (on page 155). 
 

standard task type 

A task type that is typically used for all non-
translation tasks assigned to an individual or team. 
 

study 

The definition of the workflow, data-entry, and data-
management system for a clinical study. 
 

study arm 

The CDISC term for a study branch consisting of a 
planned sequence of study elements. A study arm is 
typically equivalent to a treatment group. 
 

study book 

The set of forms used to collect clinical data. 

See also annotated study book (on page 153). 
 

study branch 

A path for which data is collected for certain 
subjects. A study can contain multiple branches as 
different conditions are assessed, and a branch is 
followed depending on the subject and other 
circumstances. 
 

study design 

A container for the structure of a study. 
 

study element 

The CDISC term for a basic building block of a 
study. A study element represents a segment of a 
study and can consist of one or more study events. 
Study elements are optional. 
 

study event 

A subject evaluation checkpoint when data is 
collected. Study events usually correspond to visits, 
but one visit can span multiple study events. 
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study object 

A study building block that appears in the Project 
Explorer. Study objects include study projects, 
library projects, studies, libraries, study elements, 
study events, forms, sections, items, codelists, and 
codelist items. 

See also component (on page 154). 
 

study object editor 

An editor for each study object, such as a project, 
study, study element, study event, form, or item. A 
study object editor appears in the workspace when 
you select a study object. 
 

study project 

A project containing one or more studies that are 
related to each other. 
 

study role 

A role associated with study activities. 
 

study team 

A group of users who perform tasks granted by a 
certain role for a particular study. 
 

study workflow 

See workflow (on page 161). 
 

subject 

An individual who participates in a clinical study. 
 

system 

An application to which you deploy a study from the 
Central Designer application. 
 

system configuration administration 

The process of creating, configuring, and managing 
internationalization, collaboration, and 
customization information using the Central 
Designer Administrator application. 
 

T 
target item 

An item that holds a term, code, or additional 
information after a verbatim is coded. 
 

task 

A request that you attach to a study object and 
assign to an individual or a study team. 
 

task classification 

The classification of a task. You can choose either 
standard (used for all non-translation tasks assigned 
to an individual or team) or translation (used for 
tasks that request translation of a study object into 
one or more languages). You define the classification 
for task types in the Central Designer Administrator 
application. 
 

task type 

A classification used to identify the type of the task 
and the way the task is used. 
 

Tasks Browser 

A browser in which you work with tasks. 
 

team 

See study team (on page 160), library team (on 
page 157). 
 

template 

A study object that is either partially or fully defined 
and that can be used to create other study objects. 
You can create templates for study projects, studies, 
study elements, study events, forms, items, codelists, 
and mappings. 
 

text box 

A data-entry format in which you type data. 
 

text item 

An item used to collect alphanumeric information. 
 

translation task type 

A task type that is used for tasks that request 
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translation of a study object into one or more 
languages. 
 

type 

A study object that is either partially or fully defined 
and can be used to create other study objects. Types 
are like templates except that types appear as options 
in the Actions menu and in the Project Explorer 
menu when you create a new study object. 
 

U 
unpublish 

The action that makes a study object in a library no 
longer available to other users. 

See also publish (on page 158). 
 

user 

A person who works in the Central Designer or 
Central Designer Administrator application. 
 

user administration 

The process of managing users. 
 

Users Browser 

A browser in which you search the repository for 
users and then add them to study teams or library 
teams. 
 

V 
validation 

The process of checking the status of a study to 
indicate if the study is ready for deployment. The 
study validation process determines whether all 
essential components exist and are consistent. 
 

verbatim 

The original reported text that describes the adverse 
event, disease, drug, or other item to be coded in the 
Central Coding application. 
 

verbatim type 

A classification of a verbatim as defined in a coding 
dictionary. 
 

version 

An explicitly requested audit history record for a 
study object. 
 

visit 

See study event (on page 159). 
 

W 
workflow 

The progression of work for a study, as determined 
by the study designers. 
 

workflow rule 

A logical construct that tests data values to 
determine the study element, study event, or form to 
which a subject progresses next. A workflow rule 
prevents study objects in the workflow from 
appearing until the rule is evaluated. 

See also data-entry rule (on page 155), g lobal 
condition (on page 156). 
 

workspace 

The work area of the Central Designer and Central 
Designer Administrator applications. The contents 
of the workspace depend on the type of activity you 
are performing and the rights that you have been 
granted. The workspace displays the editor for the 
study object that is selected in the Project Explorer. 
 

Y 
yes no item 

An item used to collect yes or no answers to 
questions. A yes no item contains a predefined 
codelist with Yes and No options. 
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F 
field 
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